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Introduction

Thank you for purchasing an NP-series Programmable Terminal. 

NP-series PTs are designed to transfer data and information in FA production sites.

Please be sure that you understand the functions and performance of the PT before attempting to use
it.

Intended Audience

This manual is intended for the following personnel, who must also have knowledge of electrical sys-
tems (an electrical engineer or the equivalent). 

• Personnel in charge of introducing FA systems into production facilities.

• Personnel in charge of designing FA systems.

• Personnel in charge of installing and connecting FA systems.

• Personnel in charge of managing FA systems and facilities.

General Precautions

This manual provides information for connecting and setting up an NP-series PT. Be sure to read this
manual before attempting to use the PT and keep this manual close at hand for reference during instal-
lation and operation.

© OMRON, 2008
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form, or
by any means, mechanical, electronic, photocopying, recording, or otherwise, without the prior written permission of
OMRON.

No patent liability is assumed with respect to the use of the information contained herein. Moreover, because OMRON is con-
stantly striving to improve its high-quality products, the information contained in this manual is subject to change without
notice. Every precaution has been taken in the preparation of this manual. Nevertheless, OMRON assumes no responsibility
for errors or omissions. Neither is any liability assumed for damages resulting from the use of the information contained in
this publication. 



vi



vii

Read and Understand this Manual
Please read and understand this manual before using the product. Please consult your OMRON 
representative if you have any questions or comments. 

Warranty and Limitations of Liability 

WARRANTY 

OMRON's exclusive warranty is that the products are free from defects in materials and workmanship for a 
period of one year (or other period if specified) from date of sale by OMRON.

OMRON MAKES NO WARRANTY OR REPRESENTATION, EXPRESS OR IMPLIED, REGARDING NON-
INFRINGEMENT, MERCHANTABILITY, OR FITNESS FOR PARTICULAR PURPOSE OF THE 
PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE HAS 
DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR 
INTENDED USE. OMRON DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED. 

LIMITATIONS OF LIABILITY

OMRON SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES, 
LOSS OF PROFITS OR COMMERCIAL LOSS IN ANY WAY CONNECTED WITH THE PRODUCTS, 
WHETHER SUCH CLAIM IS BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT 
LIABILITY. 

In no event shall the responsibility of OMRON for any act exceed the individual price of the product on which 
liability is asserted. 

IN NO EVENT SHALL OMRON BE RESPONSIBLE FOR WARRANTY, REPAIR, OR OTHER CLAIMS 
REGARDING THE PRODUCTS UNLESS OMRON'S ANALYSIS CONFIRMS THAT THE PRODUCTS 
WERE PROPERLY HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO 
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR REPAIR. 
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Application Considerations

SUITABILITY FOR USE 

OMRON shall not be responsible for conformity with any standards, codes, or regulations that apply to the 
combination of products in the customer's application or use of the products. 

At the customer's request, OMRON will provide applicable third party certification documents identifying 
ratings and limitations of use that apply to the products. This information by itself is not sufficient for a 
complete determination of the suitability of the products in combination with the end product, machine, 
system, or other application or use.

The following are some examples of applications for which particular attention must be given. This is not 
intended to be an exhaustive list of all possible uses of the products, nor is it intended to imply that the uses 
listed may be suitable for the products:

• Outdoor use, uses involving potential chemical contamination or electrical interference, or conditions or 
uses not described in this manual.

• Nuclear energy control systems, combustion systems, railroad systems, aviation systems, medical 
equipment, amusement machines, vehicles, safety equipment, and installations subject to separate 
industry or government regulations.

• Systems, machines, and equipment that could present a risk to life or property. 

Please know and observe all prohibitions of use applicable to the products.

NEVER USE THE PRODUCTS FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR 
PROPERTY WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO 
ADDRESS THE RISKS, AND THAT THE OMRON PRODUCTS ARE PROPERLY RATED AND INSTALLED 
FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

PROGRAMMABLE PRODUCTS 

OMRON shall not be responsible for the user's programming of a programmable product, or any 
consequence thereof.
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Disclaimers

CHANGE IN SPECIFICATIONS 

Product specifications and accessories may be changed at any time based on improvements and other 
reasons.

It is our practice to change model numbers when published ratings or features are changed, or when 
significant construction changes are made. However, some specifications of the products may be changed 
without any notice. When in doubt, special model numbers may be assigned to fix or establish key 
specifications for your application on your request. Please consult with your OMRON representative at any 
time to confirm actual specifications of purchased products.

DIMENSIONS AND WEIGHTS 

Dimensions and weights are nominal and are not to be used for manufacturing purposes, even when 
tolerances are shown.

PERFORMANCE DATA 

Performance data given in this manual is provided as a guide for the user in determining suitability and does 
not constitute a warranty. It may represent the result of OMRON's test conditions, and the users must 
correlate it to actual application requirements. Actual performance is subject to the OMRON Warranty and 
Limitations of Liability.

ERRORS AND OMISSIONS 

The information in this manual has been carefully checked and is believed to be accurate; however, no 
responsibility is assumed for clerical, typographical, or proofreading errors, or omissions.
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Safety Precautions

Notation Used for Safety Information

The following notation is used in this manual to provide precautions required to ensure safe usage of
the product.

The safety precautions that are provided are extremely important to safety.

Always read and heed the information provided in all safety precautions.

The following notation is used.

Indicates a potentially hazardous situation which, if not avoided, will result in
minor or moderate injury, or may result in serious injury or death. Additionally
there may be significant property damage.

Supplementary comments on what to do or avoid doing, to use the product safely.

Supplementary comments on what to do or avoid doing, to prevent failure to oper-
ate, or undesirable effect on product performance.

Symbols

Prohibition

Indicates a general prohibition

Caution

Indicates general cautionary, warning, or danger level infor-
mation

!WARNING

Precautions 
for Safe Use

Precautions 
for Correct Use
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! WARNING

After the NP-series PT has been installed, qualified 
personnel must confirm the installation, and must con-
duct test operations and maintenance. 
The qualified personnel must be qualified and autho-
rized to secure safety at each phases of design, instal-
lation, running, maintenance, and disposal of system.

A qualified person in charge, who is familiar with the 
machine, must conduct and verify the installation of the 
NP-series PT.

Do not use the PT touch switch input functions for applica-
tions where danger to human life or serious property damage 
is possible, or for emergency switch applications.

Do not press two or more touch switches at the same time. If 
doing so, other switch allocated between these switches may 
be operated.

Do not dismantle, repair, or modify the product. Doing so may 
lead to loss of safety functions.
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Precautions for Safe Use

• When unpacking the Units and peripheral devices, check carefully for any external scratches or
other damage. Also, shake the products gently and check for any abnormal sound.

• Always install the Unit in the control panel.

• The mounting panel must be between 1.6 and 2.5 mm thick. Tighten the Mounting Brackets evenly
to a torque of 0.7 N·m to maintain water and dust resistance. Make sure the panel is not dirty or
warped and that it is strong enough to hold the Units.

• Do not let metal particles enter the Units when preparing the panel.

• Do not connect an AC power supply to the DC power terminals.

• Use reinforced insulation or double insulation for the DC power supply with minimal fluctuation volt-
age to the Unit. Ensure that a stable power output can be provided even if a 10-ms interruption
occurs at the input. Tighten the terminal block screws to a torque of 0.51 N·m.
Rated power supply voltage: 24 VDC (Allowable range: 21.6 to 27.6 VDC)
Capacity: 12 W minimum

• Do not perform a dielectric voltage test.

• Ground the Unit correctly to prevent malfunctions caused by noise.

• Do not touch the surface of the circuit board or the components mounted on it with your bare hands.
Discharge any static electricity from your body before handling the board.

• Confirm that the current capacity of the connected device is 250 mA or less before using 5VDC
power supply from the pin 6 of the serial port COM1 connectors. The 5VDC output of the Unit is
250 mA maximum at 5 V ±5%.

• Turn OFF the power supply before connecting or disconnecting cables.

• The tightening torque of the serial port COM1 is 0.6 N·m. 
The tightening torque of the serial port COM2 is 0.2 N·m.

• The maximum tensile load for cables is 30 N. Do not apply loads greater than this.

• Confirm the safety of the system before turning ON or OFF the power supply.

• The whole system may stop depending on how the power supply is turned ON or OFF. Turn ON or
OFF the power supply according to the specified procedure.

• Start actual system application only after sufficiently checking screen data, macros, and the opera-
tion of the program in the host.

• To ensure the safety of the system, incorporate a program that can check that the Unit is properly
operating.

• Before initializing screen data, confirm that existing data is backed up at a computer.

• To use numeric input functions safely, always make maximum and minimum limit settings.

• An image will be burnt onto the screen if the same pattern is continuously displayed for a long period
of time (24 hours or longer as a guideline). To prevent screen burn, use a screen saver or switch dis-
plays periodically.

• Commercially available and recommended USB Hubs do not have the same specifications as the
NP-series PT. Normal operation may not be possible in environments subject to noise or static elec-
tricity. When using USB Hubs, be sure to provide sufficient measures to prevent noise and static
electricity, or install in a location that is not subject to noise or static electricity.

• Do not connect the USB connector to any device that is not applicable.

• Before connecting the USB connector to a device, make sure that the device is free of damage.

• Do not press the touch switch with a force greater than 30 N.

• Confirm the safety of the system before pressing touch switches.

• Signals from the touch switches may not be input if the switches are pressed consecutively at high
speed. Confirm each input before proceeding to the next one.
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• Do not accidentally press touch switches when the backlight is not lit or when the display does not
appear.

• Do not operate the touch switches with tools including screwdriver.

• Touch panel resistance may change over time, causing the touch points to shift. Periodically perform
the calibration.

• Do not use benzene, paint thinner, or other volatile solvents, and do not use chemically treated
cloths.

• When mounting the Battery, be sure to use the correct Battery and mount it correctly.

• Do not attempt to disassemble or short-circuit the battery.

• Dispose of any battery that has been dropped on the floor or subjected to excessive shock.

• When replacing the battery, always backup data before turning off the power to the Unit. If the bat-
tery is removed, the data stored in the Unit will be deleted.

• Dispose of the Units and batteries according to local ordinances as they apply.

• The backlight in the Unit contains mercury. Do not dispose of the Unit together with waste to be pro-
cessed at disposal plants. Dispose of the Unit according to all local laws, regulations, and ordi-
nances.

• The backlights of the Units cannot be replaced by the user. Contact your nearest OMRON represen-
tative.

• The Unit may not be usable in locations subject to long-term exposure to oil or water. The gasket will
deteriorate after long-time use. Inspect the gasket on a regular basis. If deterioration is found, con-
tact your OMRON representative.
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Precautions for Correct Use
• Do not install the Unit in the following places:

• Locations subject to severe changes in temperature

• Locations subject to temperatures or humidity outside the range specified in the specifications

• Locations subject to high humidity that may result in condensation.

• Locations subject to exposure to chemicals.

• Locations subject to exposure to oil.

• Locations subject to corrosive or flammable gases

• Locations subject to excessive shock or vibration.

• Locations directly subject to wind or rain.

• Locations subject to strong ultraviolet light.

• Take appropriate and sufficient countermeasures when installing systems in the following locations:

• Locations subject to static electricity or other forms of noise from other devices

• Locations subject to strong electromagnetic fields

• Locations close to power supplies

• Locations subject to possible exposure to radiation.
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Conforming Directive
The NP-series PTs conform to the EMC Directive.

EMC Directive Conformance

OMRON products are designed as electrical devices for use built into other devices or the overall
machine. As individual devices, they comply with the related EMC standards (see note) so that they
can more easily be built into other devices or the overall machine. The actual products have been
checked for conformity to EMC standards. Whether they conform to the standards in the system used
by the customer, however, must be checked by the customer.

EMC-related performance of the OMRON devices will vary depending on the configuration, wiring, and
other conditions of the equipment or control panel on which the OMRON devices are installed. The
customer must, therefore, perform the final check to confirm that devices and the overall machine con-
form to EMC standards.

Note Applicable EMC (Electromagnetic Compatibility) standards are as follows:

EMS (Electromagnetic Susceptibility): EN 61131-2

EMI (Electromagnetic Interference): EN 61131-2 (Radiated emission: 10-m regulations)

Complying with EC Directives

NP-series PTs comply with EC Directives. Observe the following precautions to ensure that the cus-
tomer's device and the overall machine also comply with EC Directives.

1. The PT is designed for installation inside a control panel. The PT must be installed within a control
panel.

2. Use reinforced insulation or double insulation for the DC power supply to the PT. Ensure that a sta-
ble power output can be provided even if a 10-ms interruption occurs at the input.

3. The PT conforms to the EN 61131-2, but the radiated emission characteristics (10-m regulations)
may vary depending on the configuration of the control panel used, other devices connected to the
control panel, wiring, and other conditions. You must therefore confirm that the overall machine or
equipment complies with EC Directives.

4. The NP-series PTs are Class A products. It may cause radio interference in residential areas, in
which case the user may be required to take adequate measures to reduce interference. 
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Notation and Terminology

The following notation and terminology are used in this manual.

Notation

Terminology

Reference Indicates additional information on operation, descriptions or settings.

CS1G-CPU@@-VI @ used in this manual indicates one character. For example, “CS1G-CPU@@-VI” 
indicates CS1G-CPU42-VI, CS1G-CPU43-VI, CS1G-CPU44-VI and CS1G-
CPU45-VI.

PT In this manual, indicates an NP-series Programmable Terminal. 

NP Series Indicates products in the OMRON NP@@ Series of Programmable Termi-
nals, unless otherwise specified.

PLC Indicates a Programmable Controller in the OMRON SYSMAC CP, CS/CJ, 
C, or CVM1/CV Series of Programmable Controllers.

CP Series Indicates products in the OMRON SYSMAC CP Series of Programmable 
Controllers: CP1L and CP1H.

CS/CJ Series Indicates Programmable Controllers in the OMRON SYSMAC CS/CJ 
Series of Programmable Controllers: CS1G, CS1H, CS1G-H, CS1H-H, 
CJ1G, CJ1M.

C Series Indicates products in the OMRON SYSMAC C Series of Programmable 
Controllers: C200HX(-Z), C200HG(-Z), C200HE(-Z), CQM1, CQM1H, 
CPM1A, CPM2A, CPM2C.

CVM1/CV Series Indicates products in the OMRON SYSMAC CVM1/ CV Series of Pro-
grammable Controllers: CV500, CV1000, CV2000, CVM1

Serial Communications Unit Indicates a Serial Communications Unit for an OMRON CS/CJ-series 
PLC. 

Serial Communications Board Indicates a Serial Communications Board for an OMRON CS/CJ-series or 
CQM1H PLC.

Communications Board Indicates a Communications Board for an OMRON C200HX/HG/HE(-Z) 
PLC.

CPU Unit Indicates a CPU Unit in the OMRON SYSMAC CP, CS/CJ, C, or CVM1/
CV Series of Programmable Controllers.

NP-Designer Indicates the OMRON CP-Designer (NP-NPDC0-V@).

Host Indicates a device such as PLC functioning as the control device and 
interfaced with the NP-series PT. 
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About this Manual:

Section 1 Overview
This section provides an overview of the NP-series PTs, including functions, features, connection
types, and communications methods.

Section 2 Part Name and Functions
This section describes the part names and functions of the PT.

Section 3 Installing the PT and Connecting Peripheral Devices
This section describes the methods used to install the PT and connect peripheral devices.

Section 4 System Menu
This section describes the methods used to set and check various settings in the system menu of the
PT.

Section 5 Installing and Starting the NP-Designer
The software “NP-Designer” is required to create screen data for the PT. This section describes the
methods for installing and starting the NP-Designer.

Section 6 NP-Designer Functions
This section describes functions of the NP-Designer.

Section 7 Maintenance and Troubleshooting
This section describes the maintenance and inspection methods for preventing errors occurring, and
troubleshooting measures when errors occur in the PT. 

Appendices 
This section describes hardware specifications and methods for preparing connections cables, and
provides lists of standard products. 
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Related Manuals

The following table lists the device and software manuals used for reference.

Device/Software Manual name Catalog No.

NP Series User's Manual (This manual) V096

Host Connection Manual V102

PLC SYSMAC CP Series CP1L CPU Unit Operation Manual W462

SYSMAC CP Series CP1L CPU Unit Programming Manual W451

SYSMAC C200HX/HG/HE(-Z) Installation Guide W302

SYSMAC C200HX/HG/HE Operation Manual W303

SYSMAC C200HX/HG/HE(-ZE) Operation Manual W322

SYSMAC CQM1 Operation Manual W226

SYSMAC CQM1H Operation Manual W363

SYSMAC CV Series CV500/CV1000/CV2000/CVM1 
Programming Manual: Ladder Diagrams 

W202

SYSMAC CPM1A Operation Manual W317

SYSMAC CPM2A Operation Manual W352

SYSMAC CPM1/CPM1A/CPM2A/CPM2C/SRM1(-V2)
Programming Manual

W353

SYSMAC CPM2C Operation Manual W356

SYSMAC CS Series CS1G/H-CPU@@ Operation Manual W339

SYSMAC CS/CJ Series Serial Communications Boards and Serial 
Communications Units Operation Manual

W336

SYSMAC CJ Series Operation Manual W393

SYSMAC CS/CJ Series Programming Manual W394

SYSMAC CS/CJ Series Instruction Reference Manual W340

SYSMAC CS/CJ Series Programming Console Operation Manual W341

SYSMAC CS/CJ Series Communications Command Reference Manual W342

Programming Devices/
Software

SYSMAC Support Software Operation Manual: C-series PLCs W248

SYSMAC Support Software Operation Manual: CVM1 PLCs W249

SYSMAC CPT Operation Manual W333

CX-Programmer User Manual W437

EJ1 Modular Temperature Controller User's Manual H142
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SECTION 1
Overview

This section provides an overview of the NP-series PTs, including functions, features, connection types, and
communications methods.
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NP-series PT Functions and Operations Section 1-1

1-1 NP-series PT Functions and Operations 
The NP Series offers advanced operator interfaces called Programmable Ter-
minals that can be used to display required information and provide operating
capabilities for FA manufacturing sites. This section describes the role and
functions of the NP-series PTs for first-time users of Programmable Termi-
nals. 

1-1-1 PT Functions for FA Manufacturing Sites

Line Operating Status Monitor Display
NP-series PTs can be used to display information such as the operating sta-
tus of the system and the devices. Graphs and other indicators can be used to
better represent the information and make it easy to understand.

Directions for FA Site Operators
The PTs can be used to inform the operators of system and device errors and
assist them in taking appropriate measures. 

Control Panel Switches
The NP-series PTs allow the user to create various on-screen switches. By
using touch switch inputs, operating results can be sent to the host. 

1-1-2 NP-series PT Operating System

Transferring Screen Data
The screen data displayed on NP-series PTs is created using the NP-
Designer on a computer and transferred to the PT through RS-232C or USB
communications.

Screen data can also be transferred at high speed using a USB flash memory.

Create screen data.

RS-232C

Screen data

Connect the computer to the PT only when
transferring screen data to or from the
NP-Designer.

Computer
(NP-Designer)

USB Flash Memory
Computer
(NP-Designer)
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Displaying Screens The information displayed on the screens is created using the NP-Designer
on a computer and transferred to the PT. The required screens can be dis-
played by using commands from the host or touch switch operations.

Reading Data from 
the Host

A communications method such as NT Link is used to connect the host, and
the required data is automatically read from the host.

Sending Data to the Host
Data input using touch switches (button ON/OFF status, numerals, and char-
acter strings) is sent to the host.

Host

The required screens can
be displayed by using
commands from the host
or touch switch operations.

NT Link Host

Touch panel

Host

ON/OFF status,  

numeric data, etc.
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1-2 Communications with the Host
NP-series PTs allow the user to allocate words and bits in any PLC area for
use in accessing the required display contents and storing input data.

Operations that can be performed include reading and writing allocated word
contents and bit status directly, changing the display status of objects on the
PT screen, and controlling and providing notification of the PT status.

The NP-series PTs also enable communications with more than one PLC. A
host name is registered for each PLC connected, allowing access to any PLC
areas by specifying the host name and address.

When using NP-series PTs, the host can be connected using any of the fol-
lowing methods.

• 1:1 NT Link

• 1:N NT Link (normal or high-speed)

• Host Link

1-2-1 What is an NT Link?
An NT Link is a method for high-speed communications between an OMRON
PLC and an OMRON Programmable Terminal (PT) using a special protocol.

One NP-series PT can be connected to each host. More than one NP-series
PT cannot be connected to the same host. Also, if an NP-series PT is con-
nected, then a PT that supports 1:N NT Links and PLC slaves that support
Serial PLC Links cannot be connected. 

NP-series PTs can be connected to a host using either the 1:1 NT Link proto-
col or the 1:N NT Link protocol. 

CS/CJ-series and CP-series PLCs can also be connected using high-speed
1:N NT Link communications. For details on the PLCs that support high-
speed 1:N NT Link communications, refer to Appendix E Standard Models.

In the rest of this manual, “NT Link” refers to NT Link communications in gen-
eral, “1:1 NT Link” refers to an NT Link in a 1:1 configuration only, and “1:N NT
Links” refers to NT Links in a 1:N configuration only. Where necessary, “nor-
mal 1:N NT Links” and “high-speed 1:N NT Links” are used. When “1:N NT
Links” is used alone, it refers to both normal and high-speed communications.

1-2-2 Host Link
Host Link is a serial communications protocol for connecting an OMRON PT
1:1 to an OMRON host (a PLC) to read and write bits and words from the
host. Host Link communications connect a PT to many different PLCs. 

1-2-3 Connecting to a Temperature Controller
OMRON EJ1 Modular Temperature Controllers can be connected with an RS-
485 connection. 

Use serial port COM2.

PLCNP-Series PT

DM Area I/O Area

Auxiliary Area Timers/counters
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1-2-4 Communicating with Another Company's PLCs
The NP-series PTs can communicate with another company's PLCs. For
details on manufactures and models of the supported PLCs, refer to NP
Series Host Connection Manual.
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1-3 System Configuration
The following information describes the system configuration using NP-series
PTs. Refer to Appendix E Standard Models for details on available models. 

1-3-1 Supported Peripheral Devices

PTs (Refer to Appendix E Standard Models.)

USB flash memory Only FAT32 formatted USB flash memory can be connected.

NP-Designer NP-NPDC0-V1 (CD-ROM version)

Reference The following optional products are available. (Refer to Appendix F List of
Optional Products.) 

Host

RS-232C cable (15 m max.)
RS-422A/RS-485 cable (500 m max.)

USB Flash Memory
Save screen data or
the system program.

NP-series PT
RS-232C cable
USB cable
(See note 1.)

Personal computer
Computer running Windows 2000 or XP

NP-Designer

*1 Refer to 3-3-2 Connecting via USB for information on connecting the PT and computer with a USB cable.

Manufacture Model

Replacement Battery OMRON CJ1W-BAT01
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1-4 Procedure for Running NP-series PTs
Use the following procedure to start up the NP Series system. 

Note (1) Run mode is entered automatically if screen data already exists. 

(2) The system program is installed in special situations only, such as when
the system program is being changed or recovered.

(3) The system menu can be displayed by operating the function switch, but-
ton to which system menu is assigned or switch on the back of the PT.

(4) When errors occur during operation, check I/O and setting statuses as re-
quired.

Refer to following pages.

1:1 NT Link:

3-4 Connecting with a 1:1 NT Link

1:N Link:

3-5 Connecting with 1:N NT Links

High-speed 1:N NT Link:

3-6 High-speed 1:N NT Link

Host Link: 3-7 Host Link

Temperature Controllers:

3-8 Connecting to

Temperature Controllers

Other Devices:

1-1 List of Supported Hosts

in the Host Connection Manual

Refer to 3-9-1 Transferring Data with USB Flash Memory.

NP-DesignerPT  Host

Refer to Section 4 System Menu.

See note 4.

Panel Installation

Peripheral connections

Power connections

Power ON

System program
installation

Screen transfer

Screen creation

System menu settings

Host connectionsPT connections

Programming

Operation

System maintenance

Settings/com check

Host settings Installation on the
      computer

See note 1.

See note 2.

See note 3.

Refer to 3-1-2 Mounting the PT 
to the Control Panel.

Refer to 3-1-3 Connecting 
the Power Supply

Refer to 3-9-1 Transferring Data 
with USB Flash Memory.

Refer to Section 5 Installing 
and Starting NP-Designer.

Refer to Section 6 NP-Designer 
Functions.
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SECTION 2
Part Names and Functions

The part names and functions of the PT are described here.

2-1 Part Names . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

2-2 Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
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2-1 Part Names
NP5-MQ000B/MQ000 Front Panel

Rear Panel

Function Switch.
Used for input.

Display
5.7-inch FSTN high luminance LCD
The entire display is a touch panel that serves as
an input device.

POWER Indicator
The light turns ON/OFF to
indicate the ON/OFF
condition of the power.

USB Slave Connector

Slide Switch SW1

Serial Port COM1 Connector Serial Port COM2 Connector
Uses an RS-422A/485 terminal block.

USB Host Connector

DIP Switch SW2

DC Input Terminals

Battery Cover
The battery is installed underneath the cover.

Used to switch to 
RS-422A/485  
and set terminating 
resistance.

Used to connect the 
24 VDC power 
supply.

Uses an RS-232C 9-pin 
connector.

This is a USB Type A 
connector.

Used to start the 
System Menu.

It is a USB Type B 
connector.

Confirm system safety before turning the power ON/OFF. Precautions 
for Safe Use
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NP5-MQ001B/MQ001 Front Panel

Rear Panel

Function Switch.
Used for input.

POWER Indicator
The light turns ON/OFF 
to indicate the ON/OFF 
condition of the power.

Display
5.7-inch FSTN high luminance LCD The 
entire display is a touch panel that serves as 
an input device.

USB Slave Connector

Slide Switch SW1

Serial Port COM1 Connector Serial Port COM2 Connector
Uses an RS-422A/485 terminal block.

USB Host Connector

DIP Switch SW2

DC Input Terminals

Battery Cover
The battery is installed underneath the cover.

Used to switch to RS-
422A/485 and set 
terminating resistance.

Used to connect the 
24 VDC power 
supply.

Uses an RS-232C 9-pin 
connector.

This is a USB Type A 
connector.

Used to start the 
System Menu.

It is a USB Type B 
connector.

Confirm system safety before turning the power ON/OFF. Precautions 
for Safe Use
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NP3-MQ000B/MQ000 Front Panel

Rear Panel

Function Switch.
Used for input.

POWER Indicator
The light turns ON/OFF to
indicate the ON/OFF
condition of the power.

Display
3.8-inch STN high luminance LCD
The entire display is a touch panel that serves as
an input device.

DIP Switch SW2

Battery Cover
The battery is installed underneath the cover.

Serial Port COM1 Connector Serial Port COM2 Connector
Uses an RS-422A/485 terminal block.

DC Input Terminals

USB Slave Connector

USB Host Connector

Slide Switch SW1

Uses an RS-232C 9-pin 
connector.

This is a USB Type B 
connector.

Used to start the 
System Menu.

It is a USB Type A 
connector.

Used to connect 
the 24 VDC  
power supply.

Used to switch to 
RS-422A/485  
and set terminating 
resistance.

Confirm system safety before turning the power ON/OFF. Precautions 
for Safe Use
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NP3-MQ001B/MQ001 Front Panel

Rear Panel

Function Switch.
Used for input.

POWER Indicator
The light turns ON/OFF to
indicate the ON/OFF
condition of the power.

Display
3.8-inch STN high luminance LCD
The entire display is a touch panel that serves as
an input device.

DIP Switch SW2

Battery Cover
The battery is installed underneath the cover.

Serial Port COM1 Connector Serial Port COM2 Connector
Uses an RS-422A/485 terminal block.

DC Input Terminals

USB Slave Connector

USB Host Connector

Slide Switch SW1
Used to switch to 
RS-422A/485  
and set terminating 
resistance.

Used to connect 
the 24 VDC  
power supply.

Uses an RS-232C 9-pin 
connector.

This is a USB Type B 
connector.

It is a USB Type A 
connector.

Used to start the 
System Menu.

Confirm system safety before turning the power ON/OFF. Precautions 
for Safe Use
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2-2 Specifications 
Touch Panel The touch switches on the front panel of the PT are used to perform input

operations. Press the touch switches to perform operations such as switching
screens and sending bit status to the host. 

Connector Pin 
Arrangement of COM1 

! WARNING

Do not use the PT touch switch input functions for 
applications where danger to human life or serious 
property damage is possible, or for emergency switch 
applications.

Do not press two or more touch switches at the same 
time. If doing so, other switch between these switches 
may be operated.

• Do not exceed a pressure of 30 N when pressing any of the touch
switches.

• Do not press the touch switches when the backlight is not lit or when
there is no display. 

• Check system safety before pressing the touch switches. 

• Do not use the touch switches with tools such as screwdriver.

• Inputs may not be recognized if the touch switches are pressed in
rapid succession. Check that one input operation has finished before
performing the next one.

• Touch panel resistance may change over time, causing the touch
points to shift. Periodically perform the calibration.

Precautions 
for Safe Use

Pin number Signal name Name

1 NC Not connected.

2 SD Send data

3 RD Receive data

4 RS Request to send

5 CS Clear to send

6 5VDC 5VDC output (250 mA max.)

7 NC Not connected.

8 NC Not connected.

9 SG Signal ground

5 1

9 6

Make sure that the total current capacity of devices being supplied 
power is 250 mA maximum before using the 5VDC power supply from 
pin 6. The capacity of the PT's 5VDC output is 250 mA maximum at 
5VDC ±5%.

Precautions 
for Safe Use
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Connector Pin 
Arrangement of COM2

Slide Switch SW1

The system menu will be displayed when setting the slide switch to the left
(ON) to turn ON the power. With the slide switch in the left position, user
screens cannot be displayed. Therefore, the slide switch must always be in
the right position (OFF).

DIP Switch SW2

Pin number Signal name Name

1 FG Functional ground

2 SG Signal ground

3 Not Connected

4 RDA(−) Receive data

5 Not Connected

6 RDB(+) Receive data

7 Not Connected

8 SDA(−) Send data

9 Not Connected

10 SDB(+) Send data

13579

10 8 6 4 2

COM2

S2+ S2− R2+ R2−

FG

Pin No. Function ON OFF

Pin 1 COM2 RS422A/485 
setting

RS-485 RS-422A

Pin 2 COM2 RS-422A/485 
setting

RS-485 RS-422A

Pin 3 COM2 terminating 
resistance setting

Terminating resistance 
enabled

Terminating resistance 
disabled

Pin 4 Not used --- ---

ON OFF
DIP switch



16

Specifications Section 2-2

Set the RS-422A/RS-485 of the COM2 serial port and the terminating resis-
tance. When using RS-422A, set pin 1 and 2 to OFF. When using RS-485, set
pin 1 and 2 to ON. 

When connecting to the host using RS-422A/485, set pin 3 to ON (enable the
terminating resistance) of the PT connected at the end. Also when using a 1:1
connection, set pin 3 to ON (enable the terminating resistance). 
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SECTION 3
Installing the PT and Connecting Peripheral Devices

This section describes the methods used to install the PT and connect peripheral devices.

3-1 Installing the PT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

3-1-1 Installation Environment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

3-1-2 Mounting the PT to the Control Panel . . . . . . . . . . . . . . . . . . . . . . . 19

3-1-3 Connecting the Power Supply . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

3-1-4 Wiring the Ground Wire. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

3-2 Starting the PT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

3-3 Connecting the NP-Designer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

3-3-1 Connecting via RS-232C . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

3-3-2 Connecting via USB. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

3-4 Connecting with a 1:1 NT Link . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

3-4-1 Connection Methods  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

3-4-2 Unit Setting Methods . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

3-5 Connecting with 1:N NT Links  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

3-5-1 Connection Methods  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

3-5-2 Unit Setting Methods . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

3-6 High-speed 1:N NT Links  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

3-6-1 Unit Setting Methods . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

3-7 Host Link  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

3-7-1 Connection Methods  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

3-7-2 Unit Setting Methods . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
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3-1 Installing the PT
The methods used to mount the PT to the control panel and connect the
power supply are described here.

3-1-1 Installation Environment
Always mount the PT to the control panel and perform other installation proce-
dures according to the following precautions.

! WARNING

After the NP-series PT has been installed, qualified 
personnel must confirm the installation, and must 
conduct test operations and maintenance. 
The qualified personnel must be qualified and autho-
rized to secure safety at each phases of design, 
installation, running, maintenance, and disposal of 
system.

A qualified person in charge, who is familiar with the 
machine, must conduct and verify the installation of 
the NP-series PT.

Do not install the PT in any of the following locations:
• Locations subject to extreme temperature changes.

• Locations subject to temperatures or humidity outside the ranges in
the specifications.

• Locations subject to high humidity that may result in condensation.

• Locations that would subject the PT to chemicals.

• Locations that would subject the PT to oil.

• Locations subject to corrosive or flammable gases.

• Locations that would subject the PT to direct shock or vibration.

• Locations that would directly expose the PT to wind or rain.

• Locations subject to strong ultraviolet light.

Provide proper shielding measures when installing in the following loca-
tions:
• Locations subject to static electricity or other sources of noise.

• Locations subject to strong electromagnetic fields.

• Locations near power supply lines.

• Locations subject to possible exposure to radiation.

Precautions 
for Correct Use

When unpacking the PT and peripheral devices, check for any external 
damage. Shake the product gently and check for any abnormal sounds.

Precautions 
for Safe Use
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3-1-2 Mounting the PT to the Control Panel
The PT is flush-mounted to the control panel.

The PT is mounted using the panel mounting brackets provided with the PT,
and tools, such as a Phillips screwdriver.

Use the following procedure to mount the PT to the control panel.

1,2,3... 1. Make a hole in the panel for flush mounting according to the following di-
mensions and insert the PT from the front of the panel.

2. Secure the panel mounting brackets from the back of the panel, as shown
in the following diagram.
Insert the catch on each bracket into the square hole on the PT, and secure
the PT to the panel by tightening the screws with a Phillips screwdriver
while gently pulling in the PT.

Model Dimensions

NP5 Width 172.4  × Height 132.4  mm

NP3 Width 118.5  × Height 92.5  mm

Recommended panel thickness:
1.6 to 2.5 mm

Width

Height

+1
0

+1
0

+1
0

+1
0

• Always install the PT in the control panel.

• Do not allow metal particles to enter the PT while work is being per-
formed on the panel.

• The allowable thickness of the panel for mounting is between 1.6 and
2.5 mm.
Secure the mounting brackets with a uniform tightening torque of
between 0.7 N·m to keep the PT waterproof and dustproof.
The front sheet may become distorted if the tightening torque is more
than the specified limit or not uniform. Always use a panel that is
clean, not distorted, and strong enough to adequately withstand
mounting the PT.

Precautions 
for Safe Use
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3-1-3 Connecting the Power Supply
Connect a 24-VDC power supply to the power input terminals.

■ Power Supply

The following table shows the specifications for the power supply that can be
connected. Determine power supply specifications that meet the power sup-
ply capacity requirements.

3-1-4 Wiring the Ground Wire
The PT is provided with a functional ground (FG: ) terminal.

Wire the FG terminal according to the following conditions.

1,2,3... 1. Ground according to Figure when there is difference in potential between
the PT and host. Do not ground the functional ground (FG: ) of the PT
if it is far from the host and one-point grounding is difficult.

2. Do not ground the functional ground (FG: ) of the PT if it is mounted to
the same panel as devices that generate noise, such as motors and invert-
ers.

• Do not connect an AC power supply to the DC power terminals.

• Use a DC power supply with low voltage fluctuation.

• Do not perform a dielectric strength test.

• Use a DC power supply that will provide a stable output even if the
input is momentarily interrupted for 10 ms, and which has reinforced
or double insulation. 

Precautions 
for Safe Use

Item Value

Power supply voltage 24 VDC

Allowable voltage range 21.6 to 27.6 VDC (24 VDC −10% to +15%)

Power supply capacity 12 W minimum

 

Functional 
ground Breaker

24 VDC

24 VDC  
power supply

Breaker

• Connect power to the power connector using twisted-pair power lines
with a cross-sectional area of at least 2 mm2 (AWG14).

• The tightening torque of the terminal block is 0.51 N·m. 

Precautions 
for Safe Use

HostPT

One-point  
grounding

Ground correctly to prevent malfunctions caused by noise.Precautions 
for Safe Use
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3-2 Starting the PT
Check that the hardware is connected properly, turn ON the power to the PT,
and then start the PT.

Use the following procedure to start the PT.

Starting the PT For the First Time

1,2,3... 1. Make sure that SW1 (slide switch) on the back is set to the right (OFF).

2. Turn ON the power to the PT. The indicator on the front will light and the
PT is started.

3. The series name, date and time are shown on the display. Confirm whether
the date and time are correct. 

4. Set the date and time in the system menu. To start the system menu, turn
OFF the power, set the slide switch SW1 to the left (ON) and then turn ON
the power again.

Starting the PT to Which Screen Data Were Downloaded

1,2,3... 1. Make sure that SW1 (slide switch) on the back is set to the right (OFF).

2. Turn ON the power to the PT. The indicator on the front will light and the
PT is started.

3. The initial screen of the downloaded screen data is shown on the display.

Starting the System Menu

1,2,3... 1. Set the SW1 (slide switch) on the back to the left (ON).

2. Turn ON the power to the PT. The indicator on the front will light and the
PT is started.

3. The system menu is shown on the display.

Confirm system safety before turning the power ON and OFF.Precautions 
for Safe Use
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3-3 Connecting the NP-Designer
Use an RS-232C or USB cable to connect the PT and computer to transfer
screen data created with the NP-Designer to the PT. 

3-3-1 Connecting via RS-232C
Connect the RS-232C cable from the computer to COM1 serial port.

Communications 
Conditions

The communications conditions are set from the PT Menu of the NP-
Designer. For details, refer to 6-2-4 PT Menu.

Recommended 
Connecting Cables

The following cables are recommended when connecting via RS-232C.

XW2Z-S002 (OMRON, cable length: 2 m) 

(D-Sub male 9-pin and D-Sub female 9-pin, for IBM PC/AT or compatible
computers) 

For details on preparing connecting cables, refer to Appendix D Preparing
Connecting Cables. 

3-3-2 Connecting via USB
Connect the USB port on the computer to the USB slave connector on the PT.
Some preparations are required and some restrictions exist, as described
below. Be sure to connect USB correctly. 

USB Driver for PTs To transfer screens using USB communications, a USB driver for the PT must
be installed in the computer. The USB driver is automatically installed when
the computer is connected to the PT for the first time.
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All models in the NP Series support USB communications. Use a commer-
cially available USB cable to connect the PT to the USB port.

Use a USB cable that is 5 m or shorter. 

• Commercially available and recommended USB Hubs do not have
the same specifications as the NP-series PT. Normal operation may
not be possible in environments subject to noise or static electricity.
When using USB Hubs, be sure to provide sufficient measures to pre-
vent noise and static electricity, or install in a location that is not sub-
ject to noise or static electricity.

• Do not connect the USB connector to any device that is not applica-
ble.

• Before connecting the USB connector to a device, make sure that the
device is free of damage.

Precautions 
for Safe Use
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3-4 Connecting with a 1:1 NT Link

3-4-1 Connection Methods
This section describes the methods for connecting the host to a serial port of
the PT using RS-232C, RS-422A or RS-485 communications. The connection
methods are as follows: 

Direct Connection to 
the COM 1 Serial Port 
Using RS-232C 

This is the easiest connection method. OMRON cables with connectors can
be used, depending on the host being connected.

Connection to COM2 
Serial Port using RS-
422A/485 

This connection method allows an extended communications distance of up
to 500 m. 

Using RS-232C and RS-422A or RS-232C and RS-485 allows connecting two
hosts at the same time. Any combination of devices can be connected to the
PT. 

To use the COM2 serial port, the SW2 DIP switch on the back of the PT must
be set.

HostPT

RS-232C cable 
(15 m max.)

Pin No. Function ON OFF

Pin 1 COM2 RS-422A/485 set-
ting

RS-485 RS-422A

Pin 2 COM2 RS-422A/485 set-
ting

RS-485 RS-422A

Pin 3 COM2 terminating resis-
tance setting

Terminating resis-
tance enabled

Terminating resis-
tance disabled

Pin 4 Not used --- ---

PT Host

RS-422A/RS-485 cable 
(500 m max.)

PT

RS-422A/RS-485 cable

RS-232C cable
Host 1

Host 2

• Always tighten the connector screws after connecting communica-
tions cables. The tightening torque of the serial port COM2 is 0.2 N·m.

• The connector's pull load is 30 N. 
Do not subject the connectors to a greater load than that specified. 

Precautions 
for Safe Use
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Supported Host Units Some models and series of OMRON PLCs have a built-in 1:1 NT Link func-
tion. 

Some PLCs can also be connected in a 1:1 NT Link by adding a Serial Com-
munications Board or Communications Board. 

When connecting the PT to a PLC, check the series and model of the PLC
and the model of the Board mounted to the PLC. 

Refer to Appendix E Standard Models for details on the Units that can be con-
nected to NP-series PTs as hosts using RS-232C, RS-422A or RS-485 com-
munications in a 1:1 NT Link.

Connecting to CPM2C 
PLCs

The CPM2C has a single connector that is the same shape as a CS-series
peripheral port. Internally, the connector has signal lines that are for use with
the CPU's built-in RS-232C port and the peripheral port. Therefore, when
using the CPM2C, use the settings for the CPU's built-in RS-232C port or for
the peripheral port according to the converter cable and port used. When
using a CPM2C1-CIF21 Simplified Communications Unit, connect it to the
RS-232C port. 

Refer to the CPM2C Operation Manual (W356) for details.

Use CS1W-CN118 Connecting Cable to connect the CPM2C to the NP-series
PT using the built-in RS-232C port of the CPM2C. The peripheral port cannot
be used to connect the PT.

When using a CPM2C1-CIF21 Simplified Communications Unit, connect it to
the RS-232C port.

CS/CJ series CPU Units cannot be connected in a 1:1 NT Link. Use a 
1:1 connection through 1:N NT Links (normal or high speed). For 
details, refer to 3-5 Connecting with 1:N NT Links or 3-6 High-speed 
1:N NT Links.

Precautions 
for Correct Use

Port for connecting PT PLC Setup 

CS1W-CN118 port (D-Sub 9-pin) Set for built-in RS-232C. 

CPM2CCS1W-CN118

RS-232C port
(D-SUB 9-pin female)

 

RS-232C port 
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3-4-2 Unit Setting Methods
The methods for setting each Unit are as follows: 

Connecting C Series, C200HX/HG/HE(-Z), CQM1, CPM2A, CPM2C or CQM1H PLCs

PLC Setup Area

Write the settings directly from the Programming Device (CX-Programmer,
etc.) to the PLC Setup Area (in DM Area) according to the host type and port
used.

Using RS-232C 

Note (1) RS-232C port of Communications Board. 

(2) RS-232C port of Serial Communications Board.

Using RS-422A/485

Note (1) RS-422A/485 port of Communications Board. 

(2) RS-422A/485 port of Serial Communications Board. 

Refer to the manuals of the PLC being used for details on using the PLC
Setup Area. 

Setting the Front Panel DIP Switch

Set the DIP switch on the front panel to enable the PLC Setup Area (Data
Memory) settings, as follows:

Using the C200HX/HG/HE(-Z), CQM1, or CQM1H PLCs via RS-232C

Host type Address Write value Settings

Built-in RS-232C port of C200HX/HG/HE(-
Z), CPM2A, CPM2C, CQM1, or CQM1H 

DM 6645 4000 Uses 1:1 NT 
Link

CPM1A DM 6650

Port A of C200HX/HG/HE(-Z) (See note 1.) 
Port 1 of CQM1H (See note 2.)

DM 6555

Port B of C200HX/HG/HE(-Z) (See note 1.) DM 6550

Host type Address Write value Settings

Port A of C200HX/HG/HE(-Z) (See note 1.) DM 6555 4000 Uses 1:1 NT 
LinkPort 2 of CQM1H (See note 2.) DM 6550

C200HX/HG/HE(-Z) CQM1 CQM1H

OFF OFFONON

ON

OFFON

ON

O
N

1 
2 

4 
3 

5 
6 

1 
2 

4 
3 

5 
6 

1 
2 

4 
3 

5 
6 

7 
8 

RS-232C Communications Conditions Setting 
Set pin 5 of the DIP switch to OFF to enable the 
PLC Setup Area settings.
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Using the CPM2A

Using the CPM2C (via RS-232C only) 

Setting the Communications Board Switches (Using RS-422A/485)

Using the C200HX/HG/HE(-Z) 

Switch 1:  (Four-wire method = RS-422A),

 (Two-wire method = RS-485)

Switch 2: ON (terminator ON = terminating resistance used)

Using the CQM1H

Two-wire/four-wire switch (WIRE):  (Four-wire method = RS-422A),

 (Two-wire method = RS-485)

Terminating resistance switch (TERM):ON (terminator ON = terminating resis-
tance used)

IN

00
0CH

0CH

10CH

02 04 06 08 10

OUT

01COM 03 05 07 09 11

COM COM COM 03 COM 06
00 01 02 04 05 07

11CH 00 01 02 03

00 02 04 NC
01 03 05

COM 01 03
00 02

10CH 00 01 02 03 04 05 06 07

00 01 02 03 04 05 06 07 08 09 10 11

00 01 02 03 04 051CH

PWR ERRCOMM ALMRUN
SYSMAC  CPM2A

O
FF

O
N

1CH

11CH

100-240
VAC

L1 L2/N

24VDC 0.3A OUTPUT
PORT

EXP
PERIPHERAL

O
FF

O
N

Set the communications 
conditions setting switch 
to OFF (lower position).

SW1:OFF
SW2:ON

SW1:OFF
SW2:OFF

• Connecting the PT to the built-in RS-232C port (The peripheral 
port is used to connect devices that require non-standard 
communications settings.)

Set the switches according to whether the peripheral port 
or the built-in RS-232C port is used, as follows:

• Connecting the PT to the built-in RS-232C port (The peripheral  
port is used to connect the Programming Console.)

4

2

4

2
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Connecting to CVM1/CV 
Series (-V) PLCs 

PLC Setup

When using CVM1/CV-series PLCs, always set the Execute Process (Execute
Control 2) in the PLC Setup to synchronous execution. 

Setting the Front Panel DIP Switch

Set the DIP switch as follows. When connecting to RS-485, set the switch to
RS-422A.

PORT1

PORT2

RS422
/485

TERM
ON

WIRE
2     4

COMM2OMM2
COMM1OMM1

RDY

SCB41

Serial Communications Board
(Inner Board slot 1)

Terminating resistance switch
Set to ON (right position).

Two-wire/four-wire switch
For RS-422A: Set to 4 to
use four-wire (right position).
For RS-485: Set to 2 to
use two-wire (left position).

Communications path switch

RS-232C

RS-422A

• Switch setting
Set this to RS-232C or RS-422A.

  
(Set terminator ON.)

• Communication Type Setting (DIP switch pin 3) 
Set pin 3 to ON. 
(for NT link communication)

• Terminator setting (DIP switch pin 6, RS-422A/485) 
Set pin 6 to ON.
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3-5 Connecting with 1:N NT Links

3-5-1 Connection Methods
This section describes the methods used to connect NP-series PTs using the
1:N NT Link protocol. 

The COM2 serial port of the PT is used. This connection method can be used
for 1:N NT Link connections (normal, high-speed). 

Supported Host Units

The OMRON PLCs that can be connected in 1:N NT Links are limited to the
CS-series, CJ-series, CP-series, and C-series PLCs. CS-series PLCs can
also be connected in 1:N NT Links by using a CS1W-SCU21 Serial Communi-
cations Unit. CJ-series PLCs can also be connected in 1:N NT Links by using
a CJ1W-SCU41 Serial Communications Unit. 

Check the series and model of the PLC and the model of the Board or Unit
that is mounted to the PLC when connecting the PTs to the host. 

For details on the Units used as hosts that can be connected in 1:N NT Links,
refer to Appendix E Standard Models.

To use the COM2 serial port, the SW2 DIP switch on the back of the PT must
be set.

Reference CS-series PLCs with -V1 suffix support high-speed 1:N NT Links as well as
normal 1:N NT Links. CS-series PLCs without the -V1 suffix can also be con-
nected to high-speed 1:N NT Links if the latest Serial Communications Board/
Unit is used. Refer to 3-6 High-speed 1:N NT Links for details. 

Pin No. Function ON OFF

Pin 1 COM2 RS-422A/485 set-
ting

RS-485 RS-422A

Pin 2 COM2 RS-422A/485 set-
ting

RS-485 RS-422A

Pin 3 COM2 terminating resis-
tance setting

Terminating resis-
tance enabled

Terminating resis-
tance disabled

Pin 4 Not used --- ---

HostPT

RS-422A/RS-485 cable
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3-5-2 Unit Setting Methods
The methods for setting each unit are as follows:

Connecting to CP-series 
PLCs

CP1L-@-@ and CP1H-@-@

PLC Setup Area 

Write the settings directly from the Programming Device or Support Software
(CX-Programmer, etc.) to the PLC Setup Area according to the host type and
port used.

Note When connecting a PROCOM, always set the value for @ to 0.

Setting the Front Panel Switches

Set the DIP switch on the front panel to enable the PLC Setup Area settings,
as follows:

When using the serial port 1, set SW4 to OFF. When using the serial port 2,
set SW5 to OFF. CP1L-L has only one serial port. Therefore there is no DIP
switch SW5.

Connecting to C-series 
C200HX/HG/HE(-Z), and 
CQM1H PLCs

PLC Setup Area 

Write the settings directly from the Programming Device or Support Software
(CX-Programmer, etc.) to the PLC Setup Area (Data Memory) according to
the host type and port used.

Using RS-232C 

Note (1) RS-232C port of Communications Board.

(2) RS-232C port of Serial Communications Board.

(3) The PT unit numbers for the C200HE (-Z) are 0 to 3.

Host type Address Write value Settings

CP1L-M
CP1H

144 8200 Uses 1:N NT Link

145 0000 Baud rate (normal) 38400bps

150 000@ @: Largest unit number (0 to 7) of connected 
PTs. (See note.) 

CP1L-L 160 8200 Uses 1:N NT Link

161 0000 Baud rate (normal) 38400bps

166 000@ @: Largest unit number (0 to 7) of connected 
PTs. (See note.) 

CP1L-M
CP1H

CP1L-L 

N
O1    2    3   4   5    6

N
O1   2   3    4

Host type Address Write value Settings

Built-in RS-232C port of C200HX/
HG/HE(-Z)

DM 6645 5@00 Uses 1:N NT Link

@: Largest unit number 
(0 to 7) of connected 
PTs. (See note 3.) 

Port A of C200HX/HG/HE(-Z) 
(See note 1.)

Port 1 of CQM1H (See note 2.)

DM 6555

Port B of C200HX/HG/HE(-Z) 
(See note 1.)

DM 6550
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Using RS-422A/485

Note (1) RS-422A/485 port of Communications Board.

(2) RS-422A/485 port of Serial Communications Board.

(3) The PT unit numbers for the C200HE (-Z) are 0 to 3.

Refer to the manuals of the PLC being used for details on using the PLC
Setup Area. 

Setting the Front Panel DIP Switch (Using RS-232C)

When using C200HX/HG/HE(-Z), set the DIP switch on the front panel to
enable the PLC Setup Area (Data Memory) settings, as follows:

Setting the Communications Board Switches (Using RS-422A/485)

Using C200HX/HG/HE(-Z)

Switch 1:  (Four-wire method = RS-422A)

 (Two-wire method = RS-485)

Switch 2: ON (terminator ON = terminating resistance used)

Using CQM1H

Two-wire/four-wire switch (WIRE):  (Four-wire method = RS-422A)

 (Two-wire method = RS-485)

Terminating resistance switch (TERM):ON (terminator ON = terminating resis-
tance used)

Host type Address Write value Settings

Port A of C200HX/HG/HE(-Z) 
(See note 1.)

DM 6555 5@00 Uses 1:N NT Link

@: Largest unit number 
(0 to 7) of the con-
nected PTs. (See note 
3.)

Port 2 of CQM1H (See note 2.) DM 6550 5@00

• There is no Communications Board for use with C200HX/HG/HE (-Z)
where port B is an RS-422A/485 port. 

• There is no Communications Board for use with CQM1H where Port 1
is an RS-422A/485 port. 

• When setting a 1:N NT Link in the CX-Programmer, set the baud rate
to 38,400 bps.

Precautions 
for Correct Use

Sets the RS-232C port communications conditions.

Set DIP switch pin 5 to OFF to enable the PLC Setup settings.

ONOFF

1
2

3
4

5
6

O
N

4

2

4

2
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Connecting to CS-series 
CPU Units 

CS1G/H-CPU@@-E(V1) and CS1G/H-CPU@@H

PLC Setup Area 

Using RS-232C

When connecting the PT to a CS-series CPU Unit, set the communications
conditions in the PLC Setup according to the communications port used, as
follows: 

Using Built-in RS-232C Port of CS1G/H or CS1G/H-H

Note (1) Set the baud rate to a numeric value between 0000 to 0009 Hex. (The
setting is the same for any value between 0000 and 0009 Hex.) 

For example, to connect PTs with unit numbers 0, and 2 to 5 to the built-in RS-
232C port in 1:N NT Links, set address 160 to 8200 Hex, and address 166 to
0005 Hex. 

Set whether the PLC Setup is set directly from the Programming Device (Pro-
gramming Console) or created using the Support Software (CX-Programmer)
and transferred to the CPU Unit. 

Refer to the SYSMAC CS Series Operation Manual (W339) for information on
PLC Setup. 

Setting the Front Panel Switches 

Using RS-232C

Set DIP switch pin 4 or 5 of the CPU Unit according to the port to which the
PT is connected, as follows:

PORT1

PORT2

RS422
/485

TERM
ON

WIRE
2     4

COMM2OMM2
COMM1OMM1

RDY

SCB41

Serial Communications Board
(Inner Board slot 1)

Terminating resistance switch
Set to ON (right position).

Two-wire/four-wire switch
For RS-422A: Set to 4 to
use four-wire (right position).
For RS-485: Set to 2 to
use two-wire (left position).

Address Write value Settings

160 8200 1:N NT Link Mode

161 0000 to 0009 
(See note 1.)

Baud rate (normal)

166 000@ @: Largest unit number (0 to 7) of the connected PTs.

When setting a 1:N NT Link in the CX-Programmer, set the baud rate to 
38,400 bps.

Precautions 
for Correct Use
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Connecting to CJ-series 
CPU Units

CJ1G-CPU@@

PLC Setup Area

Using RS-232C

When connecting the PT to a CJ-series CPU Unit, set the communications
conditions in the PLC Setup according to the communications port used, as
follows: 

Using the CJ1G/H-H, CJ1G, or CJ1M Built-in RS-232C Port

Note (1) Set the baud rate to a numeric value between 0000 to 0009 Hex. (The
setting is the same for any value between 0000 and 0009 Hex.)

For example, to connect PTs with unit numbers 0, and 2 to 5 to the built-in RS-
232C port in 1:N NT Links, set address 160 to 8200 Hex, and address 166 to
0005 Hex. 

Set whether the PLC Setup is set directly from the Programming Device (Pro-
gramming Console) or created by the Support Software (CX-Programmer)
and transferred to the CPU Unit. 

Refer to the SYSMAC CJ Series Operation Manual (W393) for information on
the PLC Setup. 

Setting the Front Panel Switches 

Using RS-232C 

Set DIP switch pin 4 or 5 of the CPU Unit according to the port to which the
PT is connected, as follows: 

DIP switch (inside battery compartment)

Peripheral port  
Mainly connected to a programming device. 
(Can be connected to an RS-232C device.) 

RS-232C port 
Mainly connected to an RS-232C device. 
(Can be connected to a computer running 
the CX-Programmer.) 

• Turn ON pin 4 when connecting the 
PT to the peripheral port (to use the 
communications settings in the PLC 
Setup).

• Turn OFF pin 5 when connecting the PT 
to the RS-232C port (to use the 
communications settings in the PLC 
Setup). 

Address Write value Settings

160 8200 1:N NT Link Mode

161 0000 to 0009 
(See note 1.)

Baud rate (normal)

166 00@ @: Largest unit number (0 to 7) of the connected PTs.

When setting a 1:N NT Link in the CX-Programmer, set the baud rate to 
38,400 bps.

Precautions 
for Correct Use
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Connecting to CS-series 
Serial Communications 
Boards 

Serial Communications Boards with RS-232C and RS-422A/485 Ports for
Use with CS-series CPU Units: 

CS1W-SCB21 (Both ports 1 and 2 are RS-232C ports.)

CS1W-SCB41 (Port 1 is an RS-232C port and Port 2 is an RS-422A/485
port.)

Setting DM Area Allocations in CPU Unit 

Write the settings directly from the Programming Device or Support Software
(Programming Console or CX-Programmer) to the DM Area (Parameter Area)
in the CPU Unit. After writing the settings, enable the settings by turning ON
the power again, restarting the Unit, restarting the communications port, or
executing the CHANGE SERIAL PORT SETUP (STUP) instruction. 

The following table shows the allocated DM Area words and settings. 

The allocations and settings are the same for RS-232C and RS-422A/485
(CS1W-SCB41 Port 2). 

Note (1) Set the baud rate to a numeric value between 0000 to 0009 Hex. (The
setting is the same for any value between 0000 and 0009 Hex.) 

For example, to connect PTs with unit numbers 3 to 6 to Port 1 in 1:N NT
Links, set DM32000 to 8200 Hex, DM32001 to 0000 Hex, and DM32006 to
0006 Hex. 

Peripheral port
Connected to a Programming Console or other device. 

RS-232C port
Connected to device other than Programming Console. 

DIP switch (inside battery compartment) 
Turn ON pin 4 when connecting the PT to the peripheral port 
(to use the communications settings in the PLC Setup).  
Turn OFF pin 5 when connecting the PT to the RS-232C port 
(to use the communications settings in the PLC Setup). 

Allocated DM Area words Write value Settings

Port 1 Port 2

DM32000 DM32010 8200 1:N NT Link Mode

DM32001 DM32011 0000 to 0009 
(See note 1.)

Baud rate (normal)

DM32006 DM32016 000@ @: Largest unit number (0 to 7) of the 
connected PTs.

When setting a 1:N NT Links in the CX-Programmer, set the baud rate 
to 38,400 bps

Precautions 
for Correct Use
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Setting the Front Panel Switches

Using RS-422A/485

Connecting to CS-series 
Serial Communications 
Units 

CS1W-SCU21 (Both ports 1 and 2 are RS-232C ports.)

CPU Unit DM Area Settings

Using RS-232C

Write the settings directly from the Programming Device or Support Software
(Programming Console or CX-Programmer) to the DM Area (Parameter Area)
in the CPU Unit. After writing the settings, enable the settings by turning ON
the power again, restarting the Unit, restarting the communications port, or
executing the CHANGE SERIAL PORT SETUP (STUP) instruction. 

The following table shows the allocated DM Area words and settings. 

m = 30000 + 100 × unit number

Note (1) Set the baud rate to a numeric value between 0000 to 0009 Hex. (The
setting is the same for any value between 0000 and 0009 Hex.) 

Setting the Front Panel Switches

Using RS-232C

Set the unit number of the Serial Communications Unit with the rotary
switches on the front of the Unit. Use a flat-blade screwdriver to set the
numerals and symbols in the switches setting display window, as follows: 

ON TERM

4    WIRE

OFF

2

SCB41

Terminating resistance switch (TERM)  
Set to ON:  
Terminating resistance used  
(right position)

Two-wire/four-wire switch (WIRE)  
For RS-422A:  
Set to 4 for four-wire (right position). 
For RS-485:  
Set to 2 for two-wire (left position).

Port 1 
RS-232C

Port 2 
RS-422A/485

PORT1

PORT2 
(RS422/ 
RS485)

RDY
COMM1
COMM2

Allocated DM Area words Write value Settings

Port 1 Port 2

DM m DM m+10 8200 1:N NT Link Mode

DM m+1 DM m+11 0000 to 0009 
(See note 1.)

Baud rate (normal)

DM m+6 DM m+16 000@ @: Largest unit number (0 to 7) of the 
connected PTs.

When setting a 1:N NT Links in the CX-Programmer, set the baud rate 
to 38,400 bps.

Precautions 
for Correct Use
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Connecting to CJ-series 
Serial Communications 
Units 

CJ1W-SCU41 (Port 1 is an RS-422A/485 port and Port 2 is an RS-232C port.)

CPU Unit DM Area Settings 

Write the settings directly from the Programming Device or Support Software
(Programming Console or CX-Programmer) to the DM Area (Parameter Area)
in the CPU Unit. After writing the settings, enable the settings by turning ON
the power again, restarting the Unit, restarting the communications port, or
executing the CHANGE SERIAL PORT SETUP (STUP) instruction. 

The following table shows the allocated DM Area words and settings. 

The allocations and settings are the same for RS-232C, RS-422A and RS-
485.

m = 30000 + 100 × unit number

Note (1) Set the baud rate to a numeric value between 0000 to 0009 Hex. (The
setting is the same for any value between 0000 and 0009 Hex.) 

Setting the Front Panel Switches

SCU21
RUN
ERC
SD1
RD1

RDY
ERH
SD2
RD2

• Unit number settingUNIT
No.

FEDCBA987654
32

Set a value between 0 and F that is not 
the same as that of other Units.

Allocated DM Area words Write value Settings

Port 1 Port 2

DM m DM m+10 8200 1:N NT Link Mode

DM m+1 DM m+11 0000 to 0009 
(See note 1.)

Baud rate (normal)

DM m+6 DM m+16 000@ @: Largest unit number (0 to 7) of the 
connected PTs.

When setting a 1:N NT Link in the CX-Programmer, set the baud rate to 
38,400 bps.

Precautions 
for Correct Use

2

ON

4

TERM

RUN

RD2

SCU41
RD1 TER1

SD2

NO.
UNIT

ERH

SD1

(RS422
/485)

OFF

WIRE

01
23456789ABCDE 

Port 2 
RS-232C

Port 1  
RS-422A/485

For RS-422A: Set to 4 for four-wire operation (right position). 
For RS-485: Set to 2 for two-wire operation (left position).

Two-wire/four-wire switch (WIRE)

Set a value between 0 and F that is not the 
same as these used by other Units in the 
system.

Unit number setting switch

Terminating resistance switch (TERM)

Display indicators

CJ1W-SCU41

PORT2

PORT1

ERC

RDY
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3-6 High-speed 1:N NT Links
Supported Host Units 

The OMRON PLCs that can be connected to high-speed 1:N NT Links using
RS-232C are as follows:

• CS-series PLCs: CS1G/H-V1 and CS1G/H-H 
• CJ-series PLCs: CJ1G, CJ1G/H-H, and CJ1M
• CP-series PLCs: CP1L and CP1H

CS-series PLCs can also be connected in high-speed 1:N NT Links by using a
CS1W-SCU21 Serial Communications Unit or CS1W-SCB21/41 Serial Com-
munications Board. (CS-series PLCs without a -V1 suffix can also be con-
nected in high-speed 1:N NT Links if a Serial Communications Unit is used.) 

CJ-series PLCs can also be connected in high-speed 1:N NT Links by using a
CJ1W-SCU41 Serial Communications Unit. 

The OMRON PLCs that can be connected in high-speed 1:N NT Links using
RS-422A/485 are as follows:

• CS-series PLCs: CS1G/H and CS1G/H-H

• CJ-series PLCs: CJ1G/H-H, CJ1G, and CJ1M

CS-series PLCs can also be connected in high-speed 1:N NT Links by using a
CS1W-SCB41 Serial Communications Board. (CS-series PLCs without -V1
suffix can also be connected in high-speed 1:N NT Links if a Serial Communi-
cations Board is used.) 

CJ-series PLCs can also be connected in high-speed 1:N NT Links by using a
CJ1W-SCU41 Serial Communications Unit. 

Check the series and model of the PLC and the model of the Board or Unit
that are mounted to the PLC when connecting the PT to the host. For details
on the PLCs that can be connected, refer to Appendix E Standard Models.

To use the COM2 serial port, the SW2 DIP switch on the back of the PT must
be set.

3-6-1 Unit Setting Methods
The methods for setting each Unit are as follows: 

Connecting to CP-series 
PLCs

CP1L-@-@ and CP1H-@-@

PLC Setup Area 

Write the settings directly from the Programming Device or Support Software
(CX-Programmer, etc.) to the PLC Setup Area according to the host type and
port used.

Pin No. Function ON OFF

Pin 1 COM2 RS-422A/485 set-
ting

RS-485 RS-422A

Pin 2 COM2 RS-422A/485 set-
ting

RS-485 RS-422A

Pin 3 COM2 terminating resis-
tance setting

Terminating resis-
tance enabled

Terminating resis-
tance disabled

Pin 4 Not used --- ---

Host type Address Write value Settings

CP1L-M
CP1H

144 8200 Uses 1:N NT Link

145 000A Baud rate (high-speed) 115,200bps

150 000@ @: Largest unit number (0 to 7) of connected 
PTs. (See note.) 
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Note When connecting a PROCOM, always set the value for @ to 0.

Setting the Front Panel Switches

Set the DIP switch on the front panel to enable the PLC Setup Area settings,
as follows:

When using the serial port 1, set SW4 to OFF. When using the serial port 2,
set SW5 to OFF. CP1L-L has only one serial port. Therefore there is no DIP
switch SW5.

Connecting to CS-series 
CPU Units 

CS1G/H-CPU@@-EV1/CS1G/H-CPU@@H

PLC Setup Area

Using RS-232C

When connecting the PT to a CS-series CPU Unit, set the communications
conditions in the PLC Setup according to the communications port used, as
follows: 

Using Built-in RS-232C Port of CS1G/H or CS1G/H-H 

For example, to connect PTs with unit numbers 0, and 2 to 5 to the built-in RS-
232C port in high-speed 1:N NT Links, set address 160 to 8200 Hex, address
161 to 000A Hex, and address 166 to 0005 Hex. 

Set whether the PLC Setup is set directly from the Programming Device (Pro-
gramming Console) or created by the Support Software (CX-Programmer)
and transferred to the CPU Unit. 

Refer to the SYSMAC CS Series Operation Manual (W339) for information on
the PLC Setup. 

CP1L-L 160 8200 Uses 1:N NT Link

161 000A Baud rate (high-speed) 115,200bps

166 000@ @: Largest unit number (0 to 7) of connected 
PTs. (See note.) 

Host type Address Write value Settings

CP1L-M 
CP1H

CP1L-L 

N
O1    2    3   4   5    6

N
O1   2   3    4

Address Write value Settings

160 8200 1:N NT Link Mode

161 000A Baud rate (high-speed)

166 000@ @: Largest unit number (0 to 7) of the connected PTs.

To set high-speed 1:N NT Link communications from the CX-Program-
mer, set the baud rate to 115,200 bps. 

Precautions 
for Correct Use
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Setting the Front Panel Switches

Using RS-232C

Set DIP switch pin 4 or 5 of the CPU Unit according to the port to which the
PT is connected, as follows: 

Connecting to CJ-series 
CPU Units 

CJ1G-CPU@@/CJ1G/H-CPU@@-H/CJ1M-CPU@@

PLC Setup Area 

Using RS-232C

When connecting the PT to a CJ-series CPU Unit, set the communications
conditions in the PLC Setup according to the communications port used, as
follows: 

Using the CJ1G/H-H, CJ1G, or CJ1M, Built-in RS-232C Port

For example, to connect PTs with unit numbers 0, and 2 to 5 to the built-in RS-
232C port in 1:N NT Links, set address 160 to 8200 Hex and address 166 to
0005 Hex. 

Set whether the PLC Setup is to be set directly from the Programming Device
(Programming Console) or created by the Support Software (CX-Program-
mer) and transferred to the CPU Unit. 

Refer to the SYSMAC CJ Series Operation Manual (W393) for information on
the PLC Setup. 

Setting the Front Panel Switches

Using RS-232C

Set DIP switch pin 4 or 5 of the CPU Unit according to the port to which the
PT is connected, as follows: 

DIP switch (inside battery compartment)

Peripheral port  
Mainly connected to a programming device. 
(Can be connected to an RS-232C device.) 

RS-232C port 
Mainly connected to an RS-232C device. 
(Can be connected to a computer running 
the CX-Programmer.) 

• Turn ON pin 4 when connecting the 
PT to the peripheral port (to use the 
communications settings in the PLC 
Setup).

• Turn OFF pin 5 when connecting the PT 
to the RS-232C port (to use the 
communications settings in the PLC 
Setup). 

Address Write value Settings

160 8200 1:N NT Link Mode

161 000A Baud rate (high-speed)

166 000@ @: Largest unit number (0 to 7) of the connected PTs.

To set high-speed 1:N NT Link communications from the CX-Program-
mer, set the baud rate to 115,200 bps. 

Precautions 
for Correct Use
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Connecting to CS-series 
Serial Communications 
Boards 

Serial Communications Boards with RS-232C Port for Use with CS-series
CPU Units: 

CS1W-SCB21 (Both ports 1 and 2 are RS-232C ports.) 

CS1W-SCB41 (Port 1 is an RS-232C port and Port 2 is an RS-422A/485
port.) 

CPU Unit DM Area Settings

Write the settings directly from the Programming Device (Programming Con-
sole) or Support Software (CX-Programmer) to the DM Area (Parameter
Area) in the CPU Unit. After writing the settings, enable the settings by turning
ON the power again, restarting the Unit, restarting the communications port,
or executing the CHANGE SERIAL PORT SETUP (STUP) instruction. 

The following table shows the allocated DM Area words and settings. The set-
tings are the same for RS-232C and RS-422A/485 (CS1W-SCB41 Port 2).

For example, to connect PTs with unit numbers 3 to 6 to Port 1 in 1:N NT
Links, set DM32000 to 8200 Hex, DM32001 to 000A Hex, and DM32006 to
0006 Hex. 

Peripheral port
Connected to a Programming Console or other device. 

RS-232C port
Connected to device other than Programming Console. 

DIP switch (inside battery compartment) 
Turn ON pin 4 when connecting the PT to the peripheral port 
(to use the communications settings in the PLC Setup).  
Turn OFF pin 5 when connecting the PT to the RS-232C port 
(to use the communications settings in the PLC Setup). 

High-speed 1:N NT Links can be used with Serial Communications 
Boards and Serial Communications Units from lot numbers 991220 
(December 20, 1999) or later. Boards and Units with earlier lot numbers 
cannot be used, so confirm that the lot number is supported.

Precautions 
for Correct Use

Allocated DM Area words Write value Settings

Port 1 Port 2

DM3200 DM32010 8200 1:N NT Link Mode

DM32001 DM32011 000A Baud rate (high-speed)

DM32006 DM32016 000@ @: Largest unit number (0 to 7) of the 
connected PTs.

To set high-speed 1:N NT Link communications from the CX-Program-
mer, set the baud rate to 115,200 bps. 

Precautions 
for Correct Use
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Setting the Front Panel Switches

Using RS-422A/485

Connecting to CS-series 
Serial Communications 
Units 

CS-series Rack-mounted Type: 

CS1W-SCU21

CPU Unit DM Area Settings 

Write the settings directly from the Programming Device (Programming Con-
sole) or Support Software (CX-Programmer) to the DM Area (Parameter
Area) in the CPU Unit. After writing the settings, enable the settings by turning
ON the power again, restarting the Unit, restarting the communications port,
or executing the CHANGE SERIAL PORT SETUP (STUP) instruction. 

The following table shows the allocated DM Area words and settings. 

Using RS-232C

m = 30000 + 100 × unit number

Setting the Front Panel Switches

Set the unit number of the Serial Communications Unit with the rotary
switches on the front of the Unit. Use a flat-blade screwdriver to set the
numerals and symbols of the switch's setting display window, as follows:

ON TERM

4    WIRE

OFF

2

SCB41

Terminating resistance switch (TERM)  
Set to ON:  
Terminating resistance used  
(right position)

Two-wire/four-wire switch (WIRE)  
For RS-422A:  
Set to 4 for four-wire (right position). 
For RS-485:  
Set to 2 for two-wire (left position).

Port 1 
RS-232C

Port 2 
RS-422A/485

PORT1

PORT2 
(RS422/ 
RS485)

RDY
COMM1
COMM2

High-speed 1:N NT Links can be used with Serial Communications 
Boards and Serial Communications Units from lot numbers 991220 
(December 20, 1999) or later. Boards and Units with earlier lot numbers 
cannot be used, so confirm that the lot number is supported. 

Precautions 
for Correct Use

Allocated DM Area words Write value Settings

Port 1 Port 2

DM m DM m+10 8200 1:N NT Link Mode

DM m+1 DM m+11 000A Baud rate (high-speed)

DM m+6 DM m+16 000@ @: Largest unit number (0 to 7) of the 
connected PTs.

To set high-speed 1:N NT Link communications from the CX-Program-
mer, set the baud rate to 115,200 bps. 

Precautions 
for Correct Use
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Connecting to CJ-series 
Serial Communications 
Units 

CJ1W-SCU41

(Port 1 is an RS-422A/485 port and Port 2 is an RS-232C port.)

CPU Unit DM Area Settings 

Write the settings directly from the Programming Device (Programming Con-
sole or CX-Programmer) to the DM Area (Parameter Area) in the CPU Unit.
After writing the settings, enable the settings by turning ON the power again,
restarting the Unit, restarting the communications port, or executing the
CHANGE SERIAL PORT SETUP (STUP) instruction. 

The following table shows the allocated DM Area words and settings. 

The allocations and settings are the same for RS-232C, RS-422A and RS-
485.

m = 30000 + 100 × unit number

Setting the Front Panel Switches

SCU21
RUN
ERC
SD1
RD1

RDY
ERH
SD2
RD2

• Unit number settingUNIT
No.

FEDCBA987654
32

Set a value between 0 and F that is not 
the same as that of other Units.

Allocated DM Area words Write value Settings

Port 1 Port 2

DM m DM m+10 8200 1:N NT Link Mode

DM m+1 DM m+11 000A Baud rate (high-speed)

DM m+6 DM m+16 000@ @: Largest unit number (0 to 7) of the 
connected PTs.

To set high-speed 1:N NT Link communications from the CX-Program-
mer, set the baud rate to 115,200 bps. 

Precautions 
for Correct Use

2

ON

4

TERM

RUN

RD2

SCU41
RD1 TER1

SD2

NO.
UNIT

ERH

SD1

(RS422
/485)

OFF

WIRE

01
23456789ABCDE 

Port 2 
RS-232C

Port 1  
RS-422A/485

For RS-422A: Set to 4 for four-wire operation (right position). 
For RS-485: Set to 2 for two-wire operation (left position).

Two-wire/four-wire switch (WIRE)

Set a value between 0 and F that is not the 
same as these used by other Units in the 
system.

Unit number setting switch

Terminating resistance switch (TERM)

Display indicators

CJ1W-SCU41

PORT2

PORT1

ERC

RDY
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3-7 Host Link

3-7-1 Connection Methods 
Host Link is a method used to connect a single PT to a single host in a 1:1
connection in the same way as 1:1 NT Link using RS-232C or RS-422A com-
munications.

Connecting to a COM1 Serial Port Using RS-232C

This is the easiest connection method. OMRON cables with connectors can
be used, depending on the host being connected.

Connecting to a COM2 Serial Port Using RS-422A

This connection method allows an extended communications distance of up
to 500 m. 

The two hosts can be connected at the same time by using RS-232C and RS-
422A. Any combination of devices can be connected to the PT. 

To use the COM2 serial port, the SW2 DIP switch on the back of the PT must
be set.

Pin No. Function ON OFF

Pin 1 COM2 RS-422A/485 set-
ting

RS-485 RS-422A

Pin 2 COM2 RS-422A/485 set-
ting

RS-485 RS-422A

Pin 3 COM2 terminating resis-
tance setting

Terminating resis-
tance enabled

Terminating resis-
tance disabled

Pin 4 Not used --- ---

HostPT

RS-232C cable 
(15 m max.)

PT Host

RS-422A/RS-485 cable 
(500 m max.)

PT

RS-422A/RS-485 cable

RS-232C cable
Host 1

Host 2

• Always tighten the connector screws after connecting communica-
tions cables. 

• The connector's pull load is 30 N. 
Do not subject the connectors to a greater load than that specified. 

Precautions 
for Safe Use
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Supported Host Units 

Some models and series of OMRON PLCs have a built-in Host Link function.
Some PLCs can also be connected in a Host Link by adding a Serial Commu-
nications Board or Communications Board. 

When connecting the PT to a PLC, check the series and model of the PLC
and the model of the Board mounted to the PLC. 

Refer to Appendix E Standard Models for details on the Units that can be con-
nected to NP-series PTs as hosts using RS-232C or RS-422A communica-
tions in a Host Link.

Communication Settings 

This table shows the communication settings required at the PT and host to
connect to the host by means of Host Link communications.

Use the PT Menu from NP-Designer to make these setting of the PT. 

Please refer to the 6-2-4 PT Menu for details.

For communication settings of the host, refer to the relevant manual for each
PLC.

3-7-2 Unit Setting Methods
The methods for setting each Unit are as follows: 

Connecting to CP-series 
PLCs

CP1L-@-@ and CP1H-@-@

PLC Setup Area 

Write the settings directly from the Programming Device or Support Software
(CX-Programmer, etc.) to the PLC Setup Area according to the host type and
port used.

Note Set the baud rate to the same value as for the PT unit.

Setting the Front Panel Switches

Set the DIP switch on the front panel to enable the PLC Setup Area settings,
as follows:

When using the serial port 1, set SW4 to OFF. When using the serial port 2,
set SW5 to OFF. CP1L-L has only one serial port. Therefore there is no DIP
switch SW5.

Item Setting

Data Bits 7 bits

Stop Bits 2 bits

Parity Even

Baud rate Any value. Note that values set for the PT and host must be 
the same.

Host Unit No. 0

Host type Address Write value Settings

CP1L-M
CP1H

144 8000 Uses host link

145 0000 to 000A 
(See note.)

Baud rate

150 0000 Unit No. 00 

CP1L-L 160 8000 Uses host link

161 0000 to 000A 
(See note.)

Baud rate

166 0000 Unit No. 00 
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Connecting C-series CPU 
Unit 

C200HX/HG/HE(-Z), CPM1, CPM2A, CPM2C, CQM1, CQM1H CPU Unit and
SRM1

Connecting C-series CPU Unit

PLC Setup Area 

Write the settings directly from the Programming Device or Support Software
(CX-Programmer, etc.) to the PLC Setup Area (Data Memory) according to
the host type and port used. 

CP1L-M 
CP1H

CP1L-L 

N
O1    2    3   4   5    6

N
O1   2   3    4

PLC model RS-232C method RS-422A method

CQM1 • Connect to the CPU Unit's built-
in RS-232C port.

---

C200HX/HG/
HE (-Z)

• Connect to the CPU Unit's built-
in RS-232C port.

• Connect to one of the RS-232C 
ports (port A or port B) on a 
Communications Board.

• Connect to the RS-422A port 
(port A) on a Communications 
Board.

CPM1A • Connect to the peripheral port 
through a CPM1-CIF01 RS-
232C Adapter.

• Connect to the peripheral port 
through a CPM1-CIF11 RS-
422A Adapter.

CPM2A, 
SRM1

• Connect to the CPU Unit's built-
in RS-232C port.

• Connect to the peripheral port 
through a CPM1-CIF01 RS-
232C Adapter.

• Connect to the peripheral port 
through a CPM1-CIF11 RS-
422A Adapter.

CPM2C • Connect to the CPU Unit's RS-
232C port or the peripheral port 
through a Connecting Cable 
(CPM2C-CN111, CS1W-CN118, 
or CS1W-CN114). 
(The CPM2C-CN111 splits the 
Unit's communications port into 
an RS-232C port and a periph-
eral port. A CPM1-CIF01 RS-
232C Adapter is also required to 
connect to this peripheral port.)

• Connect to the peripheral port 
(on a CPM2C-CN111 or 
CS1W-CN114 Connecting 
Cable) through a CPM1-CIF11 
RS-422A Adapter.
(The CPM2C-CN111 splits the 
Unit's communications port into 
a RS-232C port and a periph-
eral port.)

CQM1H • Connect to the CPU Unit's built-
in RS-232C port. 

•  Connect to the peripheral port 
through a CS1W-CN118 Con-
necting Cable.

• Connect to the RS-232C port 
(port 1) on a Serial Communica-
tions Board.

• Connect to the RS-422A port 
(port 2) on a Serial Communi-
cations Board. 
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Using RS-232C 

Note (1) RS-232C port of Communications Board.

(2) RS-232C port of Serial Communications Board.

(3) @@ is the setting value of communication speed. Set the same value as
for the PT unit.

(4) “Standard” in the communication settings refers to the following settings.
Start bit: 1 bit, Data bit: 7bits, Stop bit: 2 bits, Parity: Even

Using RS-422A

Note (1) RS-422A port of Communications Board.

(2) RS-422A port of Serial Communications Board.

(3) @@ is the setting value of communication speed. Set the same value as
for the PT unit.

(4) “Standard” in the communication settings refers to the following settings.
Start bit: 1 bit, Data bit: 7bits, Stop bit: 2 bits, Parity: Even

Refer to the manuals of the PLC being used for details on using the PLC
Setup Area. 

Connecting to CPM2C PLCs

The CPM2C has a single connector that is the same shape as a CS-series
peripheral port. Internally, the connector has signal lines that are for use with
the CPU's built-in RS-232C port and the peripheral port. Therefore, when
using the CPM2C, use the settings for the CPU's built-in RS-232C port or for
the peripheral port according to the converter cable and port used. When
using a CPM2C-CIF21 Simplified Communications Unit, connect it to the RS-
232C port. 

Refer to the CPM2C Operation Manual (W356) for details.

Host type Address Write value Settings

Built-in RS-232C port of 
C200HX/HG/HE(-Z), CPM2A, 
CPM2C, CQM1, CQM1H and 
SRM1

DM6645 0001 Uses Host Link

DM6646 03@@ 
(See note 3.)

Standard (See note 4.)

DM6648 0000 Unit No.00

CPM1A DM6650 0001 Uses Host Link

DM6651 03@@ 
(See note 3.)

Standard (See note 4.)

DM6653 0000 Unit No.00

Port A of C200HX/HG/HE(-Z) 
(See note 1.) 

Port 1 of CQM1H (See note 2.)

DM6555 0001 Uses Host Link

DM6556 03@@ 
(See note 3.)

Standard (See note 4.)

DM6558 0000 Unit No.00

Port B of C200HX/HG/HE(-Z) 
(See note 1.)

DM6550 0001 Uses Host Link

DM6551 03@@ 
(See note 3.)

Standard (See note 4.)

DM6553 0000 Unit No.00

Host type Address Write value Settings

Port A of C200HX/HG/HE(-Z) 
(See note 1.)

DM6555 0001 Uses Host Link

DM6556 03@@ (*3) Standard (See note 4.)

DM6558 0000 Unit No.00

Port 2 of CQM1H (See note 2.) DM6650 0001 Uses Host Link

DM6651 03@@ (*3) Standard (See note 4.)

DM6653 0000 Unit No.00
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Use CS1W-CN118 Connecting Cable to connect the CPM2C to the NP-series
PT using the built-in RS-232C port of the CPM2C. The peripheral port cannot
be used to connect the PT.

When using a CPM2C1-CIF21 Simplified Communications Unit, connect it to
the RS-232C port. 

Setting the Front Panel Switches 

Set the switch on the front panel to enable the PLC Setup Area settings, as
follows:

Setting the Switches on RS-232C of C200HX/HG/HE(-Z), CQM1 and 
CQM1H

Port for connecting PT PLC Setup 

CS1W-CN118 port (D-Sub 9-pin) Set for built-in RS-232C. 

CPM2CCS1W-CN118

RS-232C port
(D-SUB 9-pin female)

 

RS-232C port 

C200HX/HG/HE(-Z) CQM1 CQM1H

OFF OFFONON

ON

OFFON

ON

O
N

1 
2 

4 
3 

5 
6 

1 
2 

4 
3 

5 
6 

1 
2 

4 
3 

5 
6 

7 
8 

RS-232C Communications Conditions Setting 
Set pin 5 of the DIP switch to OFF to enable the 
PLC Setup Area settings.
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Setting the Switches of CPM2A 

Setting the Switches of CPM2C (Only RS-232C can be connected)

Setting the Communications Board Switches (Using RS-422A)

C200HX/HG/HE(-Z)

Switch 1:  (Four-wire method = RS-422A)

Switch 2: ON (terminator ON = terminating resistance used)

CQM1H

Two-wire/four-wire switch (WIRE):  (Four-wire method = RS-422A)

Terminating resistance switch (TERM):ON (terminator ON = terminating resis-
tance used)

IN

00
0CH

0CH

10CH

02 04 06 08 10

OUT

01COM 03 05 07 09 11

COM COM COM 03 COM 06
00 01 02 04 05 07

11CH 00 01 02 03

00 02 04 NC
01 03 05

COM 01 03
00 02

10CH 00 01 02 03 04 05 06 07

00 01 02 03 04 05 06 07 08 09 10 11

00 01 02 03 04 051CH

PWR ERRCOMM ALMRUN
SYSMAC  CPM2A

O
FF

O
N

1CH

11CH

100-240
VAC

L1 L2/N

24VDC 0.3A OUTPUT
PORT

EXP
PERIPHERAL

O
FF

O
N

Set the communications 
conditions setting switch 
to OFF (lower position).

SW1:OFF
SW2:ON

SW1:OFF
SW2:OFF

• Connecting the PT to the built-in RS-232C port (The peripheral 
port is used to connect devices that require non-standard 
communications settings.)

Set the switches according to whether the peripheral port 
or the built-in RS-232C port is used, as follows:

• Connecting the PT to the built-in RS-232C port (The peripheral  
port is used to connect the Programming Console.)

4

4

PORT1

PORT2

RS422
/485

TERM
ON

WIRE
2     4

COMM2OMM2
COMM1OMM1

RDY

SCB41

Serial Communications Board
(Inner Board slot 1)

Terminating resistance switch
Set to ON (right position).

Two-wire/four-wire switch
For RS-422A: Set to 4 to
use four-wire (right position).
For RS-485: Set to 2 to
use two-wire (left position).
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Setting the Switches on a Communication Adapter

Using a CPM1-CIF01 RS-232C Adapter

Set the mode switch to Host (upper position).

Using a CPM1-CIF11 RS-422 Adapter

Set the terminator selector switch to ON (upper position).

Connecting to CVM1/CV 
Series (-V@) CPU Units

CV500-CPU01-V1/CV1000-CPU01-V1/CV2000-CPU01-V1

CVM1-CPU01-V2/CVM1-CPU11-V2/CVM1-CPU21-V2

PLC Setup 

Set the communication conditions in the Host Link setting of the PLC Setup,
as follows.

Set whether the PLC Setup is set directly from the Programming Device (Pro-
gramming Console) or created by the Support Software (CX-Programmer)
and transferred to the CPU Unit.

For details on the PLC Setup, refer to the SYSMAC CVM1/CV500/CV1000/
CV2000 Programming Manual: Ladder Diagrams (W202-E1-@). 

Setting the Front Panel DIP Switch 

 Set the switch as follows.

Item Setting

Baud rate Same as the value of the PT

Stop Bits 2 bits

Parity Even

Data Bits 7 bits

Unit No. 00

Communications path switch

RS-232C

RS-422A

• Switch setting
Set this to RS-232C or RS-422A.

(Set terminator ON.)

• Communication Type Setting (DIP switch pin 3) 
Set pin 3 to OFF.  
(for host link communication)

• Terminator setting (DIP switch pin 6,RS-422A)  
Set pin 6 to ON.
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Connecting to CS-Series 
CPU Units

CS1G/H-CPU@@(-V) and CS1G/H-CPU@@H

Connection Method

Connect to the built-in RS-232C port of the CPU Unit, or the RS-232C port of
the Communications Board. Note that the connection to a peripheral port
must be made via an RS-232C adapter (CS1W-CN118) specially designed for
connecting to a peripheral port. 

PLC Setup Area 

When connecting to a CS-series CPU Unit, set the following communications
conditions for the PLC Setup area according to the communication port used.

Note (1) Set the same baud rate as for the PT.

Set whether the PLC Setup is set directly from the Programming Device (Pro-
gramming Console) or created by the Support Software (CX-Programmer)
and transferred to the CPU Unit. 

Refer to the SYSMAC CS Series Operation Manual (W339) for information on
the PLC.

Setting the Front Panel Switches

Set DIP switch pin 4 or 5 of the CPU Unit according to the port to which the
PT is connected, as follows: 

Connecting to CJ-series 
CPU Units 

CJ1G-CPU@@

Connection Method

Connect to the built-in RS-232C port of the CPU Unit, or the RS-232C port of
the Communications Board. Note that the connection to a peripheral port
must be made via an RS-232C adapter (CS1W-CN118) specially designed for
connecting to a peripheral port. 

Connection Method Address Write Value Setting

Uses built-in RS-232C port of 
CS1G/H, CS1G/H-H

160 8000 Uses Host Link

161 0000 to 000A 
(See note 1.)

Baud rate

163 0000 Unit No. 00

Uses built-in peripheral port of 
CS1G/H, CS1G/H-H

144 8000 Uses Host Link

145 0000 to 000A 
(See note 1.)

Baud rate

147 0000 Unit No. 00

DIP switch (inside battery compartment)

Peripheral port  
Mainly connected to a programming device. 
(Can be connected to an RS-232C device.) 

RS-232C port 
Mainly connected to an RS-232C device. 
(Can be connected to a computer running 
the CX-Programmer.) 

• Turn ON pin 4 when connecting the 
PT to the peripheral port (to use the 
communications settings in the PLC 
Setup).

• Turn OFF pin 5 when connecting the PT 
to the RS-232C port (to use the 
communications settings in the PLC 
Setup). 
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PLC Setup 

When connecting to a CJ-series CPU Unit, set the following communications
conditions for the PLC Setup area according to the communication unit used. 

Note (1) Set the same baud rate as for the PT.

Set whether the PLC Setup is set directly from the Programming Device (Pro-
gramming Console) or created using the Support Software (CX-Programmer)
and transferred to the CPU Unit. 

Refer to the SYSMAC CJ Series Operation Manual (W393) for information on
PLC Setup. 

Setting the Front Panel Switches 

Set DIP switch pin 4 or 5 of the CPU Unit according to the port to which the
PT is connected, as follows: 

Connecting to a C Series 
Host Link Unit 

C200H/C200HE(-Z)E/C200HG(-Z)E/C200HX(-Z)E 
Rack-mounted Type: C200H- LK201/LK202-V1 

C1000H/C2000H Rack-mounted Type: C500-LK201-EV1 

1000H(F)/C2000H Rack-mounted Type: C500-LK203 

C200H/C1000H/C2000H CPU-mounted Type: C120- LK201/LK202-EV1 

Setting the Switches 

- C200H-LK201-V1 (RS-232C)

Setting the Front Switches

Set each switch with a flat blade screwdriver so that the values or symbols in
the setting value window agree with the following. 

Connection Method Address Write Value Setting

Uses built-in RS-232C port of 
CJ1G-CPU@@

160 8000 Uses Host Link

161 0000 to 000A 
(See note 1.)

Baud rate

163 0000 Unit No. 00

Uses peripheral port of CJ1G-
CPU@@

144 8000 Uses Host Link

145 0000 to 000A 
(See note 1.)

Baud rate

147 0000 Unit No. 00

Peripheral port
Connected to a Programming Console or other device. 

RS-232C port
Connected to device other than Programming Console. 

DIP switch (inside battery compartment) 
Turn ON pin 4 when connecting the PT to the peripheral port 
(to use the communications settings in the PLC Setup).  
Turn OFF pin 5 when connecting the PT to the RS-232C port 
(to use the communications settings in the PLC Setup). 
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Setting the Rear Switches

- C200H-LK202-V1 (RS-422A)

Setting the Front Switches

Set each switch with a flat blade screwdriver so that the values or symbols in
the setting value window agree with the following. 

Setting the Rear Switches

• Unit # (SW1, SW2) 
Set these switches to 0.

• Command level, parity, and transfer code (SW4) 
 Set this switch to 2. 

• Communications speed (SW3) 

Set this switch to 4 to select 4,800 bps.  
Set this switch to 5 to select 9,600 bps.   
Set this switch to 6 to select 19,200 bps. 

 

 

• 1-to-1/1-to-N selection (DIP switch) 
 Set #3 to ON. 

• CTS selection (selection switch) 
 Set this always to 0 V (ON). 

  

• Unit # (SW1, SW2) 
 Set these switches to 0. 

• Command level, parity, and transfer code (SW4) 
 Set this switch to 2. 

• Communications speed (SW3) 

Set this switch to 4 to select 4,800 bps.  
Set this switch to 5 to select 9,600 bps.  
Set this switch to 6 to select 19,200 bps. 

 

• Terminator setting (selector switch) 
 Set this switch to ON (upper position). 

• 1-to-1/1-to-N protocol selection (selector switch) 
Set this switch to 1-to-N (OFF) (lower position). 
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- C500-LK201-EV1

Setting the Front Switches

Setting the Rear Switches

 

• Mode selector (key switch) 
 Set this to Host link. 

 

• I/O port selection (selector switch)   
Switch this to RS-232C (lower) or RS-422 (upper).   
Set this to RS-422 to connect to RS485. 

• Unit # (DIP SW1)  
Set SW1-1 to SW1-5 to OFF (0). 

• Synchronization (selector switch)  
Set this to Internal (upper). 

• Terminator setting (selector switch)  
Set this switch to ON (lower). 

• Communications speed   
(DIP SW2-1 to SW2-1 to SW2-4)  
Set these switches to 0010 to select 19,200 bps. 
Set these switches to 1010 to select 9,600 bps. 
Set these switches to 0110 to select 4,800 bps. 
(0:OFF 1:ON)

• 1-to-1/1-to-N selection (DIP SW2-6)  
Set SW2-6 to OFF (0) (1-to-N). 

• Command level (DIP SW2-7, SW2-8)   
Set these switches to ON (1).   
(Levels 1, 2 and 3 are enabled.)  

• CTS selection (selector switch)  
Set this always to 0 V (ON) (upper).  
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- C500-LK203

Setting the Rear Switches

 

 

 
  

• I/O port selection (selector switch)   
Switch this to RS-232C (lower) or RS-422 (upper).  
Set this to RS-422 to connect to RS485. 

• Unit #, parity, and transfer code   
(DIP SW1-1 to SW1-7)  
Set SW1-1 to SW1-7 to OFF

• Synchronization (selector switch)  
Set this to Internal (upper). 

• Terminator setting (selector switch)   
Set this switch to ON (lower).  

• Communications speed (DIP SW2-1 to SW2-4)   
Set these switches to 0010 to select 19,200 bps.   
Set these switches to 1010 to select 9,600 bps.   
Set these switches to 0110 to select 4,800 bps.   
(0: OFF 1: ON)  

• 1-to-1/1-to-N selection (DIP SW2-6)    
Set SW2-6 to OFF (0) (1-to-N).  

• Command level (DIP SW2-7, SW2-8)    
Set these switches to ON (1).    
(Levels 1, 2, and 3 are enabled.)  

• CTS selection (selector switch)   
Set this always to 0 V (ON) (upper).  
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- C120- LK201-V1

Setting the Rear Switches

- C120- LK202-V1

Setting the Rear Switches

 

 

• Unit #, parity, and transfer code  
(DIP SW1-1 to SW1-5)     
Set SW1-1 to SW1-5 to OFF (0).

* Parity is fixed at Even Parity.     
Transfer code is fixed at ASCII 7 data bits  
and 2 stop bits. 

• Communications speed (DIP SW2-1 to SW2-4)    
Set these switches to 0010 to select 19,200 bps.    
Set these switches to 1010 to select 9,600 bps.    
Set these switches to 1110 to select 4,800 bps.  
(0: OFF 1: ON)

• 1-to-1/1-to-N selection (DIP SW2-6)    
Set SW2-6 to OFF (0) (1-to-N).

• Command level (DIP SW2-7, SW2-8)    
Set these switches to ON (1).    
(Levels 1, 2, and 3 are enabled.)

• CTS selection (DIP SW3-1 and SW3-2)    
Set SW3-1 to ON (1), and SW3-2 to OFF (0).   
(Set this always to 0V.) 

• Synchronization (DIP SW3-3 to SW3-6)    
Set SW3-3 and SW3-5 to ON (1), and SW3-4 
and SW3-6 to OFF (0).     
(Set these to Internal.)  

 

• Unit #, parity, and transfer code 
(DIP SW1-1 to SW1-5)     
Set SW1-1 to SW1-5 to OFF (0).  

* Parity is fixed at Even Parity.    
Transfer code is fixed at ASCII 7 data bits  
and 2 stop bits. 

• Communications speed (DIP SW2-1 to SW2-4)    
Set these switches to 0010 to select 19200 bps.    
Set these switches to 1010 to select 9600 bps.    
Set these switches to 0110 to select 4,800 bps. 
(0: OFF 1: ON)   

• 1-to-1/1-to-N selection (DIP SW2-6)    
Set SW2-6 to OFF (0) (1-to-N).   

• Command level (DIP SW2-7, SW2-8)    
Set these switches to ON (1).     
(Levels 1, 2, and 3 are enabled.)  

• Terminator setting (DIP SW3-3 to SW3-6)    
Set SW3-1, SW3-3 and SW3-5 to ON (1),    
and SW3-2, SW3-4 and SW3-6 to OFF (0).   
(Set these to on.)  
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Connecting to CVM1/CV 
Series Host Link Units 

CVM1/CV-series Rack-mounted type: CV500-LK201 

Connection Method

A CVM1/CV series host link unit (CV500-LK201) has two connectors (com-
munications ports 1 and 2). 

• Communications port 1 
Communications port 1 is a 25-pin connector for RS-232C use only. 

• Communications port 2
Communications port 2 is a 9-pin connector which allows selection of the
RS-232C or RS-422A method. To make the selection, use the Communi-
cations path switch on the front panel.

Setting the Front Panel Switches

Connecting to CS-series 
Serial Communications 
Boards 

Serial Communications Boards with RS-232C and RS-422A Ports for Use
with CS-series CPU Units: 

CS1W-SCB21 (Both ports 1 and 2 are RS-232C ports.)

CS1W-SCB41 (Port 1 is an RS-232C port and Port 2 is an RS-422A port.)

Setting DM Area Allocations in CPU Unit 

Write the settings directly from the Programming Device or Support Software
(Programming Console or CX-Programmer) to the DM Area (Parameter Area)
in the CPU Unit. After writing the settings, enable the settings by turning ON
the power again, restarting the Unit, restarting the communications port, or
executing the CHANGE SERIAL PORT SETUP (STUP) instruction. 

The following table shows the allocated DM Area words and settings. 

 

 

  

• Unit # (SW3, SW4)   
When using communication port 2, set these 
switches to 0. 

• Communications path switch (selector switch) 
Switch this to RS-232C (lower) or RS-422 (upper). 
Set this to RS-422 to connect to RS485.

• CTS selection (DIP Switch pin 2 and 3)   
Set pin 2 or 3 to ON. (Set this always to 0V.)  To 
use communication port 1, set pin 2.   
To use communication port 2, set pin 3.  

• Communication condition setting (DIP switch pin 1)     
Set this switch to OFF.     
Communication is executed in accordance with the 
CPU bus unit system settings made at the PLC.     
The initial values for the system settings are as follows.  
• Communications speed: 9600 bps
• Parity: Even
• Xon/Xoff control: Not executed
• Communication method: Full duplex
• Stop bits: 2 stop bits
• Data length: 7 bits

• Terminator setting (selector switch)    
Set this switch to ON (upper position).  
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The allocations and settings are the same for RS-232C and RS-422A (CS1W-
SCB41 Port 2).

Note (1) Set the baud rate to the same value as that of the PT.

Setting the Front Panel Switches

Using RS-422A

Connecting to CS-series 
Serial Communications 
Units 

CS1W-SCU21 (Both ports 1 and 2 are RS-232C ports.)

CPU Unit DM Area Settings

Write the settings directly from the Programming Device or Support Software
(Programming Console or CX-Programmer) to the DM Area (Parameter Area)
in the CPU Unit. After writing the settings, enable the settings by turning ON
the power again, restarting the Unit, restarting the communications port, or
executing the CHANGE SERIAL PORT SETUP (STUP) instruction. 

The following table shows the allocated DM Area words and settings. 

m = 30000 + 100 × unit number

Note (1) Set the baud rate to the same value as that of the PT.

Setting the Front Panel Switches

Set the unit number of the Serial Communications Unit with the rotary
switches on the front of the Unit. Use a flat-blade screwdriver to set the
numerals and symbols in the switches setting display window, as follows: 

Allocated DM Area words Write value Settings

Port 1 Port 2

DM32000 DM32010 8000 Host Link Mode

DM32001 DM32011 0000 to 000A 
(See note 1.)

Baud rate

DM32003 DM32013 0000 Unit No. 00

ON TERM

4    WIRE

OFF

2

SCB41

Terminating resistance switch (TERM)  
Set to ON:  
Terminating resistance used  
(right position)

Two-wire/four-wire switch (WIRE)  
For RS-422A:  
Set to 4 for four-wire (right position). 
For RS-485:  
Set to 2 for two-wire (left position).

Port 1 
RS-232C

Port 2 
RS-422A/485

PORT1

PORT2 
(RS422/ 
RS485)

RDY
COMM1
COMM2

Allocated DM Area words Write value Settings

Port 1 Port 2

DM m DM m+10 8000 Host Link Mode

DM m+1 DM m+11 0000 to 000A (See note 1.) Baud rate

DM m+3 DM m+13 0000 Unit No. 00
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Connecting to CS-series 
Serial Communications 
Units 

CS-series Rack-mounted Type: 

CJ1W-SCU41 (Port 1 is an RS-422A port and Port 2 is an RS-232C port.)

CPU Unit DM Area Settings 

Write the settings directly from the Programming Device or Support Software
(Programming Console or CX-Programmer) to the DM Area (Parameter Area)
in the CPU Unit. After writing the settings, enable the settings by turning ON
the power again, restarting the Unit, restarting the communications port, or
executing the CHANGE SERIAL PORT SETUP (STUP) instruction. 

The following table shows the allocated DM Area words and settings. 

The allocations and settings are the same for RS-232C and RS-422A. 

m = 30000 + 100 × unit number

Note (1) Set the baud rate to the same value as that of the PT.

Setting the Front Panel Switches

SCU21
RUN
ERC
SD1
RD1

RDY
ERH
SD2
RD2

• Unit number settingUNIT
No.

FEDCBA987654
32

Set a value between 0 and F that is not 
the same as that of other Units.

Allocated DM Area words Write value Settings

Port 1 Port 2

DM m DM m+10 8000 Host Link Mode

DM m+1 DM m+11 0000 to 000A (See note 1.) Baud rate

DM m+3 DM m+13 0000 Unit No. 00

2

ON

4

TERM

RUN

RD2

SCU41
RD1 TER1

SD2

NO.
UNIT

ERH

SD1

(RS422
/485)

OFF

WIRE

01
23456789ABCDE 

Port 2 
RS-232C

Port 1  
RS-422A/485

For RS-422A: Set to 4 for four-wire operation (right position). 
For RS-485: Set to 2 for two-wire operation (left position).

Two-wire/four-wire switch (WIRE)

Set a value between 0 and F that is not the 
same as these used by other Units in the 
system.

Unit number setting switch

Terminating resistance switch (TERM)

Display indicators

CJ1W-SCU41

PORT2

PORT1

ERC

RDY
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3-8 Connecting to Temperature Controllers

3-8-1 Overview
The PT can communicate with up to 31 of EJ1 modular temperature control-
lers via RS-485 using the PT's COM2 serial port. The PT can also communi-
cate with other host via RS-232C using the COM1 serial port while
communicating with the EJ1.

3-8-2 Wiring
The PT's COM2 is connected to the EJ1's port B via RS-485. For details on
the cable wiring diagram, please refer to Appendix D Preparing Connecting
Cables for Host Connection.

3-8-3 Communications Settings 
Set the communication settings of the EJ1 modular temperature controller
and PT.

The communications settings must be set for the PT using the NP-Designer.
For information on how to set EJ1 modular temperature controller, please
refer to EJ1 Modular Temperature Controller User's Manual. For information
on how to set communication details using the NP-Designer, please refer to 6-
2-4 PT Menu. 

Connecting to RS-485

EJ1NP-series PT

(max.extension:50m)
Up to 31 temperature controller 
scan be connected.
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3-9 Using USB Flash Memory
USB flash memory can be used with the PT to perform the following opera-
tions.

• Transferring screen data from the computer to the PT

• Transferring screen data from the PT to the computer

• Updating the PT system

3-9-1 Transferring Data with USB Flash Memory 

Transferring Screen Data from the Computer to the PT
Use the following procedure to transfer screen data created with the NP-
Designer to the PT.

1,2,3... 1. Insert the USB flash memory into the computer.

2. Use the NP-Designer's File Menu to transfer the screen data to the USB
flash memory. Refer to 6-2-1 File Menu.

3. Set the SW1 slide switch on the back of the PT to ON (left position). Then
turn the power of the PT to OFF and then ON. The system menu will be
started. 

4. Remove the USB flash memory from the computer. Then insert it to the
USB (host) connector on the back of the PT. Unless the buzzer is turned
OFF, the PT will make a peeping sound when it detects the USB flash
memory.

5. Use the file menu of the system menu to transfer the screen data stored in
the USB flash memory to the PT. For details, refer to SECTION 4 System
Menu for details.

6. Remove the USB flash memory from the PT.

7. Set the SW1 slide switch on the back of the PT to OFF (right position).

Transferring Screen Data from the PT to the Computer
Use the following procedure to transfer screen data from the PT to the com-
puter.

1,2,3... 1. Insert the USB flash memory to the USB (host) connector on the back of
the PT.

2. Set the SW1 slide switch on the back of the PT to ON (left position). Then
turn the power of the PT to OFF and then ON. The system menu will be
started.

3. Use the file menu of the system menu to transfer the screen data stored in
the USB flash memory to the PT. For details, refer to SECTION 4 System
Menu.

4. Remove the USB flash memory from the PT.

5. Insert the USB flash memory into the computer.

6. Use the File Menu from the NP-Designer to transfer the screen data stored
in the USB flash memory to the PT. For details, refer to 6-2-1 File Menu.

7. Remove the USB flash memory from the computer.

Only FAT 32 formatted USB flash memory can be used.Precautions 
for Correct Use
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Updating the PT 
system

Use the following procedure to update the PT system.

1,2,3... 1. Insert the USB flash memory into the computer.

2. Use the File Menu from the NP-Designer to transfer the system program
to the USB flash memory. For details, refer to 6-2-1 File Menu.

3. Remove the USB flash memory from the computer. Then insert it into the
USB (host) connector.

4. Set the SW1 slide switch on the back of the PT to ON (left position). Then
turn the power of the PT to OFF and then ON. The system menu is started
up.

5. Use the file menu of the system menu to transfer the system program
stored in the USB flash memory to the PT. For details, refer to SECTION 4
System Menu. 

6. Remove the USB flash memory from the PT.

If the PT system is damaged due to the power being turned OFF while a file is
being transferred, or other reason, using normal downloading to replace the
system programs may not be possible. For details on troubleshooting, refer to
7-3 Troubleshooting.

• Do not perform the following operations while accessing the USB
flash memory. The data may be damaged and the USB flash memory
may need to be formatted.

• Turn OFF the power to the PT. 

• Remove the USB flash memory.

• Always follow the procedure for removing the USB flash memory from
the computer.

Precautions 
for Correct Use
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SECTION 4
System Menu

This section describes the System Menu. 

4-1 Displaying System Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

4-2 Functions of System Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
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4-1 Displaying System Menu
Use one of the following methods to display the System Menu.

1,2,3... 1. Press a Function Switch to which a function that can switch a screen to the
System Menu is allocated. 
For details on Function Switch, refer to 6-2-6 Screen Menu.

2. Press a button to which a function that can switch a screen to the System
Menu is allocated.

3. Set the SW1 (slide switch) on the back to the left (ON) and start the PT.
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4-2 Functions of System Menu
The following buttons are displayed on the System Menu.

Press Setting Button to show the following screen.
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This table describes the function of each button.

Item Functions

PROCON Starts Programming Console functions.

Set the protocol to NT link (1:N) (standard or high-speed) and set the NT/
PC Link Max. parameter to 0 in the PLC Setup. The Programming Con-
sole functions will work only with the 1:N NT Link protocol. It will not work 
with other protocols. Use a 1:1 connection with a 1:N NT Link connection 
configuration (standard or high-speed). 
For details on Programming Console operations, refer to Programming 
Console Operation Manual (W341)
To change the language of the key operation descriptions, press the 3 
Key when the LCD shows “JPN→ENG” or “ENG→JPN.”

File Transfers screen data and system using a USB flash memory.

Updates system using a USB flash memory.

Initializes the user area of the PT.

Downloads screen data from a USB flash memory.

Uploads screen data to a USB flash memory.

Transfer Serial Transfers screen data and system via a COM port.

Select the port to be used in the COM Port Upload/Download Dialog 
Box so that the PT prepares to receive screen data.

To transfer data using a COM port, select PC COM Port option in the 
Option Dialog Box from Tools Menu of the NP-Designer.
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Transfer Serial

Item Functions
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Settings System Sets the standard settings and communications settings.

1. Standard Settings

Buzzer ON/OFF Sets whether a buzzer sound is heard 
or not.

Screen Saver Time 
(Min.)

Sets the duration of time before the 
screen saver starts. The unit is minute. 

Startup Delay Time 
(Sec)

Sets the duration of time before the PT 
starts. The unit is second.

Default Language (ID) Sets the default language when using 
more than one language.

2. Communications settings
Sets the communication settings of each COM port.

Date/Time Sets the date and time.

Item Functions
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Settings Adjust LCD Adjusts the display.

The default settings may not be the most suitable settings for the LCD. 

Adjusts the contrast.

Adjusts the brightness. NP5 does not support this function.

Adjusts the refresh rate.

Set to Default LCD Sets to the default settings.

Put Contrast Cen-
ter

Sets the contrast to the center value. 

Calibrate Calibrates the displayed position of the screen and the actual position of 
the touch panel.
Markers will appear at the upper left, lower right, and center of the 
screen. Press each marker in order. 

Be sure to press the very center of the markers displayed on the screen. 

Calibrate the screen approximately once every six months under normal 
conditions and operation. If the PT is used in a severe environment, cali-
brate the screen more often. 

Backup Backups data when the battery is replaced.
For details, refer to Replacing the Battery in 7-1 Maintenance.

Return Returns to the initial screen of the System Menu.

Exit Exits the System Menu and switches to the user screen. Even if Exit But-
ton is pressed, the System Menu will not be switched to the user screen 
when the System Menu was displayed by using a switch on the back of 
the PT.

Item Functions
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SECTION 5
Installing and Starting NP-Designer

Make sure that you install the NP-Designer on the computer before you use it for the first time. NP-Designer is
application software that runs on a Windows 2000 or XP operating system.

5-1 Preparing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

5-2 Installing/Uninstalling  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

5-2-1 Installing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

5-2-2 Uninstalling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

5-3 Starting/Exiting NP-Designer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

5-3-1 Starting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

5-3-2 Exiting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

5-4 Installing USB Drivers for NP-series PTs . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
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5-1 Preparing 
This table shows the system requirements for the NP-Designer. 

System Requirements
Item Minimum Requirements

Operating System 
(OS)

Microsoft Windows 2000 (Service Pack 4)
Microsoft Windows XP (Service Pack 2)

CPU Pentium III 500 MHz
(Pentium III 1 GHz or faster recommended.)

Memory 256 MB

Hard Disk 100 MB

Display SVGA (800 x 600)
256 colors

Communications 
port

USB port
RS-232C port
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5-2 Installing/Uninstalling

5-2-1 Installing
1,2,3... 1. Start Windows 2000 or XP.

2. Put the NP-Designer CD-ROM in the CD-ROM drive.
The setup program starts automatically.
Double-click Setup.exe to start the setup program in this condition:

• The setup program does not start automatically

3. Select a setup language.

4. Click OK to show the Select Installation Folder Dialog Box.

5. Click Next> Button to select the default directory C: \Program Files\
OMRON\NP-Designer. 
Click Browse Button to select a directory. 
You will see a list of available directories. 
Select a directory for the NP-Designer, and click OK Button. 
Click Next> Button for the subsequent step.
The Select Components Dialog Box shows. 

6. Click Install Button.

7. Click Close Button to complete the setup. (If a dialog box that relates to a
logo testing shows, press Continue Anyway Button.)

8. The Software Installation Dialog Box will be displayed. Click the Continue
Button. 

5-2-2 Uninstalling
To uninstall the NP-Designer, select [Start]−[Program]−[OMRON]−[NP-
Designer]−[Uninstall].
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5-3 Starting/Exiting NP-Designer

5-3-1 Starting 
Click the Windows Start Button.

Select All Programs − OMRON − NP−Designer. 

• The file that you used last time will open automatically if you select Auto
Open for Next Execute Application in the Option Dialog Box.

• You will see this window when

• You do not select Auto Open for Next Execute Application in the
Option Dialog Box or,

• You start the NP-Designer for the first time.

5-3-2 Exiting 
Use one of these operations to exit the NP-Designer.

• Select Exit Button from the File Menu.

• Click Close Button at the top right corner of the main window.

• Double-click the NP-Designer icon at the top left corner of the main win-
dow.

• Click the NP-Designer icon at the top left corner of the main window, and
select Close Button from the control menu box.

• Use the keyboard shortcut Alt + F4 Keys.

If you did not save the project data that is open, you will see a confirmation
message.
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5-4 Installing USB Drivers for NP-series PTs
Install the NP-series USB driver in the personal computer. After installation,
data can be transferred between the personal computer and NP-series PT via
USB.

Operation Procedure

1,2,3... 1. Connect the personal computer to the NP-series PT USB slave connector
using the USB cable. The following Found New Hardware Wizard will be
displayed. Select Install the software automatically (Recommended).
Click the Next Button.

2. The dialog box shown below will be displayed. Click the Continue Anyway
Button.
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3. When installation is completed, the following dialog box will be displayed.
Click the Finish Button.

When the USB Drivers Cannot Be Installed by Following the Above Procedure

1,2,3... 1. Connect the personal computer to the NP-series PT USB slave connector
using the USB cable. The following Found New Hardware Wizard will be
displayed. Select Install from a list or specific location (Advanced).
Click the Next Button.

2. The dialog box shown below will be displayed. Confirm that Search for the
best driver in these locations is selected. Select the Include this loca-
tion in the search option, click the Browse Button and specify the follow-
ing folder:

C:\Program Files\OMRON\NP-Designer\ScrEditApp

Click the Next Button.



77

Installing USB Drivers for NP-series PTs Section 5-4

3. The dialog box shown below will be displayed. Click the Continue Anyway
Button.

4. When installation is completed, the following dialog box will be displayed.
Click the Finish Button.
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SECTION 6
NP-Designer Functions

This section describes the action to take when NT30/30C errors occur, and how to carry out maintenance and
inspections to prevent the occurrence of errors.

6-1 User Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80

6-2 Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82

6-2-1 File Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
6-2-2 Edit Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87
6-2-3 View Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
6-2-4 PT Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96
6-2-5 Objects Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
6-2-6 Screen Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
6-2-7 Tools Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125
6-2-8 Window Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127
6-2-9 Help Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

6-3 Toolbars  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129

6-4 Object Functions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134

6-4-1 Selecting Object . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134
6-4-2 Common Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135
6-4-3 Button Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137
6-4-4 Meter (1 to 3) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145
6-4-5 Meter (4 to 7) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 147
6-4-6 Level Meter  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148
6-4-7 Pipe. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
6-4-8 Lamp  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154
6-4-9 Data Display Object . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 157
6-4-10 Draw Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 159
6-4-11 Input Objects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 165
6-4-12 Line Graph Objects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 167
6-4-13 Data Log Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
6-4-14 Alarm Objects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 176
6-4-15 Fixed Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 179

6-5 Macro Function  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 184

6-5-1 Macro Types. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 184
6-5-2 Editing Macro  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185
6-5-3 Macro Operation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189
6-5-4 Error Messages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212

6-6 Control Block and Status Block . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215

6-6-1 Control Block. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215
6-6-2 Status Block . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 219
6-6-3 Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 223

6-7 Internal Memory. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 224
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6-1 User Interface

Basic Screen

Property

Property List The Property List sets the properties for each object. You can also refer to 6-4
Object Functions.

Menu bar 

Tool bar 
Property 

Workspace 

Output Window 

Status bar 

  

All objects on an 
editing screen 

Object state selection 
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Screen editing preview

Output Window The output window shows all user actions. If you use the validation function,
this window also shows a message for each error. Click an error message to
show the window that contains the error object.

Status Bar The status bar shows editing status.

 

 

 

 

 Status Selected download method Current mouse position PT model Caps Lock 

Num Lock  Scroll Lock

[Mouse position] @ position of selected object from upper left of window

Width and height of the selected object
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6-2 Menus
The NP-Designer has menus. You can use these menus to set the objects,
pictures, graphs, macro programs, data blocks and create screen data to
show them on NP-series PTs. This section tells you about the pull-down menu
options.

6-2-1 File Menu

■ New

This command creates a new project.

To create a new project, 

• select the File Menu − New,

• click the   icon in the toolbar or

• use the keyboard shortcut Ctrl + N.

1. If no project is open, you will see this dialog box.

Reference The NP-Designer creates sample screen data when you select EJ1 from the
Protocol option.
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2. If other project files are open, you will see this dialog box. 

• Click the Yes Button to save the file. 

• Click the No Button to close and not save the file. 

• Click the Cancel Button to close the dialog box. 

If you click the Yes or No Button, you will see the New Project Dialog Box
again.

3. Input each item in the New Project Dialog Box. Then click the OK Button.

■ Open

This command opens a project file.

To open a project, 

• select the File Menu − Open,

• click the  icon in the toolbar or,

• use the keyboard shortcut Ctrl + O.

1. If there are other project files and you did not save them, you will see a di-
alog box to save the files. 

Click the Yes or No Button. 

2. You will see the Open dialog box. Select an npp file from this dialog box,
and click the Open Button.

■ Close

This command closes a project file.

To close a project, select the File Menu − Close.

■ Save

This command saves a project file.
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To save a project, 

• select the File Menu − Save,

• click the   icon in the toolbar or 

• use the keyboard shortcut Ctrl + S.

If the project is a new file, you will see the Save As Dialog Box. If the project is
not a new file, the saving operation starts immediately.

■ Save As

This command saves a file with a new file name.

1,2,3... 1. Select the File Menu − Save As. You will see Save As Dialog Box.

2. Input a project name with a file extension of npp. 

3. Click the Save Button. 

The NP-Designer shows this dialog automatically if you save a project file for
the first time when you use Save As or Save command. 

 

■ Transfer System&Screen [To PT via USB Flash Memory]

This function transfers screen data to a PT via USB flash memory.
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1,2,3... 1. Select File Menu − Transfer System&Screen [To PT via USB Flash
Memory]. You will see the Browse for Folder Dialog Box.

2. Specify the destination to copy the screen to a USB flash memory.

You can insert this USB flash memory into an NP-series PT to transfer the
screen data to the NP-series PT.

For details, refer to 3-9 Using USB Flash Memory.

■ Open USB Flash Memory Data

This command opens USB flash memory data. 

To open USB flash memory data, 

• select the File Menu − Open USB Flash Memory Data or

• use the keyboard shortcut Ctrl + I.

1,2,3... 1. The users can move the screen data saved in the flash memory into USB
flash memory through folder manager. 

2. If you use the Open USB Flash Memory Data function, you will see the
Browse For Folder Dialog Box. 

3. You can open the screen data, and edit the data.

■ Data Security

This command enables and disables the data security function. 

To enable or disable the data security function, select the File Menu − Data
Security.

When the data security function is enabled, you will see the  symbol adja-
cent to the [Data Security] command and a dialog box. This dialog box tells
that you must use a password to open the npp file. 

To set the password, select PT Menu and set it in the PT Setting Dialog Box.
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■ Print 

This command prints screen data.

To print screen data, 

• select the File Menu − Print, 

• click the  icon in the toolbar or

• use the keyboard shortcut Ctrl + P.

■ Preview

This command shows a preview of the printed image.

To see a preview of the screen, select the File Menu − Print Preview.

■ Print Setup

This command sets the properties, print range and the number of copies. 

To set print settings, select the File Menu − Print Setup.

■ Last Used Files 

The File menu shows a list of the last four used files. 

To open these files, select a file name from the File Menu.
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■ Exit

This command exits the NP-Designer.

To exit a project file, select the File Menu − Exit.

6-2-2 Edit Menu

■ Undo 

This command undoes the last action shown in the output window log.
Operations on properties that are not shown in the output window log are not
undone. To undo the operation, 

• select the Edit Menu − Undo,

• click the  icon in the toolbar or

• use the keyboard shortcut Ctrl + Z.

■ Redo 

This command redoes the undo action. The output window shows all actions.
To redo the operation, 

• select the Edit Menu − Redo,

• click the  icon in the toolbar or

• use the keyboard shortcut Ctrl + Y.

■ Cut

This command deletes the selected object, and save it in clipboard to paste to
other position. 
To cut an object, 

• select the Edit Menu − Cut,

• click the  icon in the toolbar or

• use the keyboard shortcut Ctrl + X.

■ Copy

This command copies the selected object to the clipboard.
To copy an object, 

• select the Edit Menu − Copy,
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• click the  icon in the toolbar or

• use the keyboard shortcut Ctrl + C.

■ Paste

This command pastes an object in the clipboard.
To paste an object, 

• select the Edit Menu − Paste,

• click the  icon in the toolbar or

• use the keyboard shortcut Ctrl + V.

■ Delete

This command deletes the selected object.
To delete an object, 

• select the Edit Menu − Delete or

• use the keyboard shortcut Del.

■ Select All

This command selects all objects. When you select all objects, the NP-Design-
er uses the base object to align or resize. The base object has blue marks. 
To delete all objects, 

• select the Edit Menu − Select All or

• use the keyboard shortcut Ctrl + A.

■ Find

This command uses conditions to find labels or addresses. 
To show the Find Dialog Box, 

• select the Edit Menu − Find or

• use the keyboard shortcut Ctrl + F.
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■ Replace

This command replaces labels, read addresses and write addresses in the
current screen or all screens. The replacement data type can be Bit, Word or
Double Word. You can change the data type only for read addresses and write
addresses. 

To show the Replace Dialog Box, 

• select the File Menu − Replace or

• use the keyboard shortcut Ctrl + H.

Find Dialog Box

Find What Enter the label or address that you look for.

Options Current Screen Examines the current screen only and finds the label 
or address that you look for. 

All Screen Examines all screens and finds the label or address 
that you look for. 

Type Label Finds the label that you enter.

Read Address Finds the read address that you enter.

Write Address Finds the write address that you enter.

All Address Finds all read addresses and write addresses that 
you enter.

Match whole 
word only

Finds only the labels or addresses that you entered. If you do not 
select the [Match whole word only] option, it finds all contents that 
include the labels or addresses that you entered. 

Support 
Multi-Lan-
guage Find-
ing

Finds all multi-language contents that include the labels or addresses 
you entered. You can use the [Support Multi-Language Finding] option 
when you find labels.

Replace Dialog Box

Find What Enter a label or address that you look for.

Replace 
With

Enter a label or address that you replace with.
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■ Replace Host Unit No.

■ Group

This command groups the selected objects. When you group two or more
objects, they will become one unit. Thus, when you move or change the
objects, you will move or change them together. You cannot make grouped
objects and other object a group.

To group objects, 

• select the File Menu − Group 

Options Current Screen Examines the current screen only to find the label or 
address that you look for and replaces it. 

All Screen Examines all screens to find the label or address 
that you look for and replaces it.

Type Label Finds and replaces the label that you entered.

Read Address Finds and replaces the read address that you 
entered.

Write Address Finds and replaces the write address that you 
entered.

Data Type Bit Selects Bit, Word or Double Word.

WORD

DWORD

Replace Replaces the label or address that you entered and finds the subse-
quent one. For example, to replace the write address $157 with $158, 
enter $157 in Find What field and $158 in Replace With field. Click 
Replace Button. NP-Designer will find the address. Click Yes Button 
to replace the address. 

Replace All Replaces the label or address automatically with all contents that you 
entered.

Replace Dialog Box

Replace Host Unit No. Dialog Box

Find Unit No Sets the unit number to be replaced.

Replace Unit 
No

Sets the host number for after replacement.

Host Name Specifies the host name. 

Option Selects the items for replacement. Hosts of the checked items will be 
replaced. 
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• click the  icon in the toolbar, or

• use the keyboard shortcut Ctrl + G. 

■ Ungroup

This command ungroups selected objects. 

To group objects, 

• select the File Menu − Ungroup

• click the  icon in the toolbar, or

• use the keyboard shortcut Ctrl + U. 

■ Edit Nodes

This command edits, adds or removes the nodes of Polygon objects to
change their shapes. 

To show the nodes of fitted objects, select the Edit Menu − Edit Nodes.

To edit, add or removes nodes, follow the procedure below.

1. Editing Nodes

1,2,3... 1. Move the cursor above the node. When the cursor changes to, drag the
cursor to the new position for the node.

2. Click the right mouse button to close the edit mode for nodes.

2. Adding Nodes

1,2,3... 1. Click the Ctrl Key and move the cursor above the border of the object.
When the shape changes to, left-click the position on the border where you
add the node.

2. Click the right mouse button to close the edit mode for nodes.

3. Removing Nodes

1,2,3... 1. Click the Ctrl Key and move the cursor above the node you delete. When

the shape changes to , left- click the node.

2. Click the right mouse button to close the edit mode for nodes.

■ Order

This command changes the stacking order of the selected object. 

To change the order, 

• select each command from the Edit Menu − Order or

• click the order icons in the toolbar

The Order icons include:

Bring to Top Moves the selected object to the front. 

Send to Bottom Moves the selected object to the behind.

Bring Forward Moves the selected object one step near the front.

Send Backward Moves the selected object one step to the behind. 
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■ Align

This command aligns the objects. You can use this command only when you
select more than one object. The NP-Designer refers to the base object to
align the objects.

To align the objects, 

• select each command from the Edit Menu − Align or

• click the align icons in the toolbar.

The Align icons include:

■ Make Same Size

This command makes the object to be the same size. The users must select
one object first as reference object, and then select other objects.

To use this command,

• select each command from the Edit Menu − Make Same Size or

• click the make same size icons in the toolbar.

■ Text Process

Text Alignment

To align the text, 

• select each command from the Edit − Text Process or

• click the text process icons in the toolbar.

The text alignment icons include:

Align Left Aligns the selected objects to the left side of the base 
object.

Align Right Aligns the selected objects to the right side of the base 
object.

Align Top Aligns the selected objects to the top of the base object.

Align Bottom Aligns the selected objects to the bottom of the base 
object.

Align Vert. Cen-
ter

Aligns the objects to the vertical center of the selected 
objects.

Align Horiz. 
Center

Aligns the objects to the horizontal center of the selected 
objects.

Across Space 
Evenly

Horizontally aligns all objects to the equal distances from 
all objects.

Down Space 
Evenly

Vertically aligns all objects to the equal distances from all 
objects.

Make Same 
Width

Makes the same width.

Make Same 
Height

Makes the same height.

Both Makes the same width and height.

Text Align Left Aligns the selected text to the left end of the object.

Text Align Horiz. 
Center

Aligns the horizontal center of the object.
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Import Text This command imports the text from Text Library.

To show the Text Library Dialog Box, select the PT Menu − Text Library.

If you select the Use Text Library Edit Font option in the Import Text Dialog
Box, the imported text shows in the font of Text Library. For details on the Text
Library settings, refer to Text Library of 6-2-4 PT Menu.

■ Repeat

This command multiplies the selected objects horizontally or vertically.
To show the Repeat Dialog Box.

• select the Edit Menu − Repeat, or

Text Align Right Aligns the selected text to the right end of the object.

Text Align Top Aligns the selected text to the top of the object.

Text Align Vert. 
Center

Aligns the vertical center of the object.

Text Align Bot-
tom

Aligns the selected text to the bottom of the object.

Add Underline Adds the line below the selected text.
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• use the keyboard shortcut Ctrl + W. 

Repeat Example: 
Step 1

Repeat Dialog Box

Number of Copies 
(Columns/Rows)

Sets the horizontal and vertical quantities. The quantities 
include the source object.

Space 
(Horizontal/Vertical)

Sets the horizontal and vertical spacing between objects in 
dot unit.

X-Direction/Y-Direction Selects one of check boxes to increase or decrease the 
address.

Offset Address Sets the offset value for addresses added when objects are 
repeated to between −10,000 and 10,000.
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Step 2

6-2-3 View Menu

■ Toolbar, Property and Output Window

These commands show or hide the Toolbar, Property or Output Window. To
show or hide, select each command.

■ Grid

This function aligns the objects easily and accurately. You can set the distance
(spacing) between the grid dots freely. To use this function, select View Menu
− Grid.

Grid Settings Dialog Box

Show Grid Shows the grid dots on the screen.

Snap to Grid Makes objects snap to the grid when you move 
them.

Spacing Width Sets the width to between 4 and 50.

Height Sets the height to between 4 and 50.
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Example of Grid Display:

6-2-4 PT Menu

■ Transfer

Transfer [From PT]

This function transfers screen data from a PT to a computer.

1,2,3... 1. Select the PT Menu − Transfer [From PT] or use the keyboard shortcut Ctrl
+ Shift + B. You will see the password dialog box.

2. Input your password (The highest level password stored in the NP-Design-
er). You will see the Save As Dialog Box.

3. Input the project file name. Click the OK Button. The transfer will start.

When the progress bar shows 100%, the transfer is completed. Then the
uploaded screen data will be open. The progress bar shows the progress dur-
ing the transfer. You can click the Stop Button to stop the transfer.

Note When you transfer the screen data, you cannot upload the settings made with
the PT system menu.
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Transfer System [To PT]

This function transfers the system or adds functions to a PT

To transfer the system to the PT, select the PT Menu − Transfer − Transfer
System [To PT].

Transfer [To PT]

This function transfers the screen data to the PT.  

To transfer the screen data to the PT,

• select the PT Menu − Transfer [To PT],

• click the  icon in the toolbar or

• use the keyboard shortcut Ctrl + B.

The progress bar shows the progress of transfer.

If you cannot connect the computer to the PT, you will see these error mes-
sages.

The download interface can be USB or RS-232 when you use a cable to
transfer the screen data. 

To set the download interface, 

1,2,3... 1. Select the Tools Menu − Option 

2. Set the interface in the Transfer Setting Field of the Option Dialog Box.

Transfer Screen [To PT]

This function transfers only screens to a PT. 

To use this function,

• select the PT Menu − Transfer Screen [To PT],

• click the  icon in the toolbar or 

• use the keyboard shortcut Ctrl + F9.

■ Transfer System [To PT via USB Flash Memory]

This function transfers the systems from a computer to a PT via USB flash
memory. NP-Designer shows this menu only when a project is closed.
To use this function, select the PT Menu - Transfer System [To PT via USB
Flash Memory] when a project is closed.

Always ensure that communication settings are correct before transfer.
If communication settings are incorrect, the touch reaction may be 
slower.

Precautions 
for Correct Use
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■ Data Block

Data blocks (recipes) make it possible to read/write values to memory areas
of PLCs. To use the data block function, you must make settings with the Data
Block Setting Dialog Box and control from the control block.

To show the Data Block Setting Dialog Box, select the PT Menu − Data
Block.

Data Block Setting Dialog Box

Enable 
Data Block 

This option enables or disables the data block function.
To disable the data block function, deselect this option.

Address This option can input the starting address. Click the  Button to show 
the address input dialog box.

No. of 
Fields

This option can set the data block size to 1 word or more. 

No. of 
Groups

This option can set the number of groups to 1 or more.

Input You can edit the data block data after you set the No. of Fields and No. 
of groups of the data block. There is a limit in the memory size for data 
block. If you select the SRAM in the Hold Data Place Field with the 
Data Block Setting Dialog Box, the memory size for data block is 
64K.The total data block size must be less than 64K. (No. of Fields x 
No. of groups must be less than 64 X 1024) 
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■ Alarm Setting

The alarm function shows a message when the registered address fits the
specified conditions. To use this alarm function, you must make settings with
the Alarm Setting Dialog Box and an alarm object. For details on alarm
object settings, refer to 6-4 Object Functions.

Input

Open You can open the data block data. The data block data you opened do 
not contain the starting address. 

Save You can save the edited data block data to a file. When the NP-
Designer saves the data block file, it will not save the starting address. 

Reset You can delete all related data block setting and input data block data.

Clear You can clear all input data block to 0.

Print You can print all data block data on the current screen.

OK You can save the set data block data.

Cancel You can discard the changes and close the Data Block Setup Dialog 
box. 

Data Block Setting Dialog Box
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To show the Alarm Setting Dialog Box, select the PT Menu − Alarm Setting.

Alarm Setting Dialog Box

Alarm Set-
ting

Address of 
Alarm Block

This option can set the alarm starting address. You can 
set the address to a minimum of 512 alarms, 32 Words.

Scan Time (s) This option can set the time interval to monitor. The unit 
is second.

Number of 
Records in 
History Buffer

This option can set the number of occurred alarms to 
record.

When the number of records becomes more than the 
set value, it will delete the first record and insert the new 
record into the last address. 

Non-volatile You can select this option to save data in the SRAM 
when the power supply is cut. The SRAM can save a 
maximum of 8K bytes of alarm data. (The power of 
SRAM is battery when the power supply is cut.)

Property

The Alarm Setting Dialog Box also supports the multi-
language function. There are three languages in the 
above example. Click each tab to edit the message.

Message This option can input messages that alarm 
objects show when alarms occur.

Color This option can set colors that alarm 
objects show when alarms occur.

Detection 
Type

This option can set the alarm detection 
condition. You can set it to ON or OFF.

Screen This option can set the screens that the PT 
shows when alarms occur.
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Note (1) Exporting and importing Alarm Describe Files can be used to apply alarm
settings from other projects.

(2) Do not edit Alarm Describe Files with a text editor. Doing so may make it
impossible to import them.

■ Data Log Setting

You must use the Data Log Setting together with sampling objects. 

To show the Data Log Setting Dialog Box, select the PT Menu − Data Log
Setting. 

For details on objects, refer to 6-4 Object Functions.

Banner Enable This option enables or disables the Message Banner.

Position This option can set the display position of the message 
banner. The position can be Top or Bottom.

Direction Left Message will move from right to left.

Right Message will move from left to right.

Up Message will move from bottom to top.

Down Message will move from top to bottom.

Movement 
Distance

This option can set the movement distance for the mes-
sage banner. The range is between 1 and 50 dots. 

Interval (ms) This option can set the interval time for the message 
banner. The range is between 50 and 3000 ms.

Background 
Color

This option can set the background color of the mes-
sage banner.

Delete You can delete the message.
Select the number to delete.

Open The existing alarm setting information will be 
cleared, and data in the Alarm Describe File 
format will be imported.

Save The setting data and alarm message in the Alarm 
Setting Dialog Box will be converted to a file in 
the Alarm Describe File format and exported.

Close You can exit the Alarm Setting Dialog Box. 

Alarm Setting Dialog Box

Data Log Setting Dialog Box
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Append You can input necessary items and add a maximum of 12 data logs. 

Read 
Address

This option can set the starting address that samples the 
data log data.

Data Length This option can set the word length for sampling. The 
range is between 1 and 13 continuous words. You can 
sample a maximum of 13 continuous words.
Example

When the Data Length is 6, the PT samples continuous 6 
words ($M100, $M101,.....,$M105). When the Log Points 
is 100, the PT samples 6 words x 100 = 600 each time.

Sampling 
Cycle

This option can set the sampling cycle time to read the 
address (The length of time to read the address one 
time). If you set the Trigger option to the Control Flag 
(OFF→ON), the Sampling Cycle option is disabled. The 
range of the sampling cycle time is between 0 and 
86400000 ms.

Log Points This option can set the log points. 

Trigger You can select one of these logging timing.
• On Sampling Cycle
The PT logs on the sampling cycle timing set in the Sam-
pling Cycle Field.
• Control Flag (OFF→ON)
The PT logs when the control flag turns from OFF to ON.

Stamp Time 
and Date

You can select this option to record the time and date 
during sampling operation.

Auto Stop You can set whether to stop logging or not when the PT 
has the number of logs you set.
• Select this option to stop logging the data after the 

number of logs becomes the set value of Log Points 
option. 

• Deselect this option to delete the final log and insert the 
new record into the last address when the number of 
data logged is larger than the set value of the Log 
Points option.

Non-Volatile You can select this option to save data in SRAM when 
the power supply is cut. The SRAM can save a maximum 
of 240K bytes of sampling data. (The power of SRAM is 
battery when the power supply is cut.)

OK You can save the data and exit the Buffer Properties 
Dialog Box.

Cancel You can discard the changes and exits the Buffer Prop-
erties Dialog Box.

Data Log Setting Dialog Box
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■ Symbol Table

This function names addresses. For example, you can name [SERI-
ALA:DM00100] [Symbol_A].

To show the Symbol Table Dialog Box, select the PT Menu − Symbol Table. 

Reference

• If you do not input a name or address and click the Close Button, you will
see a warning message.

■ PT Setting

PT Setting Dialog Box contains Standard, Comm., Default and Multi-lan-
guage Tab Pages. This section describes these tabs. 

Delete You can delete data logs.

Modify You can change data logs.

Data Log Setting Dialog Box

Symbol Table Dialog Box

Open You can open a tag file.

Save You can save the settings made with the Symbol Table Dialog Box 
as a tag file. 

Add You can add a symbol. 
1. Select the Internal Memory or SELEALA. (Host names are 

shown on the third or more tabs.)
2. Click the Add Button.

Do not add a symbol with only a number or with the same address.

Delete You can delete the selected row. 
1. Use the mouse to select a row to delete.
2. Click the Delete Button. The selected row is deleted.

Close You can discard the changes and exit the dialog box.
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To show the PT Setting Dialog Box, select the PT Menu − PT Setting. 

Standard Tab in PT Setting Dialog Box

Project Name This option can set the project name. 

Model This option can select a PT model you use. 

Hold Data Place This option can save the backup memory data in SRAM or 
USB flash memory. 

Startup Delay Time This option can set the delay time for the startup of the PT. 
The range is between 0 and 255 seconds. 

Project Periodic 
Macro Delay Time

This option can set the interval time to use the project periodic 
macro. The range is between 100 and 65535ms. 

Password This option can set a highest level password. You can set this 
password with one-bye numerics. You use the password when 
you transfer a project file and open a file.

Starting Level This option can set the starting level. There are 8 levels. 
The highest level is 7 and the lowest level is 0.

Prompt For Level 
Insufficient

You can select this option to show a mark on objects when the 
user level is lower than the levels of objects.

Address 
(Control Block)

This option can set the starting address of system control 
block.
Refer to 6-6 Control Block and Status Block.

Size This option can set the length of control block. When the con-
trol block size is 0, the control block function is disabled.

Clear flag after done You can select this option to clear the address in the control 
block to 0 when an operation was completed in the control 
block.

Address 
(Status Block)

This option can set the starting address of system status 
block.

Refer to 6-6 Control Block and Status Block.
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Optimize Type Optimize Dynamic This option can optimize all objects that 
read addresses on the screen when the 
PT switches screens.

Note When you select this function, all 
objects that read addresses on 
the screen will show incorrect val-
ues for a short time. All objects 
show correct values after optimi-
zation is completed.

Optimize Static This option can optimize all objects that 
read addresses on the screen during 
validation operation. 

System Menu Lan-
guage

This option can set a language for the System Menu.

Communication Tab in PT Setting Dialog Box

Add/Delete Con-
troller Connection

Add You can give a host name and sets a protocol. 
Some hosts cannot simultaneously communicate 
via 2 ports. 
For details, refer to 1-1 Supported Hosts in the 
Host Connection Manual.

Delete You can delete a host. You cannot delete the host 
No.1.

Modify You can change a host name and protocol.

Protocol Settings-
1

PT Unit No. This option can set the PT unit number. The 
range is between 0 and 255. 

Host Unit No. This option can set the host unit number. If you do 
not do this setting, the host unit number will be the 
default setting. The range is between 0 and 255.

Interface This option can set the communication interface.

Data Bits You can select 7 Bits or 8 Bits. 

Stop Bits You can select 1 Bit or 2 Bits.

Baud rate You can select 4800, 9600, 19200, 38400, 57600 
or 115200. It is possible to enter the value directly. 
Maximum setting value cannot be more than 
150000.

Parity You can select None, Odd or Even.

Standard Tab in PT Setting Dialog Box
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Protocol Settings-
2

COM Port This option can set the COM port that communi-
cates with PT (COM1 or COM2). 

Password A password is necessary for some PLCs before 
communication. You can set a password with one-
byte numerics.

Comm. Delay This option can set the delay time before the host 
starts. The range is between 0 and 255 ms.

Timeout This option can set the communication timeout 
time when the PT communicates with the host. 
The range is between 20 and 65535ms. 

Retry Count This option can set the retry counts. You will see a 
communication error dialog box if the number of 
times that the PT sends a command becomes the 
same as the retry counts. The range is between 0 
and 255 times.

Optimize You can select this option to optimize all read addresses of all 
related objects.

Size Limit You can select this option to keep the screen update speed when 
the PT reads continuous addresses. This function is available 
only when you select Optimize Type − Optimize Static in the 
Standard Tab. 

Communication 
Interrupt N times 
then cancel

You can select this option to stop the communication with the 
host after the communication interruption times becomes the 
same as the setting time. Thus, it is possible to hide the commu-
nication error dialog box on the PT screen when the communica-
tion error occurs after the PT retries. The range is between 1 and 
255 times.

Default Tab in PT Setting Dialog Box

Communication Tab in PT Setting Dialog Box
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System Default 
Value

Start up Screen This option can set the first display screen 
when PT starts.

Default Data For-
mat

This option can set the default data format of 
objects.

Default Screen 
Background

This option can set the default screen back-
ground color of a new screen. 

System Error Dis-
play Time

This option can set the display time of the sys-
tem error message dialog box. The range is 
between 0 and 5 seconds. 

Note If you set 0, the PT does not show the 
system error message dialog box.

Object Default 
Value

Object Font Name This option can set the default object font.

Object Font Size This option can set the default object font size.

Object Font Color This option can set the default object font 
color. 

Flicker Time This option can set the default object flicker 
(blink) time. 

Multi-Language Tab in PT Setting Dialog Box

Default Tab in PT Setting Dialog Box
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Saver 
Screen 

For details on how to set the saver screens, refer to 6-2-6 Screen 
Menu.

Enable Saver 
Screen

• You can select this option to use Edit Saver 
Screen function in Screen Maintenance option. 

• You can deselect this option to not start the 
screen set with Edit Saver Screen function. 
After the set time elapsed, the PT does not show 
the saver screen and stops the backlight.

Read Host 
Address

• You can select this option to enable the screen 
saver. When the user touches the PT screen, the 
screen saver function is disabled. 
• When the setting value is 0:

The PT disables the screen saver function. 
• When the setting value is a non-zero value:

The PT enables the screen saver function.
• You can deselect this option to start up the 

screen saver automatically when the Screen 
Saver Time set in the PT elapsed. When the 
user touches the PT screen, the screen saver 
function is disabled. 

Interval Time At 
Two Saver Screen

This option can set the interval time between two 
screen savers. The range is between 1 and 255 
seconds. 

Ending of Saver 
Screen Mode

Return Original: 
The screen goes back to the original screen when 
the screen saver starts.
Indicate Screen: 
You can specify the screen to show after the 
screen saver ends. 

Multi-Language Tab in PT Setting Dialog Box
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■ System Macro

There are Startup Macro, Project Resident Macro, Project Periodic Macro and
Sub-macro. 

For details, refer to 6-5 Macro Function.

■ Library

This function imports and saves many pictures to the Library.

Screen 
Data Multi-
Language

New This option can add a maximum of 8 languages.

• Enter the language name and value. The system 
will refer to the value. The range of the setting 
value is between 0 and 255. 

• To select the flag color on the language name 
tab, click the  Button.

Enable/Disable You can set which languages are enabled or dis-
abled when you download data to the PT. 

Remove You can remove a language. There must be a min-
imum of one language for a project.

Modify You can change the language name and value.

Default Sets the default language when using more than 
one language.

Enable Edit Multi-
Language User 
Interface

You can select this option to enable the multi-lan-
guage user interface and view the multi-language 
display in the property list.

See below example.

Multi-Language Tab in PT Setting Dialog Box
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To show the Library Dialog Box, select the PT Menu − Library.

Library Dialog Box

Click the Library option to browse all pictures saved in the Library. When one picture 
is selected, the preview window shows the picture. To show the selected picture in a 
real size, double left click on the picture.

 New Library
This icon creates a new library. 
If you click this icon, the New Picture Library Dialog 
Box shows.

 Open Library
This icon opens a library file (*.pib file).

 Delete Picture Library
This icon uninstalls the selected library. The library will 
goes to the Recycle Bin. 

 Update Picture Library
This icon updates the picture library.
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■ Text Library

This function enables you to input frequently used text into the Text Library. It
is possible to select the text from the Text Library and enter them on the
object.

 Import Picture
This icon imports pictures into the specified library. 
The formats of the pictures can be BMP, JPG, GIF 
(static) and ICO pictures.
To import pictures,
1. Click this icon. You will see the Select Picture Dia-

log Box. 
2. Select pictures.

 Export
This icon exports pictures in BMP format from the 
library. 

 Delete Picture
This icon deletes pictures in the library. 

Shortcut Menu To show the shortcut menu, right-click on the picture. 
The shortcut menu shows a list of commands related 
to library.

Library Dialog Box



112

Menus Section 6-2

To use the Text Library, select the PT Menu − Text Library.

Reference Do not use a text editor to edit txt files. If you do this, you cannot possibly open
the txt files.

6-2-5  Objects Menu

The NP-Designer has 12 types of objects and has many functions. The 12
types include button, analog meter, level meter, pipe, lamp, data display,
graph display, input, curve, data log, alarm and fixed objects. For details on
object properties, refer to 6-4 Object Functions.

Text Library Dialog Box

Add You can add the text into the Text Library. You can input the 
text in different language, set each font and save them in the 
Text Library.

Delete You can delete the input text in the Text Library. 

Open You can open and import the text or terms into the Text Library.

Save You can save and export the text file.

Close You can exit the Text Library Dialog Box.
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■ Creating Object

1,2,3... 1. Right-click the mouse in the workspace to select an object.

2. Hold down the left mouse button and drag the mouse cursor.

3. Release the left mouse button to create an object.

4. Set the object property.

■ Moving Object

1,2,3... 1. Move the mouse cursor above the object. The mouse cursor changes into

 icon.
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2. Hold down the left mouse button and move the mouse to move the object.

3. When the object is in the correct position, release the left mouse button.

■ Changing Object Width

1,2,3... 1. Move the mouse cursor to the edge of the object. The cursor will change
the  icon.

2. Hold down the left mouse button and move the mouse to change the object
width.

3. When the object width is correct, release the left mouse button.

■ Changing Object Height

1,2,3... 1. Move the mouse cursor to the edge of the object. The cursor will change

the  icon.
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2. Hold down the left mouse button and move the mouse to change the object
height.

3. When the object height is correct, release the left mouse button.

■ Changing Object Width and Height at the Same Time

1,2,3... 1. 1.Move the mouse cursor to the edge of the object. The cursor will change

the  icon.

2. Hold down the left mouse button and move the mouse to change the object
height and width.

3. When the object height and width are correct, release the left mouse but-
ton.

■ Inputting Characters

You can use one of these procedures to input characters.

• Move the mouse cursor in the Label field of the Property to make the cur-

sor  shape.

• Select the object and click the space key.
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■ Right-clicking the Mouse

When you right-click the mouse, you will see different menus.

• Right-click in the toolbar

The Toolbars Display Setup Menu shows.

• Right-click on the workspace.

The Object Selection Menu shows.
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• Right-click on the object. 

The Object Editing Menu shows.

6-2-6 Screen Menu

■ New

This function creates a new screen. Up to 1,000 screens can be created in
one project. 

To create a new screen,

• select the Screen Menu − New,
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• click the  icon in the toolbar or

• use the keyboard shortcut Ctrl + Shift + N.

You can give a name and ID for the new screen.

■ Open

This command opens a screen. 

To open a screen,

• select the Screen Menu − New,

• click the  icon in the toolbar or

• use the keyboard shortcut Ctrl + Shift + O.

When you select this command, you can preview each screen in Open
Screen Dialog Box.

■ Maintenance

This function does screen maintenance. You can copy, paste, cut screens and
specify saver screens. To set the saver screen settings, select the PT Menu −
PT Setting − Multi-Language Tab Page. To select saver screens, do these
procedures.
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Selecting Saver Screens

1,2,3... 1. Select the Maintenance from the Screen Menu to open the Screen main-
tenance window.

2. Right-click the mouse to select the Edit Saver Screen function.

3. Drag the mouse to specify the saver screen.
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Deleting Saver 
Screens

 Select a saver screen that you want to delete. Then press the [Delete] key.

■ Cut

This command cuts the full screen to paste it to clipboard.

To cut the full screen, select the Screen Menu − Cut. 

Reference It is not possible to undo the cut operation. The cut command deletes the
screen and its operation is the same as the delete command. But you can
paste the screen to have the same screen. After you select the Cut command,
you will see this dialog. 

■ Copy

This command copies the full screen. 

To copy the full screen, select the Screen Menu − Copy.

■ Paste

This command pastes a screen. All screen setting will be the same as source
screen. The NP-Designer gives a screen name automatically.

To paste a screen, select the Screen Menu − Paste

■ Delete

This command deletes the current screen and objects. 

To delete, select the Screen Menu − Delete.

Reference It is not possible to undo the delete operation. After you select the Delete
command, you will see the dialog box below. Make sure that you select a cor-
rect screen before you delete. 

■ Export Image

This command exports a screen to image

To export, 

• select the Screen Menu − Export Image, or

• click the  icon in the toolbar.
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■ Import Image

This command imports an image to be the ground of the editing screen. You
can import BMP, JPG, GIF and ICO.

To import, select the Screen Menu − Import Image.

■ Clear Imported Image

This command deletes an imported image.

To delete, select the Screen Menu − Clear Imported Image. 

■ Start Macro

For details on how to use and edit, refer to 6-5 Macro Function.

■ End Macro

For details on how to use and edit, refer to 6-5 Macro Function.

■ Screen Periodic Macro

For details on how to use and edit, refer to 6-5 Macro Function.

■ Function Switch

This function specifies functions for function switches used on screens of NP-
series PTs.

Setting the Function Switch

1,2,3... 1. If the Function Switch Window is not on the screen, select the Screen
Menu − Function Switch.

2. Press a Function Switch. A menu shows.

3. Click a function.
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Reference

• The System Menu function is set by default. The function switches below
have the System Menu function.

■ Properties

This function sets the properties of the current screen. 

To set properties, 

• select the Screen Menu − Properties. 

Model Function Switch

Three Function Switches Middle

Six Function Switches F6
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• select the Details of the Properties from the List Tab Page of the Prop-
erty.

Screen Properties Dialog Box

Screen No. The range is between 1 and 65535. You cannot use the 
same number two times.
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Pop-up 
Screen

Use as Pop-up 
screen

A Pop-up screen shows on the current screens

The Pop-up screens are not closed even when the user 
switches base screens.

Width This option can set the width of pop-up screen. The unit 
is dot. The minimum value is 32 dots.

Height This option can set the height of pop-up screen. The unit 
is dot. The minimum value is 32 dots.

Pop-up screen 
Position

This option can show the pop-up screen on the center of 
the PT screen or on a position you specify. 
To specify the position, 

• input the coordinate value directly (X and Y axis) or 

• press the mouse button  to drag the pop-up screen.

Use Title Bar You can select this option to show the title bar on the 
pop-up screen. 

Screen Periodic Macro 
Delay

This option can set the time interval to execute the 
Screen Periodic Macro. The range can be between 
100ms and 5s.

Fast Refresh Rate There are three levels, high, medium and low. This func-
tion shows four objects immediately after PT switches 
screens. 

Note Each screen renews only four objects immedi-
ately.
To set which objects to be renewed, select Yes in 
Fast Refresh Field of the property of each object.

Sheet Applied a Sheet You can select this option to use other screen as a 
sheet. The sheet will be background sheet behind all 
objects.

Screen Properties Dialog Box
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6-2-7 Tools Menu

■ Validation

This command validates a project file. 

If the project is a new project, you will see the Save As Dialog Box before val-
idation. If the project is not a new project, this command does a validation
immediately. 

The Output Window shows the validation results. If there is no error, this com-
mand creates a file.

To do the validation, 

• select the Tools Menu − Validation,

• click the  icon in the toolbar or

• use the keyboard shortcut Ctrl + E.

Example: Debugging Validation Errors During Validation Process

1. Create a new project. 
2. Create two editing screens. 
3. Create a button object on each screen. Do not change the object default property.

4. Click the  icon to do validation operation. You will see an error message dialog 
box that shows the number of errors. In the dialog below, there are two errors and 
the output window shows the errors.

5. Click the error message to switch to the error screen automatically.
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■ Test

This function tests if the read/write addresses and macro of editing screen are
correct or not on a created program. It is not necessary to connect the PLC. 

To do the test, 

• click the Tools − Test

• click the  icon in the toolbar or

• use the keyboard shortcut Ctrl + T.

Reference With the Test function, it is not possible to save the date and time settings. 

■ Option

This function sets the environment settings of NP-Designer.

To show the Option Dialog Box, select the Tools Menu − Option.

Option Dialog Box

Output Path This option can set the location where NP-Designer saves the output 
file after validation. Some functions (Test and file transfer) refer to the 
files in this location. 
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6-2-8 Window Menu

This table tells you about the commands in the Window Menu and their func-
tions.

Options Toolbars/Windows This option can show or hide the toolbars or win-
dows.

Language You can select English, Traditional Chinese, 
Simplified Chinese, or Japanese.

Transfer Setting This option can set the communication interface 
(USB 1.1 or PC COM Port) for transfer.

Auto Saving.... 
Time Interval

This option can save the file at the specified time 
interval. The setting range is between 0 and 120 
minutes.

Auto Open for Next 
Execute Applica-
tion

This option can automatically open the file that 
you last used when the NP-Designer starts.

Include Picture 
Data For Uploading

This option can transfer all pictures from the PT 
to the computer when you upload screen data.

Auto Convert Input 
Address To Sym-
bol Name

For example, to replace address “SERI-
ALA:DM00100” with the word “Symbol_A”, you 
must first make this setting in Symbol Table. 
When this option is selected, the NP-Designer 
automatically changes the input address “SERI-
ALA:DM00100” to the word “Symbol_A”.

The font size of 
Display read/write

This option can set the font size of display read 
and write addresses.

Reinstall PT 
USB Drive

You can reinstall the PT USB driver.

Uninstall PT 
USB Drive

You can uninstall the PT USB driver.

OK You can save the changes and exit the Option Dialog Box.

Cancel You can discard the changes and exit the Option Dialog Box.

Option Dialog Box

Menu Function Shortcut keys

Close Window This function hides the current window.

Close All Windows This function hides all windows.

Next Window Moves the focus from the current window 
to the next window.

Shift+PgDn

Previous Window Moves the focus from the current window 
to the previous window.

Shift+PgUp

Cascade This function cascades the screen win-
dows.

Tile Horizontal This function tiles the screen windows hor-
izontally.
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6-2-9 Help Menu

■ About NP-Designer

This command shows the version information of the NP-Designer.
To show the information, 

• select the Help Menu − About NP-Designer or 

• click the  icon in the toolbar.

Tile Vertical This function tiles the screen windows ver-
tically.

Window List This function shows a list of all open 
screens. The front screen has a check 
mark.

Menu Function Shortcut keys
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6-3 Toolbars
This section tells you about toolbars. For details on each function, refer to 6-2
Menus.

■ File Toolbar

■ Edit Toolbar

Icon Function

New

Open

Save

Export

New Screen

Open Screen

Find Content

Print

About

Icon Function

Undo

Redo

Cut

Copy

Paste

Delete
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■ Text Toolbar

■ Bitmap Toolbar

Icon Function

Font size

Font

Aligns left

Center

Aligns right

Aligns text top

Center Vertical

Aligns Bottom

Font Color

Bold

Italic

Underline

Icon Function Description

Select Transparent 
Color

The sucker tool removes the color of the selected 
picture to specify the transparent color of the pic-
ture.

Change Mode for Pro-
cess All State Picture

This icon stretches, resizes or aligns not only the 
current picture with current state but also all pic-
tures with all states.

Picture Stretch All This icon resizes the selected picture to fit it to the 
size of the object.

Picture Stretch Ration 
1: 1

This icon resizes the selected picture to fit it to the 
size of the object in proportion to the initial picture 
size.

Picture Actual This icon resizes the selected picture to the initial 
picture size.

Picture Align Left This icon aligns the selected picture to the left side 
of the object.
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■ Object Toolbar

Picture Align Horizontal 
Center 

This icon horizontally aligns the picture to the cen-
ter of the object. 

Picture Align Right This icon aligns the selected object to the right 
side of the object.

Picture Align Top This icon aligns the selected object to the top of 
the object.

Picture Align Vertical 
Center 

This icon vertically aligns the picture to the center 
of the object.

Picture Align Bottom This icon aligns the selected object to the bottom 
of the object.

Icon Function Description

Icon Function

Button

Analog Meter

Level Meter

Pipe

Lamp

Data Display

Graph Display

Input

Curve

Data Log

Alarm

Fixed Objects
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■ Build Toolbar

■ Layout Toolbar

Icon Function

Current Object State

View State OFF/0

View State ON/1

Display All Read/Write Address

Previous windows

Next windows

Validation

Transfer [To PT]

Transfer Screen [To PT]

Test

Icon Function

Group

Ungroup

To Front

To Bottom

Forward one

Backward one

Align Left

Align Right

Align Top
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For details, refer to 6-2-2 Edit Menu.

■ Zoom Toolbar

Align Bottom

Center Vertically

Center Horizontally

Make same space horizontally

Make same space vertically

Make same width

Make same height

Make same size

Icon Function

Icon Function

Zoom level

Zoom in

Zoom out
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6-4 Object Functions
The NP-Designer has many objects. You can use these objects to create
screens. 

This section tells you how to select an object and the function of each object.

6-4-1 Selecting Object
There are three methods to select objects when you edit the screen. To edit
the screen, do one of these:

• Right-click the mouse in the workspace. You will see a shortcut menu.
Use the mouse to select an object.

• Select one of the commands from the Objects Menu.

• Select one of the objects from the Objects Toolbar.

After you select an object, left-click and drag the mouse cursor on the work-
space to create an object. See the illustration. Up to 1,024 objects can be cre-
ated on one screen.

Note When inputting using overlapped objects, an input will be accepted only by
the top object. Inputs will not be accepted by objects in the back.
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6-4-2 Common Settings
The settings common to all objects show below. 

Note Some objects do not have these functions.

Common Settings Details

Label
Label Size

Font
Label Color

You can set label, label size, font and label color on the object. Click the  button for Font. The 
Font Detail Setting Dialog Box will show as below.

The font option can set the font name, font size and ratio. This can also show the text format in the 
Preview window. If you use multi-language function, the Font Detail Setting Dialog Box shows 
different language tabs. Do the font setting in each language.

Write Address
Read Address

Click the  button for Write Address or Read Address in the Property. The Input Dialog Box is 
shown. Set the write address or read address.

When the Read Address is set to None, the Read Address accesses to the same address as the 
Write Address.

The Host can be Internal Memory or SERIALA. If the PT connects to different connections, the 
available host names will show in the Host drop-down list. After you select the Host and Type and 
input the address number, click Enter key. The object will record the input value.

When you use Internal Memory as host, select the memory area from the Area Field:
$ − Internal Address
$M − Non-volatile Internal Address

*$ − Indirect Address 
RCPNO − Data Block Number Address
RCP − Data Block Address

When the NULL is set in Comm. Tab of PT Setting Dialog box under PT Menu, only Internal Mem-
ory can be set as the host.

Flicker When Yes is selected from Flicker Field, the object will flicker (blink).
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Picture Library Name 
Picture Name

1. Select a picture of the object from the Picture Library Name Field.

2. Click  button for Picture Name to show the Select Picture Dialog Box below.

3. Double-click an image that you use.
To import more than one picture into one object at the same time, press the Shift key and click the 
left mouse button at the same time. The selected pictures will be in each state of the object in 
sequence. If the number of the selected pictures is more than that of the object states, the system 
will import only the pictures of the same number of the states. The remaining pictures will not be 
imported.
Note that NP-Designer does not save the Picture Library Name and Picture Name that you speci-
fied. When the project file is open again, the Picture Library Name will be “_LocalTempxx” and the 
Picture Name will be “HMIxx”.

Transparency Effect 
Transparency Color

Use the sucker tool  to suck the transparent color of the picture. See the illustrations below for 
the transparent effect on the object. 

Before the transparent effect After the transparent effect

Push Time (s) You can set the active time of the button between 0 and 10 seconds. When this option is enabled, 
the button will be active after you press the button longer than the setting time. This option can pre-
vent operation errors.

User Security Level You can set the user security level between 0 and 7. (0 is default. 7 is the highest security Level.) 
When this option is enabled, the user can use only the objects whose security level is equal to or 
lower than the user's level.

Set Low Security When this option is enabled, the security level will be the lowest after the button is pressed. This 
option can prevent operation errors.

InterLock Address 
InterLock Level

InterLock Address:
An interlock can be set for accepting inputs for the object based on the status of the communica-
tions address. 
InterLock Level:
• When Set to ON:

Inputting is disabled when the InterLock Address is ON and enabled when it is OFF. 
• When Set to OFF:

Inputting is disabled when the InterLock Address is OFF and enabled when it is ON.

Common Settings Details
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6-4-3 Button Objects

ON Macro Refer to 6-5 Macro Function.

OFF Macro Refer to 6-5 Macro Function.

Touch ON Macro Refer to 6-5 Macro Function.

Touch OFF Macro Refer to 6-5 Macro Function.

Trigger
Trigger Mode

This function can turn the target PLC address to ON before or after the setting value is written. If it 
is necessary to turn to ON again, the user must set the address to be OFF manually.

Border Color You can set the border color of the object. 

Background Color You can set the background color of the object.

Foreground Color You can set the foreground color of the object.

Fast Refresh Refer to Properties in 6-2-6 Screen Menu.

Common Settings Details

Button Macro Read Write Function

Set Touch 
ON/
Touch 
OFF

Yes Yes This button can turn the setting address (Bit) to 
ON. The address will be always ON, if you release 
or press the button again. If there is an Touch ON 
Macro, the PT will execute it at the same time.

Reset Touch 
ON/
Touch 
OFF

Yes Yes This button can turn the setting address (Bit) to 
OFF. The address will be always OFF, if you 
release or press the button again. If there is an 
Touch OFF Macro, the PT will execute it at the 
same time.

Momen-
tary

Touch 
ON

Touch 
OFF

Yes Yes This button can turn the setting address (Bit) to 
ON while the button is pressed. When you press 
the button, the bit is turned ON and the Touch ON 
Macro is executed. When you release the button, 
the bit is turned OFF and the Touch OFF macro is 
executed.

Alterna-
tive

Touch 
ON
Touch 
OFF

Yes Yes When you press the button, Touch ON Macro is 
executed if the bit is turned from OFF to ON or 
Touch OFF Macro is executed if the bit is turned 
from ON to OFF.

N-State ON/
OFF

Yes Yes There are 1 to 256 user-defined multi-states. This 
button can change its state by the read address.

Assign 
Value

ON/
OFF

No Yes When you press this button, the Numeric keypad 
Dialog Box will show on the screen. You can input 
the setting value directly. After you press ENTER 
key, the PT will transmit the input value to the set-
ting address.

Assign 
Constant

ON/
OFF

No Yes This button will write the specified value into the 
setting address. 
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■ General Buttons

There are four types of general buttons: set button, reset button, momentary
button and alternative button. When you press these buttons, the PT will
transmit ON/OFF signal to the PLC. 

For details on functions common to all objects, refer to 6-4-2 Common Set-
tings.

■ N-State Button

For details on functions common to all objects, refer to 6-4-2 Common Set-
tings.

N-Incre-
ment

ON/
OFF

Yes Yes This button will add the setting address value to 
the setting constant value and write the result to 
the setting address.

N-Decre-
ment

ON/
OFF

Yes Yes This button will subtract the setting constant value 
from the setting address value and write the result 
to the setting address. 

Change 
Screen

ON/
OFF

No No This button can show the screen you specified.

Back 
Screen

ON/
OFF

No No This button can show the previous screen.

Previous 
View

ON/
OFF

No No This button can show the previous screen in an 
order that the change screen button shows. 

TC Oper-
ation
Command

No No Yes This button can send commands to temperature 
controllers.

Button Macro Read Write Function

Property of General Buttons 

Style Standard Raised Round Invisible

You can set the button style.

Function You can change the function of the general buttons. You do not have 
to create a new object.

Property of N-State Button

The N-State button is a button that has more than one state.

Data Length The data length can be bit, word or LSB.

Read 
Format

The read format can be BCD, signed decimal, unsigned decimal or 
hexadecimal. This option is available only when the data length is word.

Add/
Remove 
State

You can set the number of states of the object. The setting range will 
change by the data length.

Word: 256 states

LSB: 16 states
Bit: 2 states

Sequence You can set the sequence of the N-state object (previous state/next 
state).
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Example of N-State button: 

When the data length is LSB (from D100.0-D100.1 to D100.3-D100.4), N-
State button will change as below.

■ Assign Value Button

For details on functions common to all objects, refer to 6-4-2 Common Set-
tings.

Example of Assign Value Button: 

S0=D100.0 ON S1=D100.1 ON S2=D100.2 ON S3=D100.3 ON S4=D100.4 ON

Property of Assign Value Button

When you press this button on the screen, the numeric keypad (TEN-KEY) will show. 
Input the setting value and press ENTER key. The PT will send the value to the spec-
ified address. 

Detail Range 
Setup

Data Length The data length can be word (16bits) or double word 
(32bits).

Data Format You can select the data format from below: Word: 
BCD, signed decimal, unsigned decimal or hexadec-
imal, binary.
Double Word: BCD, signed decimal, unsigned deci-
mal, hexadecimal, binary or float.

Minimum You can set the minimum and maximum value of the 
input setting range.Maximum

Integer Digits You can set the integer or fraction digits. The digit 
number will be an actual digit number only when the 
data format is selected as float.

Fraction Digits
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Numeric keypad (TEN-KEY) dialog box:

■ Assign Constant Button

For details on functions common to all objects, refer to 6-4-2 Common Set-
tings.

■ N-Increment / N-Decrement Buttons

For details on functions common to all objects, refer to 6-4-2 Common Set-
tings.

Property of Assign Constant Button

When you press this button on the screen, the PT will send the value to the PLC 
address. This button has the same function as the assign value button has.

Detail Range Setup

Data Length The data length can be word (16 bits) or dou-
ble word (32 bits).

Data Format The read format can be BCD, signed decimal, 
unsigned decimal or hexadecimal.

Detail You can enter the constant value to write in the 
address.

Property of N-Increment / N-Decrement Buttons

When you press these buttons on the screen, the PT will read the value from the PLC 
address. The read value adds to or subtracts from the set constant value, and the PT 
will write the result into the address. When the user press the button, the PT will write 
the limit value (minimum or maximum) to the address, if the result is out of the limit. 

Function You can change the function of the N-Increment buttons and 
N-Decrement buttons. You do not have to create a new object.
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Example of N-Increment / N-Decrement buttons:

To adjust D1000 value, press +/− Buttons.

Detail Range Setup

Data Length The data length can be word (16 bits) or dou-
ble word (32 bits).

Data Format The read format can be BCD, signed decimal, 
unsigned decimal or hexadecimal.

Jog Step You can set the increment or decrement value. 
This will be the number to add or subtract 
when you press the buttons each time.

Limit You can set the maximum or minimum number 
of the increment or decrement value.

Property of N-Increment / N-Decrement Buttons
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■ Change Screen / Back Screen / Previous View Buttons 

For details on functions common to all objects, refer to 6-4-2 Common Set-
tings.

Property of Change Screen / Back Screen / Previous View Buttons

These three buttons can change screens.

• Change Screen: When you press this button on the screen, the PT will change the 
screen to the target screen.

• Back Screen: When you press this button on the screen, the PT will change the 
screen to the previous screen.

• Previous View: When you press this button on the screen, the PT will change to the 
previous view.

These are the examples of screen changes.
Change Screen Button:

On Screen1, if you press the “Goto Screen2” button, Screen1 will change to 
Screen2. If you press the “Goto Screen3” button on Screen2, it will change to 
Screen3. Back Screen Button:

If you press the “Back Screen” button on Screen3, the screen will change to Screen2 
shown one screen before the active one. If you press the “Back Screen” button on 
Screen2, it will change to Screen3.

Previous View Button:
If you press the “Previous View” button on Screen2, it will change to Screen1. 

Function You can change the function of the change screen, back screen, and 
previous view buttons. You do not have to create a new object.
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■ TC Operation Command

For details on functions common to all objects, refer to 6-4-2 Common Set-
tings.

When EJ1 is specified as a protocol, the TC Operation Command button is
available. 

For how to set the protocol, refer to Communication Tab in PT Setting Dialog
Box of 6-2-4 PT Menu.

The TC Operation Command buttons can send commands to temperature
controllers. 

To specify the commands, use the Input Dialog Box of Write Address option.

For details on each command, refer to the manual for temperature controller.

Input Value

Note This option is for the change screen button only.

Close Pup-up 
Screen

You can select this check box only when the button is 
placed on a pop-up screen. When you press this but-
ton on the pop-up screen, the PT will close that pop-
up screen.

User security 
level will be set 
to Low Security 
after changing 
the screen

When this option is enabled, the security level will be 
the lowest after the button is pressed. This option can 
prevent operation errors.

Goto 
Screen

You can set a destination screen.
Click this option to show the dialog box as below.

When you select one of the screens from the left pane of the Dialog 
Box, the preview screen will show on the right pane.

Note This option is for the change screen button only.

Property of Change Screen / Back Screen / Previous View Buttons
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■ System Function Button

For details on functions common to all objects, refer to 6-4-2 Common Set-
tings.

Property of System Function Button

Function You can change the function of the system function buttons. You do not 
have to create a new object.

System Date 
& Time

When you press this button on the screen, the PT will 
show the Date/Time Dialog Box. You can set year, 
month and date, hour, minute and second, and save 
them in the PT system.

Password 
Table Setup

When you press this button on the screen, PT will show 
the Password Table Dialog Box. You can only change 
and see the passwords that are the same or lower than 
your security level.
If the setting level is higher than your security level, you 
cannot change and see the passwords.

Even if you replace the screen data, the passwords in 
the Password Table will be the same.

Enter Pass-
word

When you press this button on the screen, PT will show 
the Password Keypad Dialog Box. You can input a 
password to change your security level of PT. When you 
input a higher level password, you can access the higher 
level objects.

User security level 7 User security level 5
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6-4-4 Meter (1 to 3)

For details on functions common to all objects, refer to 6-4-2 Common Set-
tings.

■ Meter (1 to 3) 

Function Contrast 
&Brightness

When you press this button on the screen, the PT will 
show the Adjust LCD Dialog Box. You can adjust LCD 
contrast and brightness settings of the PT.
 If you press the Set to Default LCD Button, the LCD 
settings will be default. If you press Put Contrast Center 
Button, the contrast adjustment bar will move to the mid-
dle.

Low Security The user security level will become the lowest level 
(Level 0).

System Menu When you press this button on the screen, the PT will 
show the system menu. To return to the user screen, 
press the Exit Button on the system menu.

Property of System Function Button

Property of Meter (1 to 3)

You can use the meter (1 to 3) to monitor whether the value of the address is more than 
the limit or not.

Style Standard Raised Sunken
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Detail

Data Length The data length can be word (16bits) or double 
word (32bits).

Data Format The data format can be BCD, signed decimal 
or unsigned decimal.

Minimum Value You can set the minimum and maximum value 
of the display. Maximum Value

Target

Value
Color

You can select the Target option to specify the 
target value and color. Thus the object will 
show the target value and the color that you 
set.

See the illustration below.
The target value is 60 and the color is blue.

Range Refer to the Low Region Color and High 
Region Color of this property.

Variable target/range 
limits

If you select this option, Read Address+1 is 
the low limit, Read Address+2 is the high limit 
and Read Address+3 is the target value.

Integer Digits You can set the integer and fraction digits for 
display. Fraction Digits

Low Region 
Color
High Region 
Color

You can set the low and high region color. These options are available 
only when you select the Ranges option in the Detail Dialog Box. 
See the illustration below.

The low limit value is 30, the color of low region is green, the high limit 
value is 70, and the color of high region is red.

Stitch Color You can set the stitch color.

Property of Meter (1 to 3)
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6-4-5 Meter (4 to 7)

For details on functions common to all objects, refer to 6-4-2 Common Set-
tings.

Scale Color You can set the scale color.

Scale Region 
Number

You can set the scale region number. The setting range is between 1 
and 10. 

Property of Meter (1 to 3)

Property of Meter (4 to 7)

The meter (4 to 7) show the continuous changes of the specified address.

Border Color
Foreground 
Color

Background 
Color

You can set the border color, foreground and background color.
See the illustration below.
The border color is blue, the foreground color is green and the back-
ground color is yellow. 

Style Standard Raised Sunken Transparency

Detail

Data Length The data length can be word (16bits) or double 
word (32bits).

Data Format The data format can be BCD, signed decimal, 
unsigned decimal or hexadecimal.

Minimum Value You can set the minimum and maximum value of the 
display.Maximum Value
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6-4-6 Level Meter

For details on functions common to all objects, refer to 6-4-2 Common Set-
tings.

■ Level Meter

Detail Target
Value

Color

You can select the Target option to specify the tar-
get value and color. Thus the object shows the tar-
get value and the color that you set.
See the illustration below.
The target value is 80 and the color is yellow.

Range Refer to the Low Region Color and High Region 
Color of this property.

Variable target/
range limits

If you select this option, Read Address+1 is the low 
limit, Read Address+2 is the high limit, and Read 
Address+3 is the target value.

Low Region 
Color
High Region 
Color

You can set the low and high region color. These options are available 
only when you select the Range option in the Detail Dialog Box.
See the illustration below.
The low range limit value is 30, the color of low region is green, the 
high range limit value is 70 and the color of high region is red. The 
minimum and maximum input value is 0 and 100 respectively.

Property of Meter (4 to 7)

When the value is 20 When the value is 50 When the value is 80 

Property of Level Meter 

The PT reads the value of the specified host address, and shows the value on the level 
meter.

Foreground 
Color

Background 
Color

You can set the foreground and background color.
See the illustration below.

The foreground color is green and the background color is light yellow.

Style Standard Raised Sunken

Display For-
mat

Left The display progressing direction is from right to left.

Right The display progressing direction is from left to right.

Top The display progressing direction is from bottom to top.

Bottom The display progressing direction is from top to bottom.
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Value

Data Length The data length can be word (16bits) or dou-
ble word (32bits).

Data Format The data format can be BCD, signed decimal, 
unsigned decimal or hexadecimal. 

Minimum Value You can set the minimum and maximum value 
of the display.Maximum Value

Value Target
Value
Color

You can select the Target option to specify the 
target value and color. Thus the object will 
show the target value and the color that you 
set.
See the illustration below.
The target value is 50 and the color is red. 
The maximum and minimum value is 100 and 
0 respectively.

Range Refer to the Low Region Color and High 
Region Color of this property.

Variable target/range 
limits

If you select this option, Read Address+1 is 
the low limit value, Read Address+2 is the 
high limit value and Read Address+3 is the 
target value.

Low Region 
Color

High Region 
Color

You can set the low and high region color. These options are available 
only when you select the Range option in the Detail Dialog Box. 

See the illustration below.
The low limit value is 30, the color of low region is green, the high limit 
value is 70, and the color of high region is red. The minimum and max-
imum input values are 0 and 100 respectively.

Property of Level Meter 

When the value is 20 When the value is 50 When the value is 80
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■ Deviation Object

Property of Deviation Object

The PT reads the value of the specified host address and subtracts the setting stan-
dard value from this read value to get a deviation value. Then, the PT shows this devi-
ation value on the deviation object.

Foreground 
Color
Background 
Color

You can set the foreground and background color.

See the illustration below.
The foreground color is green and the background color is light yellow.

Style Standard Raised Sunken

Display For-
mat

Horizontal The deviation value shows horizontally. 

Vertical The deviation value shows vertically.

Value

Data Length The data length can be word (16bits) or dou-
ble word (32bits).

Data Format The data format can be BCD, signed decimal, 
unsigned decimal or hexadecimal.

Standard Value You can set the standard value to calculate 
the deviation value.

Minimum Value You can set the minimum and maximum value 
of the display.Maximum Value

Display Deviation 
Limit

If you select this option, you can specify the 
deviation limit and color to show the deviation 
value in the color you specified.
If you deselect this option, the deviation object 
shows the deviation value in the foreground 
color.

Limit You can set the limit value.

Color You can set the display color of the limit value.

Variable Standard 
Value/Deviation Limit

If you select this option, Read Address+1 is 
the standard value and Read Address+2 is 
the deviation limit value.
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6-4-7 Pipe

For details on functions common to all objects, refer to 6-4-2 Common Set-
tings.

■ Pipe (1) / Pipe (2)

Detail Example:
If the data length is word, the data format is unsigned decimal, the 
standard value is 50, the minimum value is 0, the maximum value is 
100 and the deviation limit is 20, the deviation object will show as fol-
lows.

Property of Deviation Object

When the value is 10 When the value is 20

When the value is 70 When the value is 90

Property of Pipe (1) / Pipe (2) 

The PT reads the value of the specified host address, and shows the value on the pipe 
(1) / pipe (2). 

Water Mark 
Color

Inside Tube 
Color

You can set the watermark color and inside tube color.
See the illustration below.

The Water Mark Color is blue.          The Water Mark Color is red.
The Inside Tube Color is black.         The Inside Tube Color is white.

Style Standard Rotation 180

Pipe (1) Pipe (2)
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Detail

Data Length The data length can be word (16bits) or double word 
(32bits).

Data Format The data format can be BCD, signed decimal, 
unsigned decimal or hexadecimal.

Minimum Value You can set the minimum and maximum value of the 
pipe object.Maximum Value

Detail Target Value 
Color

You can select the Target option to specify the tar-
get value and color. Thus the object will show the 
target value and the color that you set.

Range Refer to the Low Region Color and High Region 
Color of this property.

Variable target/
range limits

This option is available only when you select the 
Target and Range Options. Read Address+1 is the 
low limit value, Read Address+2 is the high limit 
value and Read Address+3 is the target value.

Low Region 
Color
High Region 
Color

You can set the low and high region color. These options are available 
only when the Range option in the Detail Dialog Box is selected. 
See the illustration below.
The low limit value is 30, the color of low region is green, the high limit 
value is 70 and the color of high region is red. The minimum and max-
imum input value is 0 and 100 respectively.

Property of Pipe (1) / Pipe (2) 

When the value is 20 When the value is 50 When the value is 80
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■ Pipe (3)

■ Pipe (4) 

■ Pipe (5) 

Property of Pipe (3)

This object connects to several pipes. The pipe (3) shows as follows.

Pipe Gauge You can set the pipe gauge. The selectable range is between 1 
and 5. 1 is 13 dots and 2 is 26 dots. The size for 3 to 5 increases 
progressively.

Property of Pipe (4)

This object connects to several pipes. The pipe (4) shows as follows.

Style Standard Rotation 90 Rotation 180 Rotation 270

Pipe Gauge You can set the pipe gauge. The selectable range is between 1 and 
5. 1 is 13 dots and 2 is 26 dots. The size for 3 to 5 increases progres-
sively.

Property of Pipe (5)

This object connects to several pipes. The pipe (5) shows as follows.

Style Standard Rotation 90 Rotation 180 Rotation 270

Pipe Gauge You can set the pipe gauge. The selectable range is between 1 and 
5. 1 is 13 dots and 2 is 26 dots. The size for 3 to 5 increases progres-
sively.
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■ Pipe (6) / Pipe (7)

6-4-8 Lamp

For details on functions common to all objects, refer to 6-4-2 Common Set-
tings.

■ N-State Lamp

Property of Pipe (6) / Pipe (7) 

The pipe (6) and (7) are horizontal and vertical pipes. The PT shows the direction of 
water flow by the change of the read 
address.

Mobile Cursor 
Color

You can set the mobile cursor color. The mobile cursor will show 
when there is any data occurred in the read address.

Pipe Gauge You can set the pipe gauge. The range is between 1 and 5. 1 is 13 
dots and 2 is 26 dots. The size for 3 to 5 increases progressively.

Value of Read 
Address = 0

Value of Read 
Address = 1

Value of Read 
Address = 2

Pipe 6

Pipe 7

Property of N-State Lamp

The N-state lamp is a lamp that has n states.

Read Address Refer to 6-4-2 Common Settings for details on how to set the read 
address.
When you set the read address with the contact of the host, the n-
state lamp will change with the state (ON or OFF) of the host contact.

For example, you can set the state settings of the n-state lamp to 
show the text “Start” when the value is 1 and to show the text “Stop” 
when the value is 0.

You can also add a picture to each state to show a different picture 
for each state. 

Style Standard Raised Round Invisible

Data Length The data length can be bit, word or LSB.
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Example of n-state lamps:

■ Range Lamp

Read Format The read format can be BCD, signed decimal, unsigned decimal or 
hexadecimal. This option is available only when the data length is 
word. 

Add/Remove 
State

You can set the number of states of the object. The setting range will 
change by the data length.

Word: 256 states
LSB: 16 states

Bit: 2 states

Property of N-State Lamp

 

Property of Range Lamp

The range lamp shows the state of specified address in the data length.

Style Standard Raised Round Invisible

Add/Remove 
State

You can set the number of states of the object. The setting range will 
change by the data length.

Word: 256 states

Detail
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■ Simple Lamp

Detail Data Length The data length can be word (16bits) or double word 
(32bits).

Data Format The data format can be BCD, signed decimal or 
unsigned decimal. 

Range Vari-
able 
Limits

When n is the total number of states, n will also be 
the total number of ranges. You can use addresses 
to specify the lower limit of each range.

For example, If the read address is $0, and the total 
number of states is 5, you can use range 0 to 4. The 
lower limit value of range 0 is $1, the lower limit value 
of range 1 is $2. For the range 2 and greater the 
address increases progressively. 

Con-
stant 
Limits

When n is the total number of states, n will also be 
the total number of ranges. You can specify the limit 
of each range. 

For example, when the number of states is 5, the 
number of ranges will be 5 (0 to 4). You can specify 
the foreground color of state 0, 1, 2, 3, and 4 as red, 
green, blue, yellow and purple, respectively. 

Property of Simple Lamp

The simple lamp has two states (ON/OFF). Thus, it is possible to emphasize some dis-
play parts of the screen. In the example below, there are simple lamps on the pipes. 
The simple lamps will change as shown on the right figure below.

XOR Color You can set XOR color of base picture. 

When an object is positioned in the behind a simple lamp, the object in 
back will not be refreshed while the simple lamp is illuminated, even if 
the object display changes.

Property of Range Lamp

The below shows the relationships between the 
value of the read address and the range lamp color.

Range 0 Range 1 Range 2 Range 3 Range 4

100 50 33 1 0

Value of Read Address Range Lamp Color

100 and more Red

50 to 99 Green

33 to 49 Blue

1 to 32 Yellow

0 and less Purple

Precautions 
for Correct Use
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6-4-9 Data Display Object

For details on functions common to all objects, refer to 6-4-2 Common Set-
tings.

■ Numeric Display Object

Property of Numeric Display Object

The numeric display object reads the value of the setting address, and shows the read 
value in the format that you set.

Label Size
Label Color

You can set the label size and label color. The label size can be 
between 8 and 64.

Style Standard Raised Sunken Transparency

Leading Zero You can add or remove the leading zero to each value. The integral 
digits are set to 4.

Detail

Data Length The data length can be word (16bits) or double 
word (32bits).

Data Format You can set any of the data formats below.
Word: BCD, signed decimal, unsigned decimal, 
hexadecimal or binary. 

Double Word: BCD, signed decimal, unsigned deci-
mal, hexadecimal, binary or float.

Integral Digits You can set the integral and fraction digits. The 
digit numbers will be an actual digit number only 
when the data format is selected as Float.

Fraction Digits

When YES is selected

When NO is selected
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■ String Display Object

■ Date Display Object

■ Time Display Object

Detail Gain (a) You can gain and offset the display numeric value 
(y) by the equation y = (a) x (read address value) 
+ (b).
For example, if Gain value (a) is 2, Offset value (b) 
is 3 and the read address value is 4, then the dis-
play numeric value will be 2 x 4 + 3 = 11. 

Offset (b)

Round off If you select this option, the result (y) of the equa-
tion above can be rounded off. 

Property of String Display Object

This string display object reads the value of the specified address, and converts it to 
text to show it on the screen. The value of read address must be set in ASCII format.

Read Address Refer to 6-4-2 Common Settings.

Label Size
Label Color

You can set the label size and label color. The label size can be 
between 8 and 64.

Style Standard Raised Sunken Transparency

Characters 
Length

The characters length can be between 1 and 28 characters. 

For example, if the read address is $0, the characters length is 2 and 
the value at $0 is set as follows, the above screen will show.

$0 = 4142H

Property of Date Display Object

The date display object shows the PT system date.

Label Size

Label Color

You can set the label size and label color. The label size can be 
between 8 and 64.

Style Refer to the Property of Numeric Display Object.

Date Format MM/DD/YY, DD/MM/YY, DD.MM.YY, YY/MM/DD

Property of Time Display Object

The time display object shows the PT system time. 

Label Size

Label Color

You can set the label size and label color. The label size can be 
between 8 and 64.

Style Refer to the Property of Numeric Display Object.

Time Format HH:MM:SS, HH:MM 

Property of Numeric Display Object
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■ Week Display Object

■ Message Bank Object

■ Banner Object

6-4-10 Draw Objects

Property of Week Display Object

The week display object shows the day (Sunday to Monday) of the week. The state 
default setting is 0 (0: SUN to 6: SAT). Each state has its predefined day description, 
such as SUN, MON ... SAT. You can change it in the property.

Style Refer to the Property of Numeric Display Object.

Property of Message Bank Object

The message bank object shows the state content of the specified host contact or 
address.

Style Refer to the Property of Numeric Display Object.

Data Type The data type can be bit, word or LSB. 

Read Format The read format can be BCD, signed decimal, unsigned deci-
mal or hexadecimal. This option is available only when the data 
length is word.

Add/Remove State You can set the number of states of the object. The setting 
range will change by the data length.

Bit: 2 states 

Word: 256 states
LSB: 16 states

Property of Banner Object

The banner object moves, lights and shows in the way you set, and shows the state 
content of specified host contact or address.

Style Refer to the Property of Numeric Display Object.

Data Length The data length can be bit, word or LSB.

Read Format The read format can be BCD, signed decimal, unsigned decimal 
or hexadecimal. This option is available only when the data 
length is word. 

Add/Remove State You can set the number of states of the object. The setting 
range will change by the data length.

Word: 256 states
LSB: 16 states

Bit: 2 states

Direction Left The display progressing direction is from right to left.

Right The display progressing direction is from left to right. 

Top The display progressing direction is from bottom to top.

Bottom The display progressing direction is from top to bottom. 

Movement Distance You can set the movement distance of the message. The range 
is between 1 and 50 dots.

Interval (ms) You can set the time interval between movements. The range is 
between 50 and 3000 ms. 
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For details on functions common to all objects, refer to 6-4-2 Common Set-
tings.

■ State Image Object

Example of state image objects:

The read address = D100.

The relation between the Internal Memory value and each state shows below:

Property of State Image Object

You can use this object to show one or more states on the specified position of the PT 
screen. Each state can show a different picture.

Data Length The data length can be bit, word or LSB.

Read Format The read format can be BCD, signed decimal, unsigned decimal or 
hexadecimal. This option is available only when the data length is 
word.

Add/Remove 
State

You can set the number of states of the object. The setting range will 
change by the data length.

Bit: 2 states 
Word: 256 states

LSB: 16 states

Auto Change No The value of read address sets the state number.

Yes When the value of read address is 1 or more, the object will 
change automatically. When the value of read address is 0, 
the state will not change automatically.

Variation Read Address+1 
1 or more: The states will change automatically. 
0: The states will not change automatically.

Change Rate 
(ms)

You can set the automatic change interval of the states. The change 
rate is between 100 and 3000 ms.

Transparency 
Effect
Transparency 
Color
Foreground 
Color 
Transparency

If you select Yes, the transparent color specified in the object will be 
invisible. This option comes with the Transparency Color setting of 
the object.

See the illustrations:

Transparency Effect is No.

Transparency Color is disabled.

Foreground color transparency is Yes.

Transparency Effect and Transparency is Yes.

The object becomes transparent.
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■ Animated Object

D100=1   D100=2   D100=3   D100=4

Property of Animated Object

You can move and show the animated object on the screen by control of horizontal and 
vertical axes position. A different picture can show for each state.

Read Address Refer to 6-4-2 Common Settings for how to set read address.

Read Address The value of Read Address is the state of the 
animated object. 

Read Address+1 The value of Read Address+1 is the horizontal 
axis position.

Read Address+2 The value of Read Address+2 is the vertical axis 
position. 

Clear Picture You can clear the previous animated object when the object moves or 
the state of the object changes.

Data Length The data length can be word or LSB.

Read Format The read format can be BCD, signed decimal, unsigned decimal or 
hexadecimal. This option is available only when the data length is 
word.

Add/Remove 
State

You can set the number of states of the object. The setting range will 
change by the data length.

Word: 256 states
LSB: 16 states
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■ Variable Line Object

Property of Variable Line Object

You can change the color, shape and display position of the variable line object by the 
value of the read address.

Read 
Address

Refer to 6-4-2 Common Settings for how to set read address.

Note When you set Variable Color and Flicker to Yes, the address will be 
used for the variable color. The next address will be used for control-
ling the flicker.

Color You can set the display color of the variable line object.

Width The line width can be between 1 and 8 dots. 

Read Format The read format can be BCD, signed decimal, unsigned deci-
mal or hexadecimal.

Line Style You can select the line style from below.

Variable Position Refer to the Read Address of this property.

Variable Color Refer to the Read Address of this property.

Flicker This option can flicker the object when the address that con-
trols the flicker is ON.

Variable Position Yes No

Read Address Horizontal axis position of the start 
point

Color /Flicker 
(see note)

Read Address+1 Vertical axis position of the start point Flicker (see 
note)

Read Address+2 Horizontal axis position of the end 
point

Read Address+3 Vertical axis position of the end point

Read Address+4 Color /Flicker (see note)

Read Address+5 Flicker (see note)
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■ Variable Rectangle Object

Property of Variable Rectangle Object

You can change the color, shape and display position of the variable rectangle object 
by the value of the read address.

Read 
Address

Refer to 6-4-2 Common Settings for how to set read address.
When you set Variable Position to Yes:

Note When you set Variable Color and Flicker to Yes, the address 
will be used for the variable color. The next address will be used 
for controlling the flicker.

Width The border line can be between 1 and 8 dots.

Read Format The read format can be from BCD, signed decimal, unsigned decimal 
or hexadecimal.

Transparency When you enable this option, only the object border will show and 
there is no color in the object. This will also disable the Foreground 
Color option. 

Corner 
Radius 

You can use the bevel size setting for the radius to round the corners. 
(The maximum setting value can change when the size of the object 
changes.)

When you set Variable Position to No:

Variable Size Yes No

Read Address Horizontal axis posi-
tion of the top left

Horizontal axis posi-
tion of the top left

Read Address+1 Vertical axis position of 
the top left

Vertical axis position of 
the top left

Read Address+2 Object width Color /Flicker (see 
note)

Read Address+3 Object height Flicker (see note)

Read Address+4 Color /Flicker (see 
note)

Read Address+5 Flicker (see note)

Variable Size Yes No

Read Address Horizontal radius Color /Flicker (see 
note)

Read Address+1 Vertical radius Flicker (see note)

Read Address+2 Color /Flicker (see 
note)

Read Address+3 Flicker (see note)
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■ Variable Ellipse Object

Variable Posi-
tion

Refer to the Read Address of this property.

Variable Size Refer to the Read Address of this property.

Variable Color Refer to the Read Address of this property.

Flicker This option can flicker the object when the address that controls the 
flicker is ON.

Property of Variable Ellipse Object

You can change the color, shape and display position of variable ellipse object by the 
value of the read address.

Read 
Address

Refer to 6-4-2 Common Settings for how to set Read Address.
When you set Variable Center Point to Yes:

Note When you set Variable Color and Flicker to Yes, the address 
will be used for the variable color. The next address will be used 
for controlling the flicker.

Color You can set the display color of the variable ellipse object.

Width The line width can be between 1 and 8 dots. 

Read Format The read format can be BCD, signed decimal, unsigned decimal or 
hexadecimal.

Property of Variable Rectangle Object

When you set Variable Center Point to No:

Variable Size Yes No

Read Address Horizontal axis posi-
tion of the center point

Horizontal axis posi-
tion of the center point

Read Address+1 Vertical axis position of 
the center point

Vertical axis position of 
the center point

Read Address+2 Horizontal radius Color /Flicker (see 
note)

Read Address+3 Vertical radius Flicker (see note)

Read Address+4 Color /Flicker (see 
note)

Read Address+5 Flicker (see note)

Variable Size Yes No

Read Address Horizontal radius Color /Flicker (see 
note)

Read Address+1 Vertical radius Read Address+3

Read Address+2 Color /Flicker (see 
note)

Read Address+3 Flicker (see note)
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6-4-11 Input Objects 

You can input a value or string in a specified address. 

For details on functions common to all objects, refer to 6-4-2 Common Set-
tings.

■ Numeric Input Object

Transparency When you enable this option, only the object border will show and 
there is no color in the object. This will also disable the Foreground 
Color option.

Variable Cen-
ter Point

Refer to the Read Address of this property.

Variable Size Refer to the Read Address of this property.

Variable Color Refer to the Read Address of this property.

Flicker This option can flicker the object when the address that controls the 
flicker is ON.

Property of Variable Ellipse Object

Property of Numeric Input Object

You can input the setting value directly on the screen.

Press the object on the screen. A numeric keypad (TEN-KEY) will show. Input a setting 
value and press ENTER on a keypad. The PT will send the input setting value to the set 
address.

Label Size
Label Color

You can set the label size and label color. The label size can be between 
8 and 64 pixels.

Style Standard Raised Sunken Transparency

Leading 
Zero

You can add or remove the leading zero to each value.
The integral digits below are set to 4.

(When YES is selected)

(When NO is selected)
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■ String Input Object

Detail

Data Length The data length can be word (16bits) or double word 
(32bits).

Data Format You can select the data format from below: 
Word: BCD, signed decimal, unsigned decimal, hexa-
decimal, binary

Double Word: BCD, signed decimal, unsigned decimal, 
hexadecimal, binary, float

Minimum 
Maximum

You can set the minimum and maximum value of the 
input setting range. These options executes the check 
of minimum and maximum values before the values 
are converted to the set gain and offset.

Integer Digits

Fraction Digits

You can set the integer or fraction digits. The digit num-
ber will be an actual digit number only when the data 
format is selected as Float.

Variable Mini-
mum/Maximum 
Value

When this option is selected, the Read Address+1 is 
the minimum value. Read Address+2 is the maximum 
value.

Detail Gain (a) You can gain and offset the display numeric value (y) 
by the equation y = (a) x (Read Address value) + (b).
For example, if Gain value (a) is 2, Offset value (b) is 3, 
and the read address value is 4, the display numeric 
value will be 2 x 4 + 3 = 11.

Offset (b)

Round off If you select this option, the result (y) of the equation 
above can be rounded off. 

Display 
Asterisk (*)

If you select YES, the screen will show asterisks when you input values. 

Property of String Input Object

Press a string input object to show a dialog box for inputting a string. This object writes 
the input string to the write address. The string is input or shown only ASCII format.

Label Size
Label Color

You can set the label size and label color. The label size can be between 
8 and 64 points.

Style Standard Raised Sunken Transparency

Property of Numeric Input Object



167

Object Functions Section 6-4

6-4-12 Line Graph Objects 

Refer to the 6-4-2 Common Settings on functions common to all objects.

■ Broken-Line Object

Characters 
Length

The character length can be between 1 and 28 characters. The default 
setting is 4 characters.

Display 
Asterisk (*)

If you select YES, the screen will show asterisks when you input charac-
ters.

Property of String Input Object

Property of Broken-Line Object

This object can show a broken-line chart of the read address values.
Set the Line Number (1 to 4) in the property. Then click Value − Detail... to show the 
Line Setting Dialog Box, and set the Broken-Line chart setting.
Example:
If the Sample Number is 100 and Line Number is 4, the object will read the data of 
100 X 4 = 400 words. When the Read Address is D0, the object will read from D0 to 
D399.
See the Read Address allocation below. 

Line 1: D0 to D99
Line 2: D100 to D199
Line 3: D200 to D299

Line 4: D300 to D399
You must set the sample flag of the control block to read data and display the broken-
line charts. Refer to the 6-6 Control Block and Status Block.

Style Standard Raised Sunken

Line Num-
ber

The line number can be between 1 and 4 lines.
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Value

Sample Number When the Sample Number is a constant, the 
Max. Sample Number option is disabled. The 
Max. Sample Number is specified as below: 

• When the object style is Standard, the Max. 
Sample Number is the object width and the 
unit is dots.

• When the object style is Raised or Sunken, 
the Max. Sample Number is the object width 
minus the border widths (the border size is 
always 7 dots). See the illustration below for 
the border widths.

When the sample number is a variable value, 
the read address will be the sample number. If 
the variable value is more than the Max. Sam-
ple Number, the value will not exceed the Max. 
Sample Number that you set.

Max. Sample Number

Read Format The read format can be BCD, signed decimal, 
unsigned decimal or hexadecimal. 

Sample Flag You can select the number of the sample flag 
address. When the sample flag bit is ON, the 
data will be read and drawn. When the clear 
flag bit is ON, the graph will be cleared.

The sample flag address is in the control block. 
Refer to 6-6 Control Block and Status Block.

Minimum
Maximum

You can set the minimum and maximum value 
of the graph. If the value is more than the maxi-
mum value, the line will show the maximum 
value. If the value is less than the minimum 
value, the line will show the minimum value.

Width The line width can be between 1 and 8 dots. 

Color You can set the line color.

Property of Broken-Line Object
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■ X-Y Distribution Object

Grid Color
Partition 
Number

The illustration below shows that the Grid Color is red and the Partition 
Number is 3.

Property of X-Y Distribution Object

This object can show X and Y axes chart of the read address values.

Set the Line Number (1 to 4) in the property. Then click Detail − Detail... to show the 
Line Setting Dialog Box, and set the X-Y distribution chart setting.
Example:

If the Sample Number is 100 and Line Number is 4, the object will use 100 X 4 X2= 
800 words. When the Read Address of X axis is D0 and Y axis is D500, the object will 
read from D0 to D399 and from D500 to D899. 

See the Read Address allocation below. 
Line 1: X is D0 to D99, Y is D500 to D599
Line 2: X is D100 to 199, Y is D600 to D699

Line 3: X is D200 to D299, Y is D700 to D799
Line 4: X is D300 to D399, Y is D800 to D899
You must set the sample flag of the control block to read data and display the X-Y dis-
tribution. Refer to 6-6 Control Block and Status Block.

Style Standard Raised Sunken

Connect 
Two Points 

When you select Yes, a straight line will connect each two points.

Line Num-
ber

The line number can be between 1 and 4 lines.

Detail

Property of Broken-Line Object
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6-4-13 Data Log Objects

The data log objects can show data logs in graph and table formats. You must
use this object with Data Log Setting. Refer to 6-2-4 PT Menu for the setting.

Refer to the 6-4-2 Common Settings on functions common to all objects.

Detail Sample Number
Max. Sample Number

When the Sample Number is a constant, the 
Max. Sample Number option is disabled. The 
Max. Sample Number is specified as below:
• When the object style is Standard, the Max. 

Sample Number is the object width and the 
unit is dots.

• When the object style is Raised or Sunken, 
the Max. Sample Number is the object width 
minus the border widths (the border size is 
always 7 dots). See the illustration below for 
the border widths.

When the sample number is a variable value, 
the read address will be the sample number. If 
the variable value is more than the Max. Sam-
ple Number, the value will not exceed the Max. 
Sample Number that you set.

Data Format The read format can be BCD, signed decimal, 
unsigned decimal or hexadecimal.

Horiz. Read Address You can set the read address of the horizontal 
(X) axis position.

Vert. Read Address You can set the read address of the vertical (Y) 
axis position.

Sample Flag You can select the number of the sample flag 
address. When the sample flag bit is ON, the 
data will be read and drawn. When the clear 
flag bit is ON, the graph will be cleared.
The sample flag address is in the control block. 
Refer to 6-6 Control Block and Status Block.

Horiz. Minimum
Horiz. Maximum

You can set the minimum and maximum value 
of the horizontal (X) axis.

Vert. Minimum
Vert. Maximum

You can set the minimum and maximum value 
of the vertical (Y) axis.

Width You can set the line width. The line width can be 
between 1 and 8 dots. 

Color You can set the line color.

Grid Color
Horiz. Line 
Number
Vert. Line 
Number

The illustration below shows that the Grid Color is red and the both of 
Horizontal Line Number and Vertical Line Number are 2. 

Property of X-Y Distribution Object
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■ Trend Chart Object

Property of Trend Chart Object

The trend chart object can show data logs.

Line Number The line number can be between 1 and 8 lines.

Value

Logging Buffer You can select the data log buffer number. The 
number is the same as the line number of Data 
Log Setting Dialog Box. 

Data Format The data format can be BCD, signed decimal, 
unsigned decimal, hexadecimal or float. The data 
length is word. When you select Float, you must 
set more than 2 words in the Data Length Field of 
Data Log Setting Dialog Box.

Minimum You can set the minimum and maximum value of 
the trend chart. If the value is more than the maxi-
mum value, the line will show the maximum value. 
If the value is less than the minimum value, the 
line will show the minimum value. 

Maximum

Integral Digits You can set the integer or fraction digits. The digit 
number will be an actual digit number only when 
the data format is selected as Float.

Fraction Digits

Data Log Buffer 
Setup

Click the Data Log Buffer Setup Button to open 
the Data Log Setting Dialog Box. You can also 
select PT Menu − Data Log Setting. 

Time/Date

Time Format The time format can be HH:MM:SS or HH:MM. 
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Example of data log trend chart object: 

Value Date Format The date format can be MM/DD/YY, DD/MM/YY or 
DD.MM.YY.

Color You can set the text color of time and date. This 
option will be enabled when the Time Format or 
Date Format is selected.

Curve (No.1 ~ 8)

Enable If this option is selected, you can enable the line 
options.

Data No. You must set the data number to read the data 
log. 
For example, if the Data Length option in the 
Data Log Setting Dialog Box is 3 words, you can 
select the Data No. from 0 to 2. When you select 
1, the line 1 reads the value of the Read 
Address+1.

Note If the data format is Float and the number 
of the Data Length is an odd number, you 
must select an even number as the Data 
No.

Width The line width can be between 1 and 8 dots. 

Color You can set the line color. 

Grid Color
Partition Num-
ber

The illustration below shows that the grid color is red and the Parti-
tion Number is 3.

Property of Trend Chart Object
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■ Data Log Table Object

Property of Data Log Table Object

The data log table object can show data logs in table format.
When you input the read address in the Data Log Setting Dialog Box, the data length 
must be between 1 and 8 words. The Data No. of each Data Tab in the Data Log 
Detail Dialog Box will change with this value. 
For example, if the value of Data Length is 5, the Data No. selection will also be 5.

Column The number of the display data items can be between 1 and 8.

Value

Logging Buffer You can select the data log buffer number. The 
number is the same as the line number of Data 
Log Setting Dialog Box.

Data Log Buffer 
Setup

Click the Data Log Buffer Setup Button to open 
the Data Log Setting Dialog Box. You can also 
select PT Menu − Data Log Setting... 

Time/Date

Time Format The time format can be HH:MM:SS or HH:MM.

Date Format The date format can be MM/DD/YY, DD/MM/YY or 
DD.MM.YY.

Color You can set the text color of time and date. This 
option will be enabled when the Time Format or 
Date Format is selected.

Data (No. 1 to 8)

Data Length The data length can be word (16bits) or double 
word (32bits).

Data Format The data format can be BCD, signed decimal, 
unsigned decimal, hexadecimal or float.
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Example of data log table object: 

■ Event Log Table Object

Value Data No. You must set the data number to read the data 
log. 

For example, if the Data Length option in the 
Data Log Setting Dialog Box is 3 words, you can 
select the Data No. from 0 to 2. When you select 
1, the line 1 reads the value of the Read 
Address+1.

Note If the data format is Float and the number 
of the Data Length is an odd number, you 
must select an even number as the Data 
No.

Color You can set the display text color of the data.

Integer Digits
Fraction Digits

You can set the integer or fraction digits. The digit 
number will be an actual digit number only when 
the data format is selected as Float.

Leading Zero You can add or remove the leading zero to each 
value. For example, when Leading Zero option is 
enabled and the integral digits are set to 4, the 
display value will be 0001 instead of 1. 

Property of Data Log Table Object

Property of Event Log Table Object

The event log table object can show the event logs in table format. 

When the state changes, the specified message also changes. 

Data Length The data length can be word or LSB.

Read Format The read format can be BCD, signed decimal, unsigned decimal 
or hexadecimal. This option is available only when the data 
length is word. 

Add/Remove State You can set the number of states of the object. The setting range 
will change by the data length.

Word: 256 states
LSB: 16 states



175

Object Functions Section 6-4

Example of event log table object: 

Detail

Logging Buffer You can select the data log buffer number. The 
number is the same as the line number of 
Data Log Setting Dialog Box.

Data No. You must set the data number to read the 
event log. For example, if the Data Length 
option in the Data Log Setting Dialog Box is 3 
words, the Data No. can be between 0 and 2. 
When you select 1, the object reads the value 
of the Read Address+1.

Data Log Buffer 
Setup

Click the Data Log Buffer Setup Button to 
open the Data Log Setting Dialog Box. You 
can also select PT Menu − Data Log Set-
ting...

Time/Date

Time Format The time format can be HH:MM:SS or HH:MM.

Date Format The date format can be MM/DD/YY, DD/MM/
YY or DD.MM.YY.

Color You can set the text color of Time/Date. This 
option will be enabled when the Time Format 
or Date Format is selected.

Property of Event Log Table Object

1. D1000=0

2. D1000=1

3. D1000=2

4. D1000=3

5. D1000=4

6. D1000=5

7. D1000=6
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6-4-14 Alarm Objects

The alarm objects can show the alarm messages in table format. You must
use these objects with Alarm Setting. Refer to 6-2-4 PT Menu for the setting.

For details on functions common to all objects, refer to 6-4-2 Common Set-
tings.

■ History List Object

Example of history list object

Property of History List Object

The generate history/cancel history for the set alarm will be displayed in chronological 
order in list format. The generate history items will be shown with O’s and the cancel 
history items will be shown with X’s.

Detail

Time Format The time format can be HH:MM:SS or HH:MM.

Date Format The date format can be from MM/DD/YY, DD/
MM/YY or DD.MM.YY.

Alarm Number This option can show the alarm number in the 
history list object. The alarm number will 
always be in front of the alarm message. The 
Alarm Number will be set in the Alarm Set-
ting Dialog Box.

Color You can set the text color of time and date. 
This option will be active when the Time For-
mat or Date Format is selected.
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1. Alarm No. 001 occurred at August 31, 2007 09:04:07

2. Alarm No. 002 occurred at August 31, 2007 09:05:40

3. Alarm No. 001 released at August 31, 2007 09:06:29

■ Latest List Object

■ Frequency List Object

Property of Latest List Object

The present alarms will be shown in list format.

Detail

Time Format The time format can be HH:MM:SS or HH:MM.

Date Format The date format can be from MM/DD/YY, DD/
MM/YY or DD.MM.YY.

Color You can set the text color of time and date. 
This option will be active when the Time For-
mat or Date Format is selected.

Property of Frequency List Object

The alarm ON frequency (number of alarms) will be shown in the order of the alarms, 
in list format.

Detail

Time Format The time format can be HH:MM:SS or HH:MM.
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■ Message Banner Object

Detail Date Format The date format can be from MM/DD/YY, DD/
MM/YY or DD.MM.YY.

Alarm Number This option can show the alarm number in the 
frequency list object. The alarm number will 
always be in front of the alarm message. 
The Alarm Number will be set in the Alarm 
Setting Dialog Box.

Display for 
Counting Zero 
Too

If this option is selected, the alarm frequency 
list object will show the message when the 
alarm message occurrence is zero. 

Color You can set the text color of time and date. 
This option will be active when the Time For-
mat or Date Format is selected.

Property of Message Banner Object

The present alarms will be shown in a single line of scrolling text.

Style Standard Raised Sunken Transparency

Movement Dis-
tance

You can set the movement distance of the banner. The range can 
be between 1 and 50 dots.

Interval (ms) The interval time of the movement distance can be between 50 
and 3000 ms.

Value

Time Format The time format can be HH:MM:SS or HH:MM.

Date Format The date format can be from MM/DD/YY, DD/
MM/YY or DD.MM.YY.

Alarm Number This option can show the alarm number in the 
message banner object. The alarm number will 
always be in front of the alarm message. The 
Alarm Number will be set in the Alarm Setting 
Dialog Box.

Color You can set the text color of time and date. This 
option will be active when the Time Format or 
Date Format is selected.

Property of Frequency List Object
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6-4-15 Fixed Objects

The users can make many graphics objects by use of the fixed objects.

Refer to the 6-4-2 Common Settings on functions common to all objects.

■ Line Object

■ Rectangle Object

Property of Line Object

You can draw line objects.

Line Color You can set the line color of the object. 

Line Width The line width can be between 1 and 8 dots.

Line Style You can select the line styles from below. 

Property of Rectangle Object

You can draw rectangle objects.

Line Color You can set the line color of the object.

Line Width The line width can be between 1 and 8 dots.

Transparency When you enable this option, only the object border will show 
and there is no color in the object. This will also disable the 
Foreground Color option. 

Corner Radius You can use the bevel size setting for the radius to round the 
corners. (The maximum setting value can change when the 
size of the object changes.)

Line direction                     Line width (1 to 8)
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■ Circle Object

■ Polygon Object

Property of Circle Object

You can draw circle objects.

Line Color You can set the line color of the object.

Line Width The line width can be between 1 and 8 dots.

Transparency The outside area of a circle is always in transparent color.
When you select Yes, the foreground color will be in transpar-
ent color and the object will show the border line only. If there 
are other objects below this object, they will show up and can 
be viewed on the screen.

See the illustrations below.

 Transparency option is No

 Transparency option is Yes

Property of Polygon Object

You can draw polygon objects.

Line Color You can set the line color of the object.

Foreground Color You can set the display color of the object. See the illustrations 
below. 

The foreground color is blue. The foreground color is light blue.

Line Width The line width can be between 1 and 8 dots.

Transparency The outside area of a polygon is always in transparent color.
When you select Yes, the foreground color will be in transparent 
color and the object will show only with the border line. This option 
will also disable the Foreground Color option. If there are other 
objects below this object, they will show up and can be viewed on 
the screen.

See the illustrations below.

Transparency option is No. 

Transparency option is Yes.
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■ Sectors Object

■ Text Object

■ Scale Object

Property of Sectors Object

You can draw sectors objects.

Line Color You can set the line color of the object.

Line Width The line width can be between 1 and 8 dots.

Arc When you select Yes, the object will become an arc. This option 
will also disable the Foreground Color option. When you select 
No, the object will become a sector.

Property of Sectors Object

You can draw text objects.

Label Size The label size can be between 8 and 64.

Foreground Color
Label Color 

You can set the color of the text frame and label color.
See the illustration below.

The Foreground Color is blue. The Label Color is white. 

Transparency When you select Yes, the foreground color will be in transpar-
ent color and the object will show the label text only. This option 
will also disable the Foreground Color option.

Property of Scale Object

You can draw scale objects.

Label Size

Label Color

You can set the label size and label color. 

The label size can be between 8 and 64.

Style Standard Rotation 90 Rotation 180 Rotation 270

Label Dis-
play

This option can show the label display next to the scale.

Main Scale See the illustrations below.

The main scale is 2.                  The main scale is 3. 

Arc option is No.                             Arc option is Yes
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■ Table Object

Value

Data Length The data length can be word (16bits) or double word 
(32bits).

Date Format The data format can be BCD, signed decimal or 
unsigned decimal. 

Minimum You can set the minimum and maximum values of the 
scale range.Maximum

Integer Digits
Fraction Digits

You can set the integer and fraction digits.

Scale Color You can set the scale color of the object.

Sub Scale 
Number

See the illustrations below. 

The main scale number is 3. The main scale number is 3.
The sub scale number is 1. The sub scale number is 2. 

Property of Table Object

You can draw table objects.

Detail Setup

Header Row Header This option can set the color of the first 
row of the table. 

Col. Header This option can set the color of the first 
column of the table. 

Property of Scale Object
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Detail Setup Interlacing Rows This option can set the color of the inter-
lacing rows of the table. 

Columns This option can set the color of the inter-
lacing columns of the table.

Row Header This option can set the color of the inter-
lacing row header of the table. 

Columns 
Header

This option can set the color of the inter-
lacing column header of the table. 

Cell Setting Sep. Rows 
Evenly

You can distribute the rows of the table 
evenly. 

Sep. Col 
Evenly 

You can distribute the columns of the table 
evenly. 

Grid Color You can set the grid color. 

Number of 
Rows 

The number of rows can be between 1 and 99 rows. 

Number of 
Columns

The number of columns can be between 1 and 99 columns.

Property of Table Object
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6-5 Macro Function

6-5-1 Macro Types
Macro is the function executed by a basic program. With this Macro function,
the NP-series PTs can process screen display or data, which were processed
on hosts. Thus, the load on hosts decreases. To make sure that Macro is cor-
rect, you can use Test function on a computer to do a Macro test.

■ Macro Types

■ Restrictions

• Each macro can have a maximum of 512 lines.

• Each line can have a maximum of 128 bytes.

• Make sure that infinite loops do not occur. (Example: You cannot stop a
program).

• Variables cannot be used to specify addresses within macros. 

Macro Description

Macro Set with 
Project

Startup Macro The PT executes the Startup Macro 
only one time when the PT status up.

Project Resident Macro The PT executes the Project Resident 
Macro again and again when the PT 
starts up.

Project Periodic Macro The PT executes the Project Periodic 
Macro at the specified interval while 
the PT operates.

Macro Set with 
Screen

Start Macro The PT executes Start Macro to show 
screens.
The PT draws objects on the screen 
after the PT executes this macro.

End Macro The PT executes End Macro to close 
screens. If you use this macro to 
switch screens, the PT executes the 
Start Macro for the destination screen 
only after the PT executes the End 
Macro for the current screen.

Screen Periodic Macro The PT executes the Screen Periodic 
Macro at the specified interval while 
the PT shows screens.

Macro Set with 
Object (Button)

ON Macro The PT executes the ON Macro only 
one time to turn ON a bit of an object.

OFF Macro The PT executes the OFF Macro only 
one time to turn OFF a bit of an 
object. 

Touch ON Macro The PT executes the Touch ON Macro 
the instant the user press the object.

Touch OFF Macro The PT executes the Touch OFF 
Macro the instant the user press the 
object.

Other Submacro The Sub-macro is a subroutine. It is 
possible to:
• Call the Sub-macro from each 

macro,
• Register 512 Sub-macros in one 

project, and
• Give a name.
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■ Sub-macro

6-5-2 Editing Macro 

1. Selecting Macro Commands

1,2,3... 1. Select a macro from the menu bar or property. The macro editing window
shows.

2. Click the Macro Wizard Icon. The Macro Command Dialog Box shows.

3. Click the Command Button or Command Menu in the Macro Command
Dialog Box.

4. Select a command.

5. Edit a macro.

To comment each macro, you can use the 
Sub-macro function. Thus the manage-
ment, maintenance and operation are 
easy.
The initial name of all sub-macros is Sub-
macro (n) (n = 1 to 512). 

The left field shows the Sub-macro num-
bers. 

To use the Sub-macro, you can write 
“CALL n (n = 1 to 512)”.
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2. Macro Editing Window and Macro Command Dialog Box

1,2,3... 1. Macro Editing Window

Note The number on the left is the line number.

Toolbar of Macro Editing 
Window

• Import Macro 

This command imports macro files. You can reuse these files when you
connect to different hosts. This decreases the time to edit macros. 
To open a macro file, click the Import Macro icon. You can see this dialog
box. 

• Export Macro

This command saves created macro files. It is possible to give a new
name to tell the difference between the new file and others.
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• Update Macro

This function updates macros.

• Cut

This command cuts macros.

• Copy

This command copies macros.

• Paste

This command pastes macros.

• Syntax Check

This function makes sure that the macro syntax is correct.

• Macro Wizard

This command shows the Macro Command Dialog Box. You can use this
dialog box to edit macro. The macro commands are put in brackets when
you use host addresses. This tells you the difference between the com-
mands and the Internal Memory.
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2. Macro Command Dialog Box

■ Macro Command Dialog Box

• Previous

This command moves up the selected line by one line. The above lines
will also move up by one line.

• Next

This command moves down the selected line by one line. The lines below
will also move down by one line.

• Update

This function updates the macro. If you do not use this function after you
edit a macro, changes are not updated. With this function, you can know if
it is necessary to change the macro or not. If the macro is not updated,
you need to edit the macro again.

• Insert

This command inserts a macro between two lines. The lines below will
move down by one line.

• Delete

This command deletes the selected line. The lines below will move up by
one line.

• Comment

To write comments in programs, you can put the sharp symbol (#) in front
of sentences. The sentences from the sharp symbol to the end are com-
ments.

• Input field

You can use keys to edit macro in the input field. 
To edit the macro,

1. Input macros in the input field.
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2. Update the macros, or click the Enter key. The NP-Designer changes the
macro to a correct format. 

If there is an error, a warning dialog box shows.

There is no limit in spaces between operand and operation symbol.

• Command

To edit macro, you can use the commands. 

To use commands and equations,

• Input directly.

• Select from the menu or Command Button.

6-5-3 Macro Operation
■ Definition

■ Arithmetic Operation 

There are two Arithmetic Operations, which include Integer Operation and
Float Operation. 

Each operand can be the internal memory or constant. The operands that
store output results must be the internal memory. For details, refer to this table
and examples below.

+, FADD

Addition 

Equation: Var1 = Var2 + Var3[(Signed | DW)]

Var1 = FADD(Var2, Var3) (Signed DW)

This command adds Var2 and Var3, and stores the added result in Var1.

BYTE 8-bit data. You can use it to show 00 to FF of hexadecimal system.

WORD 16-bit data. Word is made up of continuous 2 bytes. For example b15 
to b0. You can use it to show 0000 to FFFF of hexadecimal system.

DWORD, DW 32-bit data. Double word is made up of continuous 2 words. For exam-
ple b31 to b0. You can use it to show 00000000 to FFFFFFFF of hexa-
decimal system.

Signed A signed value is a numeric value with polarity. You will usually see a 
'plus' sign in front of a positive number, and a 'minus' sign in front of a 
negative number.

Command Equation Description Remarks

+ Var1=Var2 + Var3 Addition These commands store the cal-
culated result as signed or 
unsigned WORD and DWORD.
When the data is more than the 
length of specified unit, these 
commands discard the data out 
of range.

− Var1=Var2 − Var3 Subtraction

* Var1 = Var2 * Var3 Multiplication

/ Var1= Var2 / Var3 Division

% Var1= Var2 % Var Get Remainder

ADDSUMW Var1 = ADDSUMW(Var2, Var3) Sum

= Var1 = Var2 Assignment

FADD Var1=FADD(Var2, Var3) Addition Float Operation is the operation 
of signed 32-bit data. FSUB Var1=FSUB(Var2, Var3) Subtraction

FMUL Var1=FMUL(Var2, Var3) Multiplication

FDIV Var1=FDIV(Var2, Var3) Division

FMOD Var1=FMOD(Var2, Var3) Get Remainder
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Example:

Adds the value in the internal memory $2 and 1.

$2 = $2 + 1

Adds the value in the internal memory $1 and $2, and stores the total in the
address $3.

$3 = $2 + $1

Adds the value in the internal memory $4 and 1.9.

$4 = FADD($4, 1.9) (Signed DW)

Combines the float values in the internal memory $4 and $6, and stores the
total in the address $8.

$8 = FADD($4, $6) (Signed DW)

-, FSUB

Subtraction

Equation: Var1 = Var2 - Var3[(Signed | DW)]

Var1 = FSUB(Var2, Var3) (Signed DW)

This command subtracts Var3 from Var2, and stores the subtracted result in
Var1.

Example:

Subtracts 1 from the value in the internal memory $2.

$2 = $2 - 1

Subtracts the value in the internal memory $1 from the value in the internal
memory $2, and stores the result in the internal memory $3.

$3 = $2 - $1

Subtracts 1.9 from the value in the internal memory $4.

$4 = FSUB($4, 1.9) (Signed DW)

Subtracts the float value in the internal memory $6 from the float value in the
internal memory $4, and stores the result in the internal memory $8.

$8 = FSUB($4, $6) (Signed DW)

*, FMUL

Multiplication

Equation: Var1 = Var2 * Var3[(Signed | DW)]

Var1 = FMUL(Var2, Var3) (Signed DW)

This command multiplies Var2 by Var3, and stores the result in Var1.

Example:

Multiplies the value in the internal memory $2 by 2.

$2 = $2 * 2

Multiplies the value in the internal memory $2 by $1, and stores the result in
the address $3.

$3 = $2 * $1

Multiplies the value in the internal memory address $4 by 1.5.

$4 = FMUL($4, 1.5) (Signed DW)

Multiplies the float value in the internal memory $4 by $6, and stores the result
in $8.
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$8 = FMUL($4, $6) (Signed DW)

/, FDIV

Division

Equation: Var1 = Var2 / Var3[(Signed | DW)]

Var1 = FDIV(Var2, Var3) (Signed DW)

Divides Var2 by Var3, and stores the result in Var1. The value in Var3 cannot
be equal to 0(zero).

Example:

Divides the value in the internal memory $2 by 5, and stores the result in the
address $3.

$3 = $2 / 5

Divides the value in the internal memory $4 by 4.3, and stores the result in the
address $6.

$6 = FDIV($4, 4.3) (Signed DW)

%, FMOD

Get Remainder

Equation: Var1 = Var2 % Var3[(Signed | DW)]

Var1 = FMOD(Var2, Var3) (Signed DW)

This command divides Var2 by Var3, and stores the remainder in Var1. The
value in Var3 cannot be equal to 0(zero).

Example:

Divides the value in the internal memory $2 by 5, and stores the remainder in
the address $3.

$3 = $2 % 5

Divides the value in the internal memory $4 by 4, and stores the remainder in
the address $6.

$6 = FMOD($4, 4) (Signed DW)

=

Assignment

Equation: Var1 = Var2[(Signed DW | DW)]

This operator (=) assigns data at Var2 to Var1. After the PT executes MOV
command, data at Var2 do not change.

Example: 

Assigns a constant number 4 to the internal memory $0.

$0 = 4

Assigns the values in the internal memory address $2 to the values in the
internal memory address $4.

$4 = $2

ADDSUMW

Repeated addition

Equation: Var1 = ADDSUMW(Var2, Var3)[(DW)]
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This command adds Var2, Var2+1, Var2+2, ..., and Var2+(the value of Var3 −
1), and stores the repeated addition result in Var1.

Example:

$2 = 1

$3 = 2

$4 = 3

$5 = 3

$0 = ADDSUMW($2, $5)

Adds the values in the internal memory address $2 to $4, and stores the sum
total in the address $0. You can specify the number of data you add with $5.
The value of the sum total is equal to 6($2 + $3 + $4).

■ Logical Operation

There are six logical operations, which include OR, AND, XOR, NOT, Shift-left
and Shift-right. Each operation has three operands. Each operand can be the
internal memory or constant. The operands that store output results must be
the internal memory. The unit can be Word and Double Word. For details,
refer to this table and examples below.

| 

Logical OR operation 

Equation: Var1 = Var2 | Var3[(DW)]

This command does the logical OR operation on Var2 and Var3, and stores
the result in Var1.

Example:

$2 = F000H

$4 = 0F00H

$2 = $2 | $4

Stores FF00H in $2.

&&

Logical AND operation

Equation:Var1 = Var2 && Var3[(DW)]

This command does the logical AND operation on Var2 and Var3, and stores
the result in Var1.

Example:

$2 = F000H

$4 = 0F00H

$2 = $2 && $4

Stores 0000H in $2.

Command Equation Description Remarks 

| Var1 = Var2 | Var3 Logical OR operation These commands 
store the calculated 
result as WORD and 
DWORD. 

&& Var1 = Var2 && Var3 Logical AND operation

^ Var1 = Var2 ^ Var3 Logical XOR operation 

NOT Var1 = NOT Var2 Logical NOT operation

<< Var1 = Var2 << Var3 Logical Shift-left opera-
tion 

>> Var1 = Var2 >> Var3 Logical Shift-right oper-
ation 
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^

Logical XOR operation

Equation: Var1 = Var2 ^ Var3[(DW)]

This command does the logical XOR operation on Var2 and Var3, and stores
the result in Var1.

Example:

$2 = F100H

$4 = 0F00H

$2 = $2 ^ $4

Stores FE00H in $2.

NOT

Logical NOT operation

Equation: Var1 = NOT Var2 [(Signed | DW)]

This command does the logical NOT operation on Var2, and stores the result
in Var1.

Example:

$2 = F100H

$4 = NOT $2

Stores 0EFFH in $4.

<<

Logical Shift-left operation

Equation: Var1 = Var2 << Var3[(DW)]

This command shifts Var2 (WORD/DWORD) data to the left (the number of bit
is Var3), and stores the result in Var1.

Example:

$2 = F100H

$2 = $2 << 4

Shifts $2 to the left by 4 bits. Var1 becomes 1000H.

>>

Logical Shift-right operation

Equation: Var1 = Var2 >> Var3[(DW)]

This command shifts Var2 (WORD/DWORD) data to the right (the number of
bit is Var3), and stores the result in Var1.

Example:

$2 = F100H

$2 = $2 >> 4

Shifts $2 to the right by 4 bits, and becomes 0F10H
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■ Data Transfer

There are four Data transfer commands, which include MEMCOPY, MEMSET,
STRCPYB and FMOV. For details, refer to this table and examples below.

MEMCOPY

Copies data of the specified number of words 

Equation: MEMCOPY (Var1, Var2, Var3)

This command copies data from address Var2 to address Var1 in words. You
can specify the number of words you copy with Var3. If the address at the
copy destination becomes more than the maximum number, an error will
occur when you execute validation.

Example:

Copies the data in $0, $1, $2 and $3 to $10, $11, $12 and $13 in sequence.

$0 = 1

$1 = 2

$2 = 3

$3 = 4

MEMCOPY ($10, $0, 4)

After the PT executes MEMCOPY command, $10=1, $11=2, $12=3, $13=4.

MEMSET

Fills the memory with the specified data

Equation: MEMSET (Var1, Var2, Var3) [(Signed)]

This command fills the memories from the address in Var1 with data in
address Var2. The number of memories is Var3. If the write destination
address becomes more than the maximum number, an error occurs when you
execute validation.

Example:

$5 = 10

MEMSET ($0, $5, 4)

Executes MEMSET command to fill $0, $1, $2, $3 with a constant 10.

STRCPYB

Converts Text to ASCII code

Equation: STRCPYB (Var1, “Var2”)

This command converts text in address Var2 to ASCII code, and stores it in
Var1. The maximum length is 128 words.

Example:

STRCPYB ($1, “AB12”)

Command Equation Description Remarks 

MEMCOPY MEMCOPY (Var1, 
Var2, Var3)

Block move Data type for Var1 and 
Var2 is address.

MEMSET MEMSET (Var1, 
Var2, Var3)

Fills the memory

STRCPYB STRCPYB (Var1, 
Var2, Var3)

Converts text to ASCII 
code

Var2 is an input string.

FMOV Var1 = FMOV(Var2) Transfers float data
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After the PT executes STRCPYB command, it stores 4241H in $1 and 3231H
in $2.

FMOV

Transfers Float Data

Equation: Var1 = FMOV(Var2) (Signed DW)

This command transfers float data from Var2 to Var1. After the PT executes
this command, there is no change in data of Var2.

Example:

Transfers a constant 44.3 to the internal memory address $0.

$0 = FMOV(44.3) (Signed DW)

■ Data Conversion

BCD

Converts binary data to BCD value

Equation: Var1 = BCD(Var2) [(DW)]

This command converts the binary data in Var2 to BCD value, and stores it in
Var1.

Example:

The binary data in $4 is 5564. 

After the PT executes BCD command, it converts the binary data in $4 to
5564H.

$4 = 5564

$4 = BCD($4)

BIN

Converts BCD data to binary data value

Equation: Var1 = BIN(Var2) [(DW)]

This command converts the BCD data in Var2 to binary data value, and stores
in Var1.

Example:

Command Equation Description 

BCD Var1 = BCD (Var2) Converts binary data to BCD

BIN Var1 = BIN (Var2) Converts from BCD data to binary.

XWD Var1 = XWD (Var2) Converts WORD to DWORD

XBW Var1 = XBW (Var2, Var3) Converts BYTE to WORD

XWB Var1 = XWB (Var2, Var3) Converts WORD to BYTE

SWAP SWAP (Var1, Var2, Var3) Swaps BYTE data 

XCHG XCHG (Var1, Var2, Var3) Exchanges data

MAX Var1 = MAX (Var2, Var3) Gets maximum value 

MIN Var1 = MIN (Var2, Var3) Gets minimum value 

STR2H Var1 = STR2H (Var2, 
Var3, Var4)

Converts text data (ASCII format) to hexa-
decimal data

H2STR Var1= H2STR (Var2, Var3) Converts hexadecimal data to text data 
(ASCII format)

FCNV Var1= FCNV (Var2) Converts integer to float value 

ICNV Var1= ICNV (Var2) Converts float value to integer
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The BCD (hexadecimal) data in $4 is 5564H. 

After the PT executes BIN command, it converts the BCD data in $4 to 5564.

$4 = 5564H

$4 = BIN($4)

XWD

Converts WORD to DWORD

Equation: Var1 = XWD(Var2) [Signed]

This command converts the WORD value in Var2 to DWORD value, and
stores in Var1.

Example:

The WORD value in decimal format in $4 is -7. After the PT executes XWD
command, it converts the word value in $4 to DWORD value and stores it in
$7.

$4 = -7 Signed

$7 = XWD($4)(Signed)

XBW

Converts BYTE to WORD

Equation: Var1 = XBW (Var2, Var3)

This command converts BYTE data (the number of bytes is Var3) from Var2 to
WORD value, and stores the result in Var1. It converts two bytes of Var2 to
two words and stores it in Var1. it fills the high byte with 0.

Example:

Assume that the value of $65534 is 12. Converts 12 BYTES (6 WORDS) to 12
WORDS from $785, and stores the result in $10 to $21.

$10=XBW($785, $65534)

XWB

Converts WORD to BYTE

Equation: Var1 = XWB(Var2, Var3)

This command converts WORD data (the number of bytes is Var3) from low-
byte of Var2 to BYTE format, and stores the result in Var1. This command dis-
cards the high-byte of Var2.

Example:

Assume that the value of $985 is 12. This command reads 12 WORDS from
low-byte of $986, and converts these 12 WORDS to 12 BYTES (6 WORDS),
and stores the result in $65 to $70.

$65= XWB($986, $985)

SWAP

Swaps BYTE Data

Equation: SWAP (Var1, Var2, Var3)

This command swaps the high-byte and low-byte of Var2, Var2+1,
Var2+2...Var2+Var3 (WORD), and stores the result in Var1, Var1+1,
Var1+2...Var1+Var3 in sequence.
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Example:

Swaps the high-byte and low-byte of $10, $11, ..., $14, and stores the result in
$1, $2, .., $5 in sequence.

SWAP($1, $10, 5)

If $11 = 1234H, after the PT executes SWAP command, $2 = 3412H.

XCHG

Exchanges Data 

Equation: XCHG (Var1, Var2, Var3)[(DW)]

This command exchanges the data of Var2, Var2+1, Var2+2...Var2+Var3 for
the data of Var1, Var1+1, Var1+2.., Var1+Var3. After the PT executes XCHG
command, it exchanges the data of Var1 for Var2.

Example:

Exchanges the data of $10, $11, ..., $14 for the data of $1, $2, .., $5 in
sequence.

XCHG($1, $10, 5)

If $11 = 1234H and $2 = 5678H, after the PT executes XCHG command, $2 =
1234H and $1 = 5678H.

MAX

Gets Maximum Value 

Equation: Var1 = MAX(Var2, Var3)[(Signed DW | DW)]

This command gets the maximum value from Var2 and Var3, and stores the
result in Var1.

Example:

$0 = 0

$1 = 2

$2 =10

$0 = MAX($1, $2)

The result a $0 = 10

MIN

Gets Minimum Value 

Equation: Var1 = MIN(Var2, Var3)[(Signed DW | DW)]

This command gets the minimum value from Var2 and Var3, and stores the
result in Var1.

Example:

$0 = 0

$1 = 2

$2 =10

$0 = MIN($1, $2)

The result a $0 = 2

STR2H

Converts text data (ASCII format) to hexadecimal data.
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Equation: Var1 = STR2H (Var2, Var3, Var4)

Var1: Data storage address of conversion destination. (Internal memory
address)

Var2: Data storage address of conversion source. (Internal memory address)

Var3: Data size you convert

Var4: Data length

Var4==0: Data length is byte

Var4==1: Data length is word

Var4==2: Data length is double word

This command converts the text data in the address specified with Var2 by the
size specified with Var3. Then it stores the result in Var1. 

Example:

Converts the text data of $100 to $107 to hexadecimal data, and stores the
result in $0 to $3. 

Assume that the text data below are stored in $100 to $107 before the PT exe-
cutes this command.

$0 = STR2H($100,8,0)

The result →$0 = 12H(WORD)

$1 = 34H(WORD)

$2 = 56H(WORD)

$3 = 78H(WORD)

H2STR

Converts hexadecimal data to text data (ASCII format)

Equation: Var1= H2STR (Var2, Var3)

This command converts the hexadecimal data in the address specified with
Var2 by the size specified with Var3. Then it stores the result in Var1.

Example:

$100 = 1234H

$0 = H2STR($100,1)

The result →$0 = 31H

$1 = 32H

$2 = 33H

$2 = 34H

FCNV

Converts integer to float value

Equation: Var1= FCNV (Var2)(Signed DW)

This command converts the integer in Var2 to float value, and stores it in Var1. 

Example:

$2 = 100

$1 = FCNV($2)(Signed DW)

The result → $1 = 100.0

$100 $101 $102 $103 $104 $105 $106 $107

' 1 ' ' 2 ' ' 3 ' ' 4 ' ' 5 ' ' 6 ' ' 7 ' ' 8 '
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ICNV

Converts float value to integer 

Equation: Var1= ICNV (Var2)

This command converts the float value in Var2 to an integer, and stores in
Var1. 

Example:

$2=FMOV(100.5) (Signed DW)

$1 = ICNV ($2)(Signed DW)

The result → $1 = 100

■ Comparison

IF...THEN GOTO LABEL ...

Equation: IF expression THEN GOTO LABEL identifier

If the command of expression is true, the process goes to LABEL identifier to
execute the program.

Comparison command table

Example:

If $2 is greater than or equal to 10, the process goes to LABEL 1 and contin-
ues to execute the program.

IF $2 >= 10 THEN GOTO LABEL 1

.....

LABEL 1

.....

Equation: IFB Var1 == {ON | OFF} THEN GOTO LABEL identifier

If Var1 is ON or OFF, the process goes to LABEL identifier to continue to exe-
cute the program. Var1 is PLC address.

Command Description Remarks 

A == B A is equal to B A and B must be the internal 
memory or constant. A!= B A is not equal to B

A > B A is greater than B

A >= B A is greater than or equal to B

A < B A is smaller than B

A <= B A is smaller than or equal to B

A && B == 0 Executes AND command on A 
and B. The result is equal to 0 

A && B ! = 0 Executes AND command on A 
and B. The result is not equal to 0 

A == ON A is ON A is internal memory.

A == OFF A is OFF

IFB A == ON 
THEN

A is ON A is internal memory or a PLC 
address.

IFB A == OFF 
THEN

A is OFF

IF A == B 
THEN CALL C

Calls sub-macro if A is equal to B. A is internal memory or a con-
stant.
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Example:

IFB $0.0 == ON THEN GOTO LABEL 1

IF...THEN CALL ...

Equation: IF Var1 == Var2 THEN CALL sub-macro number.

If Var1 is equal to Var2, this command calls sub-macro. Var1 and Var2 must
be the internal memory or constant.

Example:

If $2 is equal to 10, then this command calls sub-macro 1.

IF $2 == 10 THEN CALL 1

IF...ELSE...ENDIF

Equation:

IF expression1

Statement1

ELSEIF expression2

Statement2

ELSE

Statement3

ENDIF

This command makes a logical decision in more than one condition. If the
expression1 is true, this command executes the Statement1. If the
expression1 is false, it checks if the expression2 is true or not. If the
expression2 is true, it executes the Statement2. If both expression1 and
expression2 are false, it executes the Statement3. For details on the expres-
sion, refer to the Comparison command table.

Example:

If $1 is smaller than 100, executes $1 = $1 + 1. If $1 is 100 or above, executes
$1 = $1 + 10.

IF $1 < 100

$1 = $1 + 1

ELSE

$1 = $1 + 10

ENDIF

FCMP

Compares the data and stores the result

Equation: Var1 = FCMP(Var2, Var3)[(Signed DW)]

This command compares the size of Var2 and Var3. Then it stores the result
in Var1.

■ Flow Control

There are five types for flow control, which include GOTO, LABEL,
CALL..RET, FOR...NEXT and END.

Var2 == Var3 Var2 > Var3 Var2 < Var3

Result to be stored 0 1 2
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GOTO

Goes to a specific Label without condition

Equation: GOTO LABEL Var1

When the PT executed the GOTO statement, the process goes to the Label
specified with Var1 and continues to execute the program.

Example:

Goes to the position of specified Label 2 without condition, and continues to
execute the program. 

GOTO LABEL 2

.....

LABEL 2

LABEL

GOTO statement shifts the program execution to the position of LABEL with-
out condition

Equation: LABEL Var1

Note: You cannot use the same label more than one time in a Macro.

Example:

Goes to the position of specified Label 2, and continues to execute the pro-
gram.

GOTO LABEL 2

.....

LABEL 2

.....

If you use more than one Label 2, an error will occur to tell you it is invalid.

LABEL 2

.....

CALL..RET

Calls sub-macro program

Equation: CALL Var1

Var1 is the sub-macro number. The sub-macro number can be 001 to 512.
Var1 must be internal memory address or constant.

When the CALL command is executed, the process shifts to the sub-macro. If
the RET command is executed in the sub-macro program, the process returns
to the CALL source of the sub-macro. If there is not a RET command, after all
commands in the called sub-macro are executed, the RET command is auto-
matically executed. In the sub-macro program, you can also call other sub-
macro. But to keep sufficient memory, the levels for CALL sub-macro must be
less than 6 levels.

FOR...NEXT

Program Loop

Equation:
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FOR Var1

Statement

NEXT

You can use this command for nested loops. FOR is the start of the loop and
NEXT is the end of the loop. A maximum of five nested loops is possible. Var1
can be the internal memory or constant. When the PT executes this com-
mand, this command executes the number of times specified with Var1 State-
ment continuously. In the Statement, you can write a macro command that the
PT executes again and again. You can change Var1 value in the Statement,
but cannot change the number of times.

Example:

$10 = 10

$1 = 0

FOR $10

$1 = $1 + 1

$10 = 2

NEXT

After the operation, the result is $1 = 10, $10 = 2. 

Note: You cannot change the loop times even when you reset the value in
$10.

END

Ends the macro 

Equation:

Statemenets1

END

Statements2

This command ends the macro program. It executes the Statemenets1 and
then ends the macro executing. It does not execute the Statements2. If there
is END command in sub-macro, the program ends here.

Example:

$1 = 10

$1 = $1 + 1

END

$1 = $1 + 1

After the operation, the result is $1 = 11, not $1 = 12 as the END command
ended the macro program. 

■ Bit Setting

There are four BIT settings, which include BITSET, BITCLR, BITINV and BIT-
GET.

Bit setting command table

Command Equation Description

BITSET BITSET Var1 Sets Var1 bit to be ON.

BITCLR BITCLR Var1 Sets Var1 bit to be OFF.
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BITSET

Sets specified bit to be ON

Equation: BITSET Var1

This command sets Var1 bit to be ON

Example:

Sets 1 in the bit 0 in the internal memory $0.

$0 = FFFEH

BITSET $0.0

The result → $0 = FFFFH

BITCLR

Sets specified bit to be OFF

Equation: BITCLR Var1

This command sets Var1 bit to be OFF

Example:

Sets 0 in the bit 0 in the internal memory $0.

$0 = FFFFH

BITCLR $0.0

The result → $0 = FFFEH

BITINV

Sets specified bit to be reversed. ON a OFF, OFF a ON

Equation: BITINV Var1

This command sets Var1 bit to be reversed. ON a OFF, OFF a ON

Example:

Inverses the bit 0 in the internal memory $0, and stores it.

$0 = FFFEH

BITINV $0.0

The result → $0 = FFFFH

BITGET

Gets bit value

Equation: Var1 = BITGET Var2

This command gets Var2 bit value, and stores in Var1

Example:

Gets the 3rd bit value in $0, and stores it to the 5th bit in $10.

$0 = FFFEH

$10 = 0

$10.5 = BITGET $0.3

The result → $10 = 20H

BITINV BITINV Var1 Sets Var1 bit to be reversed.

BITGET Var1 = BITGET Var2 Gets Var2 bit value and stores 
in Var1.

Command Equation Description
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■ Communication

Communication command table

Note There are macros that are not synchronized with any screen events, such as
switching screens or pressing a switch: Project Resident Macro, Project Peri-
odic Macro, and Screen Periodic Macro. If communications commands that
access communications buffers (PUTCHARS(), GETCHARS(), or
CLEARCOMBUFFER()) are placed in any of these macros, the communica-
tions buffers may be read or written at unexpected timing. This may conflict
with commands in other macros, causing incorrect data to be read or causing
data to be corrupted by being overwritten. When combining macros that are
not synchronized with any screen events or when combining a macro that is
not synchronized with a screen event with another type of macro, place any
commands that access the communications buffers into one macro. 

INITCOM

After you set each COM port, this command starts communication.

It stores the result in Var1. 

1: Completed normally
0: Failed

INITCOM 

Command Equation Description

INITCOM Var1= INITCOM (Var2) Initial setup COM port

ADDSUM Var1=ADDSUM(Var2, Var3) Uses addition to calculate 
checksum

XORSUM Var1 = XORSUM(Var2, Var3) Uses XOR to calculate check-
sum

PUTCHARS 
(See note.)

Var1 = PUTCHARS(Var2, 
Var3, Var4)

Outputs characters by COM 
port

GETCHARS 
(See note.)

Var1 = GETCHARS(Var2, 
Var3, Var4)

Gets characters by COM port

SELECTCOM SELECTCOM(Var1) Selects COM port

CLEARCOM-
BUFFER (See note.)

CLEARCOMBUFFER(Var1, 
Var2)

Clears COM port buffer

CHRCHKSUM Var1 = CHRCHKSUM(Var2, 
Var3, Var4)

Calculates the ASCII data of 
string, character length and 
checksum.
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Var2 settings in INITCOM 

Flow control

To make sure that data transmit between computer and PT is completed, you
can use Flow Control functions.

ADDSUM

Adds to calculate checksum

Var1=ADDSUM(Var2, Var3)

Var1: Value after calculation

Var2: Starting address for calculation

Var3: Data length

Flow control

No Flow Control This function disables the flow control function.

CTS/RTS This function is a flow control for hardware. It uses handshak-
ing signal to control receiving and sending data. 

DSR/DTR This function is also a flow control for hardware. You can use 
this function to connect a computer and a PT directly by a 
cable. 

XON/XOFF This function is a flow control for software. It creates a control 
code with software and adds the code to the transmission 
data. 

COM port

Data Bit

Parity bit

  Interface

Stop bit

Baud rate
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XORSUM

This command uses XOR to calculate checksum.

Var1=XORSUM (Var2, Var3)

Var1: Value after calculation

Var2: Starting address for calculation

Var3: Data length

PUTCHARS

Outputs characters by COM port

Var1= PUTCHARS (Var2, Var3, Var4). The result will be stored in Var1.

Var1: Response value after communication

1: Completed normally

0: Failed

Var2: Starting address of transmission data

Var3: Data length

Var4: Allowance communication time (unit is ms)
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GETCHARS

Gets characters by COM port

Var1= GETCHARS (Var2, Var3, Var4). The result will be stored in Var1.

Var1: Response value after communication

1: Completed normally

0: Failed

Var2: Starting address of transmission data

Var3: Data length

Var4: Allowance communication time (unit is ms). 

SELECTCOM

Selects COM port

If you do not connect the PLC (if you set the Protocol to NULL in PT Menu −
PT Setting), you can use two COM ports (0:COM1, 1:COM2) at the same
time. 

Note After the PT executes this command, the PT executes all communication
commands through the specified COM port. Other macros do not affect each
other, even if the PT uses a different macro.
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CLEARCOMBUFFER

Clears the COM port buffer

Equation: CLEARCOMBUFFER(Var1, Var2)

Var1: The number of communication ports. Constant 0(COM1) or 1(COM2).

Var2: The type of buffer area. Constant 0 (receiving buffer area) or 1 (sending
buffer area)

Example:

Clears the sending buffer area of COM2

CLEARCOMBUFFER(1, 1)

CHRCHKSUM

Calculates the ASCII data of the string, character length and checksum.

Equation:Var1 = CHRCHKSUM(Var2, Var3, Var4)
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Var1: The internal memory address where the character length of ASCII data
of Var2 + data length of checksum is stored.

Var2: The string of text.

Var3: The internal memory address where the ASCII data of Var2 and check-
sum is stored.

Var4: The data length of the checksum that stores in Var3. 1 represents byte
and 2 represents word.

Operation of checksum:

Converts format of each data characters to ASCII code and adds them up. For
example, when '1' is converted to ASCII code '31H' and '4' is converted to
ASCII code '34H', the checksum is 31H + 34H = 65H.

Example:

Calculates the ASCII data of 14, data length and checksum.

$0 = CHRCHKSUM(“14”, $10, 2)

After the above operation, it stores 4 in $0. 4 represents that 2 bytes (ASCII
data length) + 2 bytes (data length of checksum) = 4 bytes. The checksum
that is stored in $10 is 65H.

■ Others

TIMETICK

Gets the time from system startup to present, and saves into the specified
address.

The time unit is 100ms.

GETLASTERROR

Gets the last error value

If there is no error, the result of GETLASTERROR is 0. Even if each Macro is
executed at the same time, the error message does not affect the macro. For
details on error code, refer to 6-5-4 Error Messages.

Command Equation Description

TIMETICK Var1 = TIMETICK Gets the time from system 
startup to present

GETLASSERROR Var1 = GETLASTERROR Gets last error value

# #Var1 Comment

DELAY DELAY Var1 System delay

GETSYSTEMTIME Var1 = GETSYSTEMTIME Gets system time

SETSYSTEMTIME SETSYSTEMTIME(Var1) Sets system time

GETHISTORY Var1 = GETHISTORY (Var2, 
Var3, Var4, Var5, Var6)

Gets history data
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COMMENT

Inserts macro descriptions 

Macro descriptions make the operations clear. This command does not have
an effect on the Macro function. To change the equation to be a comment, put
“#” symbol in front of the equation. The comment starts from “#” symbol and
ends at the end of the sentence. To change the comment to be equation,
remove the “#” symbol.

DELAY

Delays the user setting time by system

Delay can occur because of the structure of the NP-series PTs. The unit of
delay time is ms.

GETSYSTEMTIME

Gets system time

Equation: Var1 = GETSYSTEMTIME
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Var1 is the starting address of continuous 7 Words in the internal memory
address.

Var1 Year

Var1 + 1 Month

Var1 + 2 Date

Var1 + 3 Week

Var1 + 4 Hour

Var1 + 5 Minute

Var1 + 6 Second

Example:

Now the system time is 2008/01/09 Wed 09:26:25. This command gets the
current system time, and stores it in $1 to $7.

$1 = GETSYSTEMTIME

Gets $1 = 2008, $2 = 01, $3 = 9, $4 = 3, $5 = 9, $6 = 26, $7 = 25

SETSYSTEMTIME

Sets system time

Equation: SETSYSTEMTIME(Var1)

Var1 is the starting address of continuous 7 words in the internal memory
address.

Var1 Year

Var1 + 1 Month

Var1 + 2 Date

Var1 + 3 Week

Var1 + 4 Hour

Var1 + 5 Minute

Var1 + 6 Second

Example:

Sets the current system time as 2008/01/09 Wed 09:26:25.

$1 = 2008

$2 = 1

$3 = 9

$4 = 3

$5 = 9

$6 = 26

$7 = 25

SETSYSTEMTIME($1)

GETHISTORY

Gets history data

Equation: Var1 = GETHISTORY (Var2, Var3, Var4, Var5, Var6)

Var1: Specify the internal memory address where the data length is stored.

Var2: Use the internal memory or constant to specify the logging buffer
number.
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Var3: Use the internal memory address or constant to decide which number
of logged data is stored. Specify the number 1, 2, 3,..., (logging
points).

Var4: Use the internal memory or constant to specify points for reading.

Var5: Use the internal memory or host address to specify a starting address
for saving data.

Var6: Use the internal memory or constant to specify a data type to read.

0: Data, 1: Time, 2: Time and Data

6-5-4 Error Messages
The Output Window shows errors after validation. 

■ Error Messages While You Edit

Code − 100: LABEL cannot be found

There is no LABEL that GOTO specifies. 

Code − 101: Recursion occurs

This error message usually shows in sub-macro. The function of a sub-macro
to call is called recursion whether the PT calls it directly or not. The sub-macro
does not usually use recursion. As an alternative for it, you can use GOTO or
FOR (infinite times).

Code − 102: More than 3 nested FOR is used

This error message tells you not to use more than 3 nested FOR commands
to keep sufficient memory. As an alternative for it, you can use GOTO or IF.

Code − 103: Sub-macro does not exist

This error message tells you that there is no sub-macro in the program. For
example, CALL 5 means CALL sub-macro 5. This error message shows when
you do not edit sub-macro 5 in the program. This message shows to make
sure that there are no errors. These errors include input error and absence of
related sub-macro.

Code − 104: Number of NEXT is less than the number of FOR

The number of NEXT and FOR commands must be the same. This error code
shows when the number of NEXT commands is less than that of FOR com-
mands. 

Code − 105: Number of FOR is less than the number of NEXT

The number of FOR and NEXT commands must be the same. This error code
shows when the number of FOR commands is less than that of NEXT com-
mands.

Code − 106: Repeated LABEL

This error message shows to tell you that one macro has the same LABEL
more than one time. It shows during validation. If you use the same LABEL
more than one time, the program does not operate correctly. 

Code − 107: There is RET in Macro

This error message tells you that there is RET command in macro. To return
program, you can use RET command in sub-macro. But in macro, you must
use END.

■ PT Macro Error Messages

The user can read error messages by macro.
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Code − 10: GOTO Error

This message tells you that there is GOTO error in macro. 

Code − 11: Stack Overflow

This message tells you that stack in macro is full. This can occur if you use too
many sub-macros or execute different macros at the same time. This mes-
sage shows to keep sufficient memory.

Code − 12: CALL Empty Sub-macro

This message tells you that there is a CALL sub-macro error. The sub-macro
that is called must not be an empty sub-macro. This message shows to pre-
vent an unexpected error. 

Code − 13: Data Read Error

This message tells you that there is a data read error. This can occur if there
is a memory data error, but usually it occurs if there is a host data read error. 

Code − 14: Data Write Error

This message tells you that there is a data write error. This can occur if there
is a memory data error, but usually it occurs if there is a host data write error. 

Code − 15: Divisor is 0

This error message tells you that the divisor is 0 when you do division opera-
tion. 

■ PT Communication Error Messages

Communication Busy

Error Message: Com x Station x: Communication Busy ...

Unknown Code

Error Message: Com x Station x: Receive Unknown Code ...

No Response from Controller

Error Message: Com x Station x: Controller No Response ...

PT CheckSum Error

Error Message: Com x Station x: Check Sum Error in PT Message ...

Controller CheckSum Error

Error Message: Com x Station x: Check Sum Error in Controller Message ...

Incorrect Command

Error Message: Com x Station x: Command Can Not be Executed ...

Incorrect Address

Error Message: Com x Station x: Address Fault ...

Incorrect Value

Error Message: Com x Station x: Value is Incorrect ...

Controller is Busy

Error Message: Com x Station x: Controller is Busy ...

CTS Signal Fail

Error Message: Com x Station x: CTS Signal Fail ...

No Such Resource in Controller

Error Message: Com x Station x: No Such Resource ...
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No Such Service in Controller

Error Message: Com x Station x: No Such Service ...

Must Retry

Error Message: Com x Station x: Must Retry ...

PT Station Number Error

Error Message: Com x Station x: PT Station Number Error ...

Controller Station Number Error

Error Message: Com x Station x: Controller Station Number Error ...

UART Communication Error

Error Message: Com x Station x: UART Communication Error ...

Other Communication Error

Error Message: Comx Station x: Other Communication Error ...
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6-6 Control Block and Status Block

6-6-1 Control Block
When you set the host address and size in Control Block, the host can control
an NP-series PT. The control area consists of continuous word addresses.
The length is between 0 and 8 words. The length can change if the function
that you use on screen data changes. For example, for the Data Log function,
a minimum of 5 words is necessary. When the size of Control Block is 0, the
Control Block function is disabled. When the Control Block function is
enabled, the host can control the PT. For details on settings, refer to 6-6-3
Settings.

This table shows functions and gives explanations of each word. 

■ Address for Designating Screen Number (SNIR)

When you write a screen number to SNIR, the NP screen changes to that
number. This function allows the NP display screen to be changed from the
host. Specify the numerical value storage format in signed decimal, unsigned
decimal, hexadecimal, or binary.

When opening or closing a pop-up screen, write 0 to SNIR. 

■ Control Flag Address (CFR)

Enable/Disable Communication

Bit 0 controls the PT communications. When bit 0 is turned ON, the PT com-
munication is disabled. When bit 0 turns OFF, the PT communication is
enabled.

Word Address Offset

0 Address for Designating Screen Number (SNIR) +0

1 Control Flag Address (CFR) +1

2 Curve Control Address (CUCR) +2

3 Address for Sampling Data Log Buffer (HBSR) +3

4 Address for Clearing Data Log Buffer (HBCR) +4

5 Data Block Control Address (RECR) +5

6 Address for Designating Data Block Group Number 
(RBIR) 

+6

7 System Control Flag Address (SCFR) +7

Word Function

0 Designate Screen Number 

Word Function

0 Enable/Disable Communication 

1 Turn ON/Turn OFF Backlight

2 Sound the Siren

3 Clear Alarm Buffer

4 Clear Alarm Counter

5 to 7 Reserved

8 Set User Security Level (bit 0)

9 Set User Security Level (bit 1)

10 Set User Security Level (bit 2)

11 to 15 Reserved 
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Turn ON/Turn OFF Backlight

Bit 1 controls the PT backlight. When bit 1 is turned ON, the PT backlight
turns OFF. When bit 1 turns OFF, the PT backlight turns ON.

Sound the Siren 

Bit 2 controls the PT siren. When bit 2 is turned ON, the siren starts. When bit
2 is turned OFF, the siren stops.

Clear Control Flag for Alarm Buffer 

Bit 3 clears the alarm buffer. When bit 3 is turned ON, the alarm buffer is
cleared. To control the alarm buffer again, this flag must be turned OFF and
then ON.

Clear Control Flag for Alarm Counter 

Bit 4 clears the alarm counter. When bit 4 is turned ON, the alarm counter is
cleared. To control the alarm counter again, this flag must be turned OFF and
then ON.

Set User Security Level 

Bits 8 to 10 set the PT user security level. The level is from 0 to 7. MSB is Bit
10, and LSB is Bit 8. The default level is the Starting Level set with the PT
Setting Dialog Box. 

If the security level of an object is higher than the current security level, the
user must enter a password. The security level will then change to the higher
level. The user can thus use all objects with a security level that is lower than
or equal to this new user security level. 

If the user changes to the system menu and back to the application, the user
security level goes back to the default level.

■ Curve Control Address (CUCR)

Curve Sampling Control Flag (1-4) 

Bits 0 to 3 control the curve (Broken-Line or XY Distribution) sampling. 

When this control flag (Bit 0 to Bit 3) is turned ON, the PT reads continuous
data from the set host address to sample once, changes the data to graph
and shows it on PT screen. To control it again, this flag must be turned OFF
and then ON.

Curve Clear Control Flag (1-4) 

Bits 8 to 11 clear the curve (Broken-Line or XY Distribution) when this control
flag (Bit 8 to Bit 11) is turned ON. To clear it again, this flag must be turned
OFF and then ON.

Bit Function

0 Curve Sampling Flag 1

1 Curve Sampling Flag 2

2 Curve Sampling Flag 3

3 Curve Sampling Flag 4

4 to 7 Reserved

8 Curve Clear Flag 1

9 Curve Clear Flag 2

10 Curve Clear Flag 3

11 Curve Clear Flag 4

12 to 15 Reserved
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■ Address for Sampling Data Log Buffer (HBSR) 

The NP-series PT has 12 bits that control the sampling address of data log
buffer. These bits not only sample on the Sampling Cycle specified in Data
Log Setting Dialog Box of the NP-Designer, but also sample or clear the data
log buffer through the host. For details on the settings of sampling data log
buffer, refer to Data Log Setting of 6-2-4 PT Menu.

Control Flag Address for Sampling Data Log Buffer 

Bits 0 to 11 control the sampling data log buffer operation of PT by the host.
When this control flag (Bit 0 to Bit 11) is turned ON, the PT samples one time.
To control the flag again, this flag must be turned OFF and then ON.

■ Address for Clearing Data Log Buffer (HBCR)

Clear Flag of Data Log Buffer 

Bits 0 to 11 clear the PT data logs. When the control flag (Bit 0 to Bit 11) is
turned ON, it clears the PT data logs. To control this flag again, this flag must
be turned OFF and then ON.

■ Data Block Control Address (RECR)

Bit Function

0 Control Flag for Sampling Data Log Buffer 1

1 Control Flag for Sampling Data Log Buffer 2

2 Control Flag for Sampling Data Log Buffer 3

3 Control Flag for Sampling Data Log Buffer 4

4 Control Flag for Sampling Data Log Buffer 5

5 Control Flag for Sampling Data Log Buffer 6

6 Control Flag for Sampling Data Log Buffer 7

7 Control Flag for Sampling Data Log Buffer 8

8 Control Flag for Sampling Data Log Buffer 9

9 Control Flag for Sampling Data Log Buffer 10

10 Control Flag for Sampling Data Log Buffer 11

11 Control Flag for Sampling Data Log Buffer 12

12 to 15 Reserved

Bit Function

0 Clear Flag of Data Log Buffer 1

1 Clear Flag of Data Log Buffer 2

2 Clear Flag of Data Log Buffer 3

3 Clear Flag of Data Log Buffer 4

4 Clear Flag of Data Log Buffer 5

5 Clear Flag of Data Log Buffer 6

6 Clear Flag of Data Log Buffer 7

7 Clear Flag of Data Log Buffer 8

8 Clear Flag of Data Log Buffer 9

9 Clear Flag of Data Log Buffer 10

10 Clear Flag of Data Log Buffer 11

11 Clear Flag of Data Log Buffer 12

12 to 15 Reserved

Bit Function

0 Control Flag for Changing Data Block Group Number 

1 Control Flag for Reading Data Block (Host → PT)
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Control Flag for Changing Data Block Group Number 

Bit 0 specifies the data block group number (RCPNo).

To specify it,

1,2,3... 1. Write the data block group number (N) to Designated Data block Group
Number Address (RBIR), and

2. Turn ON this control flag (Bit 0).

After the above settings, the RCPNo changes to N automatically. 

To control it again, this flag must be turned OFF and then ON.

Control Flag for Reading Data Block (Host → PT)

Bit 1 reads the data block from the host and stores the data block in the spec-
ified area of PT.

To read and store the data block,

1,2,3... 1. Specify the data block group number (N).

2. Turn ON this control flag (Bit 1).

To control it again, this flag must be turned OFF and then ON.

Control Flag for Writing Data Block (PT → Host)

Bit 2 writes the data block to the host.

To write it,

1,2,3... 1. Specify the data block group number (N). (Refer to the Control flag for
changing data block group number above)

2. Turn ON the control flag (bit 2).

To control it again, this flag must be turned OFF and then ON.

■ Address for Designating Data Block Group Number (RBIR)

When the Control Flag for Changing Data Block Group Number is turned ON
to write the data block group number (N) into Address for Designating Data
Block Group Number (RBIR), the RCP No changes.

■ System Control Flag Address (SCFR)

2 Control Flag for Writing Data Block (PT → Host)

3 to 15 Reserved 

Bit Function

Word Function

0 Designate Data Block Group Number

Bit Function

0 Multi-language Setting Value (bit 0)

1 Multi-language Setting Value (bit 1)

2 Multi-language Setting Value (bit 2)

3 Multi-language Setting Value (bit 3)

4 Multi-language Setting Value (bit 4)

5 Multi-language Setting Value (bit 5)

6 Multi-language Setting Value (bit 6)

7 Multi-language Setting Value (bit 7)

8 to 15 Reserved
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■ Multi-language Setting Value

Bits 0 to 7 store the designated multi-language setting value. They also com-
mand the PT to switch to the specified language of a value that the user sets
in this address. The setting range is between 0 and 255. MSB is bit 7, and
LSB is bit 0.

Note: If the user set a value that is not in the multi-language setting, the multi-
language state does not change. The state before the value is set remains.

6-6-2 Status Block
When you set the address in Status Block, the host can read the status of
NP-Series PT. If the size of Control Block is 0, the Control Block function is
disabled. When the Control Block function is disabled, the Status Block
function is also disabled. When the Status Block function is enabled, the host
reads the PT status. For details on settings, refer to 6-6-3 Settings.

This table shows functions and gives explanations of each word.

■ Status Address for General Control (GCSR)

Screen Switch Status 

When the PT switches the screen, bit 0 is turned ON. After the screen switch
is completed, bit 0 is turned OFF.

Clear Status of Alarm Buffer

When the PT clears the alarm buffer, bit 3 is turned ON. After this function is
completed, bit 3 is turned OFF.

Word Address Offset

0 Status Address for General Control (GCSR) +0

1 Status Address for Screen Number (SNSR) +1

2 Status Address for Curve Control (CCSR) +2

3 Status Address for Sampling Data Log Buffer 
(HSSR)

+3

4 Status Address for Clearing Data Log Buffer 
(HCSR)

+4

5 Data Block Status Address (RESR) +5

6 Status Address for Data block Number 
(RBSR)

+6

7 Status Address 2 for General Control 
(GCSR2)

+7

Bit Function

0 Screen Switch Status 

1 to 2 Reserved

3 Clear Status of Alarm Buffer 

4 Clear Status of Alarm Counter 

5 to 7 Reserved

8 User Security Level Status (bit 0)

9 User Security Level Status (bit 1)

10 User Security Level Status (bit 2)

11 to 15 Reserved
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Clear Status of Alarm Counter

When the PT clears the alarm counter, bit 4 is turned ON. After this function is
completed, bit 4 is turned OFF.

User Security Level Status 

Bits 8 to 10 hold the current user security level (0 to 7). MSB is bit 10, and
LSB is bit 8. 

■ Status Address for Screen Number (SNSR)

The last Open Screen Number

This address stores the last screen number you opened. When the user
switches the screen, word 0 stores the last screen or pop-up screen that the
users opened.

■ Status Address of Curve Control (CCSR)

Curve Sampling Status Flag

When the PT samples a curve or XY distribution, the curve sampling status
flag (bits 0 to 3) is turned ON. After the sampling operation is completed, the
curve sampling status flag is turned OFF. 

Curve Clear Status Flag

When the PT clears a curve or XY Distribution, the curve clear status flag (bits
8 to 11) is turned ON. After the clear operation is completed, the curve clear
status flag is turned OFF. 

Bit
User 
Security 
Level 

Bit 8 Bit 9 Bit 10

0 OFF OFF OFF

1 ON OFF OFF

2 OFF ON OFF

3 ON ON OFF

4 OFF OFF ON

5 ON OFF ON

6 OFF ON ON

7 ON ON ON

Word Function

0 The Last Open Screen Number

Bit Function

0 Sampling Status of Curve 1

1 Sampling Status of Curve 2

2 Sampling Status of Curve 3

3 Sampling Status of Curve 4

8 Clear Status of Curve 1

9 Clear Status of Curve 2

10 Clear Status of Curve 3

11 Clear Status of Curve 4

4 to 7, 12 to 15 Reserved
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■ Status Address for Sampling Data Log Buffer (HSSR)

Sampling Data Log Buffer Status Flag 

When the PT samples the data log buffer, the sampling data log buffer status
flag (bits 0 to 11) is turned ON. After the sampling operation is completed, the
sampling data log buffer status flag is turned OFF. 

■ Status Address for Clearing Data Log Buffer (HCSR)

Clear Data Log Buffer Flag 

When the PT clears data log buffer, the clear data log buffer status flag (bits 0
to 11) is turned ON. After the clearing operation is completed, the clear data
log buffer status flag is turned OFF. 

■ Data Block Status Address (RESR)

Bit Function

0 Sampling Status of Data Log Buffer 1

1 Sampling Status of Data Log Buffer 2

2 Sampling Status of Data Log Buffer 3

3 Sampling Status of Data Log Buffer 4

4 Sampling Status of Data Log Buffer 5

5 Sampling Status of Data Log Buffer 6

6 Sampling Status of Data Log Buffer 7

7 Sampling Status of Data Log Buffer 8

8 Sampling Status of Data Log Buffer 9

9 Sampling Status of Data Log Buffer 10

10 Sampling Status of Data Log Buffer 11

11 Sampling Status of Data Log Buffer 12

12 to 15 Reserved

Bit Function

0 Clear Status of Data Log Buffer 1

1 Clear Status of Data Log Buffer 2

2 Clear Status of Data Log Buffer 3

3 Clear Status of Data Log Buffer 4

4 Clear Status of Data Log Buffer 5

5 Clear Status of Data Log Buffer 6

6 Clear Status of Data Log Buffer 7

7 Clear Status of Data Log Buffer 8

8 Clear Status of Data Log Buffer 9

9 Clear Status of Data Log Buffer 10

10 Clear Status of Data Log Buffer 11

11 Clear Status of Data Log Buffer 12

12 to 15 Reserved

Bit Function

0 Change Status of Data Block Number 

1 Data Block Read Status (Host → PT) 

2 Data Block Write Status (PT → Host) 

3 to 15 Reserved



222

Control Block and Status Block Section 6-6

Change Status of Data Block Number Flag

When the host changes the data block number, the change status of data
block number flag (bit 0) is turned ON. After the PT changes the data block
number and updates the RCPNo value, the change status of data block num-
ber flag is turned OFF. 

Data Block Read Status Flag

When the PT reads one data block data from the host, the data block read
status flag (bit 1) is turned ON. When the PT reads and saves the data block
data fully, the data block read status flag is turned OFF. 

Data Block Write Status Flag

When the PT sends one data block data to the host, the data block write sta-
tus flag (bit 2) is turned ON. When the PT sends and writes the data block
data to the host fully, the data block write status flag is turned OFF. 

■ Status Address for Data Block Number (RBSR)

When the host or PT changes the data block number address (RCPNo), the
PT also updates the Status Address for Data Block Number (RBSR). To know
the current data block number, this Status Address for Data Block Number
(RBSR) must be monitored.

■ Status Address 2 for General Control (GCSR2)

Multi-language Status Value

Bits 0 to 7 read the current language that the PT shows from the multi-lan-
guage status value.

Note: The PT stores the Value in the Screen Data Multi-Language Field.
(PT Menu − PT Setting − Multi-Language Tab − Screen Data Multi-Lan-
guage Field)

Word Function

0 Current Data Block Number

Bit Function

0 Multi-language Status Value (bit 0)

1 Multi-language Status Value (bit 1)

2 Multi-language Status Value (bit 2)

3 Multi-language Status Value (bit 3)

4 Multi-language Status Value (bit 4)

5 Multi-language Status Value (bit 5)

6 Multi-language Status Value (bit 6)

7 Multi-language Status Value (bit 7)

8 to 15 Reserved
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6-6-3 Settings
To control the PT and read the status, you must make these settings.

1,2,3... 1. Select PT Setting from PT Menu. The PT Setting Dialog Box shows.

2. Select Standard Tab Page. 

3. Specify a starting address and size in the Control Block Field. 

4. Specify a starting address in the Status Block Field.
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6-7 Internal Memory
■ Internal Address (R/W): $

Word access: $n (n: 0 to 65535)

Bit access: $n.b (n: 0 to 65535, b: 0 to 15)

The NP-series PT has 65536 16-bit internal addresses ($0 to $65535).

■ Non-volatile Internal Address (R/W): $M

Word access: $Mn (n: 0 to 1023)

Bit access: $Mn.b (n: 0 to 1023, b: 0 to 15)

The NP-series PT has 1024 16-bit non-volatile internal addresses ($M0 to
$M1023).

■ Indirect Address (R/W): *$

Word access: *$n (n: 0 to 65535)

The indirect address is an area where an address is stored. The user must
get the address from $n, and then get the value stored in this address.

*$n = 

For example, if $n = m; $m = X; then *$n = X. The value of m must not be
more than 65535.

■ Data Block Number Address (R/W): RCPNO

You can specify the data block group. The minimum data block group number
must be 1. When you edit the data block, you set the maximum group number.
When you upload/download data to the PT or PLC, the PT or PLC uses the
setting of data block number address to read/write the data of data block
group. When you edit the data block, you set the size of each group of data
block. The NP-series PT has a space of 64k words for the data block.

■ Data Block Address (R/W): RCP

The data block size is L and the data block group number is N.

Word access: RCPn (n: 0 to NxL+(L-1))

Bit access: RCPn.b (n: 0 to NxL+(L-1), b: 0 to 15)

The data block address saves the data block that you uploaded from the PT
after you exit the NP-Designer.

There are two methods to read/write these addresses:

Assume that the set data block size is L and the data block group number is
N:

Use one of two methods below to access data that are set with data block.

1. Use RCPNO and RCP0 to RCP(L-1)

2. Use the equation: RCP{n×L+(m-1)}

Example of how to access data:

Setting the size L to 2 and the number of groups N to 3 with the data block.

$n m 

X 
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The data block size L is 2. Thus the data for RCPNO value will be stored in the
RCP0 and RCP1, which are the first two addresses from the starting data
block address.

The value of RCPNO is 1

Data of the group number 1 is stored.

The value of RCPNO is updated to 3. 

The value of data block address will be updated to data of the group number
3.

Data will be stored in the data block address of RCP2 or later as follows.

Data of the mth word of nth data block will be stored in RCP{n×L+(m-1)}. 

Thus data “55” (the first word of the group number 3) will be stored in
RCP{3×2+(1-1)}=RCP6.

Use one of the methods below to change data “55” of the first word of group
number 3.

1. Set the value of RCPNO to 3. Then change the value of RCP0.

2. Change the value of RCP6.

Data Block Address RCP0 RCP1

Data 11 22

Data Block Address RCP0 RCP1

Data 55 66

Data Block Address RCP2 RCP3 RCP4 RCP5 RCP6 RCP7

Data 11 22 33 44 55 66
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SECTION 7
Maintenance and Troubleshooting

This section describes the maintenance and inspection methods for preventing errors occurring, and troubleshooting
measures when errors occur in the PT. 

7-1 Maintenance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228
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7-4 Requesting a Replacement PT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 237
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7-1 Maintenance 
Perform maintenance operations to maintain the PT in optimum condition. 

Backing up Project 
Data

Always create a backup of project data and store it in a safe place when the PT
malfunctions and needs to be sent out for repair, or when replacing the PT.

Spare PTs Prepare a spare PT to allow quick recovery of the system at such times as when
the PT malfunctions, or the service life of the backlight has expired causing poor
screen visibility.

Backlight The backlight must be replaced when the brightness of the display backlight dims
and the display becomes difficult to see. The backlight cannot be replaced by the
user.

Contact your nearest OMRON representative.

Backlight 
Replacement 
Guidelines

Replace the backlight according to the following guidelines under normal condi-
tions.

After 50,000 hours of using NP5 at room temperature and humidity, (or after
approximately 40,000 hours if an NP3 is used. (when the luminous intensity is
decreased by 40% per LED))

The service life of the backlight will be especially shortened if used in a low-tem-
perature environment. Replace the backlight when the brightness dims and the
display becomes difficult to see.

Replacing the 
Battery

Use a lithium battery to back up data other than screen data, such as calendar,
clock, and log data. 

The battery service life is approximately five years at 25°C. The service life will be
shortened if the battery is used at higher temperatures. After backing up the data,
replace the battery periodically, according to the operating environment.

Keep a spare battery available, so that the battery can be replaced immediately
when required. 

Battery Models 

! WARNING

After the NP-series PT has been installed, qualified 
personnel must confirm the installation, and must con-
duct test operations and maintenance. 
The qualified personnel must be qualified and autho-
rized to secure safety at each phases of design, instal-
lation, running, maintenance, and disposal of system.

Do not dismantle, repair, or modify the product. Doing 
so may lead to loss of safety functions.

The backlights of PTs cannot be replaced by the user. Contact your 
nearest OMRON representative.

Precautions 
for Safe Use

Manufacturer Model

OMRON CJ1W-BAT01
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Replacement 
Guidelines 

The guidelines for replacing the battery are as follows: 

• Replace when five years have lapsed since a new battery was installed in the
PT. 
Replace when a message of battery replacement is displayed on the PT.

Replacement Method Perform the following procedure to replace the battery. 

Prepare a new battery.

1,2,3... 1. Open the System Menu. Press the Setting - Backup.

2. Turn OFF the power to the PT. 

3. Open the battery cover on the rear panel of the PT.

4. Remove the battery that is secured inside the PT, grasp the cable, and pull the
connector out to remove it.

5. Connect the new battery connector, and insert the battery into the battery hold-
er in the battery cover.
Make sure that the lead wire of the battery is placed to contact the upper side
of the holder as shown in the Figure 2.

6. Close the battery cover, being careful not to squash the battery cable.

Figure 1

Figure 2
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The following data will 
be saved.

• Password

• Brightness and contrast

• Refresh rate

• Buzzer

• Screen Saver Time

• Startup delay time

• Default language

• PT internal memory

• Communication parameter

Backup data will be restored automatically after replacing the battery.
Precautions 
for Correct Use

• Never use batteries that have been subjected to a severe shock, such 
as being dropped on the ground. Batteries subjected to shock may 
leak. 

• When mounting the battery, be sure to use the correct battery and 
mount it correctly.

• If the battery is removed, the data stored in the PT will be deleted.
• Do not attempt to disassemble or short-circuit the battery. 

Precautions 
for Safe Use



231

Inspection and Cleaning Section 7-2

7-2 Inspection and Cleaning 
Clean and inspect the PT periodically to maintain it in optimum condition for use. 

Cleaning Methods The screen visibility will be impaired if the display becomes dirty. Clean the display
periodically using the following methods: 

• For daily cleaning, wipe with a soft, dry cloth. Attempting to remove heavy dirt
with the cloth may scratch the front panel sheet. Use a damp cloth and wipe
the surface again to remove dirt. 

• If dirt cannot be removed using a dry cloth, dampen the cloth sufficiently with
a neutral cleaning agent solution (approximately 2%), squeeze the cloth out,
and then wipe the surface. 

• Materials such as rubber, vinyl, or tape that are attached to the PT will leave
stains if left for a long time. If such material is attached to the PT, remove
when cleaning. 

Inspection 
Methods 

Inspect the PT once every six to twelve months. Shorten the interval between
inspections when using the PT in extreme conditions, such as under high temper-
atures, high humidity, or environments subject to large quantities of dust. 

Inspection Items Inspect the PT for the following items to check whether the PT is operating within
the specified criteria. If the PT is outside the criteria, use measures such as
improving the operating environment to conform to the standards, or tightening
screws. 

! WARNING

After installing the NP-series PT, qualified personnel 
must confirm the installation, and must conduct test 
operations and maintenance. 
The qualified personnel must be qualified and autho-
rized to secure safety at each phases of design, instal-
lation, running, maintenance, and disposal of system.

Never use benzene, thinner, or other volatile solvents, or chemical
cloths to clean the PT. 

Precautions 
for Safe Use

Inspection 
items 

Inspection details Criteria Inspection means 

Power supply Power terminal voltage 
fluctuation 

Allowable voltage range 
(24 VDC −10% to +15%) 

Tester 

Ambient envi-
ronment 

Ambient temperature 
(temperature in con-
trol panel) 

0 to 50°C 
(Refer to Appendix A 
Specifications.) 

Thermometer

Ambient humidity 
(temperature in con-
trol panel) 

35% to 85% RH 
(Refer to Appendix A 
Specifications.) 

Temperature meter 

Presence of dust No dust accumulated. Visual inspection 

Presence of oil No oil between front 
panel sheet and molding. 

Visual inspection 
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Mounting con-
ditions 

Looseness of fixed 
mounting bracket 

Specified torque. Phillips screwdriver 

Connection status of 
Connecting Cable 
Connectors 

Fully inserted, locked, 
and with No looseness.

Phillips screwdriver 

Looseness of external 
wiring screws 

No looseness. Phillips screwdriver 

Status of external con-
necting cables 

No breaks or other dam-
age 

Visual inspection, 
tester 

Parts with lim-
ited service life 

Backlight brightness Sufficient brightness. 
Backlight life of NP5 (at 
room temperature of 
25°C) is 50,000 hours, 
NP3 is 40,000 hours 
(when the luminous 
intensity is decreased by 
40% per LED) as a 
guideline.

Visual inspection 

Battery 5 years (at room temper-
ature of 25°C).

Replace every 5 
years 

Inspection 
items 

Inspection details Criteria Inspection means 

• Do not disassemble, repair, or modify the PT. 
• Follow all local government regulations, where applicable, when dis-
posing of the PT and used batteries. 

• The Unit may not be usable in locations subject to long-term exposure 
to oil or water. The gasket will deteriorate after long-time use. Inspect 
the gasket on a regular basis. If deterioration is found, contact your 
OMRON representative. 

Precautions 
for Safe Use
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7-3 Troubleshooting 
This section describes countermeasures for errors.

7-3-1 Errors
If an error occurs during PT operation, find the symptoms of the error on the fol-
lowing table and then perform the suggested countermeasures. 

Errors during Data Transfer

Errors at PT Startup

Check that the system is safe before turning the power ON/OFF.

Do not dismantle, repair, or modify NP-series PTs. 
Precautions 
for Safe Use

Symptoms Cause Possible countermeasure

Cannot exe-
cute serial data 
transfer.

Not connected to 
NP-Designer. 

Check the connection cable wiring. (Refer to 3-3 
Connecting the NP-Designer)

The transfer setting 
of NP-Designer is 
set to USB.

Set the Transfer Setting to PC COM Port in Option 
Dialog Box from Tools Menu of the NP-Designer.

The PT is not in the 
transfer mode.

Set the PT to the transfer mode. (Refer to SEC-
TION 4 System Menu.)

Personal com-
puter cannot 
detect PT when 
connected via 
USB.

A malfunction has 
occurred due to 
external noise.

Configure the USB Hub and wire the USB cables 
taking measures to prevent noise.

Timeout occurs 
during screen 
transfer using 
USB.

The transfer setting 
of NP-Designer is 
set to PC COM 
port.

Set the Transfer Setting to USB in Option Dialog 
Box from Tools Menu of the NP-Designer.

A malfunction has 
occurred due to 
external noise.

Configure the USB Hub and wire the USB cables 
taking measures to prevent noise.

Open File Fail 
was displayed 
on the PT.

No USB flash mem-
ory is connected to 
the PT even though 
saving data to USB 
flash memory was 
specified.

Connect USB flash memory to the PT or change 
the PT settings from the NP-Designer to save data 
to SRAM rather than USB flash memory.

Symptoms Cause Possible countermeasure

Indicators are 
not lit. 

Power not supplied 
to the PT.

Check the connections and supply power correctly 
to the PT. (Refer to 3-1 Installing the PT.) 

Power supply fuse 
broken.

The PT must be repaired. Contact your nearest 
OMRON representative. 

System program 
corrupted. (Fatal 
error.)

The PT may be faulty. Contact your nearest 
OMRON representative. 

The indicator is 
lit green and the 
screen is blank.

Backlight failure. The backlight must be replaced. Contact your 
nearest OMRON representative.
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Errors When Connecting the Host

Errors during PT Operation

Symptoms Cause Possible countermeasure

Cannot con-
nect to host. 
(An error mes-
sage is dis-
played.)

A malfunction has 
occurred due to 
external noise.

Wire the cable according to noise prevention mea-
sures.

Protocol settings for 
the host and PT 
settings do not 
match. 

Use NP-Designer to make communications set-
tings. 

PT and host are not 
connected properly. 

Check that the type of connection cable, the 
length, and the wiring meet the specifications. 
(Refer to 1-2 Communications with the Host) 

For 1:N NT Links, a 
duplicate unit num-
ber has been used. 

With an NP-series PT, only one PT can be con-
nected to each PLC port even if the 1:N NT Link 
protocol is used. Two or more PTs cannot be con-
nected. (Refer to 3-5 Connecting with 1:N NT 
Links)

Symptoms Cause Possible countermeasure

RUN indicator 
does not light. 

Power is not being 
supplied to the PT. 

Check the connections and supply power to the 
PT correctly. (Refer to 3-1 Installing the PT.) 

The fuse is broken. The PT must be repaired. Contact your nearest 
OMRON representative. 

The screen is 
blank.

The screen saver 
function is operat-
ing. 

This is not an error. Touch the screen.

The backlight has 
malfunctioned. 

The backlight must be replaced. Contact your 
nearest OMRON representative. 

The display 
update is slow.

Screen switching or 
opening and closing 
pop-up screens are 
being performed 
frequently. 

If screens are switched, opened and closed fre-
quently, the display update may take some time 
and communications may be delayed.

Adjust the interval between screen switches so 
that the system is not overloaded. 

The touch 
panel does not 
respond.

PT has malfunc-
tioned due to exter-
nal noise. 

Reset the PT, and wire it according to noise pre-
vention measures. 

The touch panel is 
damaged.

If there is an abnormal symptom, contact your 
nearest OMRON representative.

The display is 
dark. 

The brightness set-
ting is too low. 

Increase the backlight brightness in the LCD of 
the System Menu. With some models of NP-series 
PTs, the backlight brightness cannot be adjusted. 
Please check the specifications.

The backlight is 
faulty or its service 
life has expired. 

The backlight must be replaced. Contact your 
nearest OMRON representative. 

Cannot con-
nect to a Pro-
gramming 
Console

Host settings are 
incorrect.

Check the host settings. Use NT Link 1:N (normal 
or high-speed) and set the maximum unit number 
to 0.

Device Not 
Support was 
displayed on 
the PT.

The USB flash 
memory could not 
be detected. 

• Format the USB flash memory in FAT32 format.
• Check to see if the USB flash memory is dam-

aged.
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Errors During Object Operation

7-3-2 Error Messages
If the messages listed on the following table are displayed on the computer, find
the symptoms of the error below and then perform the suggested countermea-
sures.

Troubleshooting Screen Data Transfers between Computer (NP-Designer) and PT
This section describes possible errors during data transfer and their countermea-
sures.

Symptoms Cause Possible countermeasure

The numerical 
and character 
string update is 
slow. 

Communications 
are unstable due to 
external noise. 

Perform noise countermeasures such as separat-
ing communications cables from power lines. 

There are too many 
numeric display, 
numeric input, 
string display and 
string input objects 
in the display. 

Reduce the number of numeric display, numeric 
input, string display and string input objects in the 
screen where update is slow. 

For RS-422A com-
munications, the 
branch is incorrect 
or the terminating 
resistance is not set 
properly. 

Wire correctly, referring to Appendix C Connecting 
to RS-422A/485. 

Some objects in 
the screen are 
not displayed. 

A communications 
error has occurred. 

Check the communications settings. 

The log graph 
display does 
not match the 
actual log tim-
ing. 

The communica-
tions address set 
for the event of log 
timing is turning ON 
and OFF at high 
speed. 

Set the ON/OFF cycle of the communications 
address for events to a longer time. 

Cannot input 
numerical val-
ues.

The numerical 
value input upper 
and lower limit 
check function is 
running. 

 Select Detail in the Property of the input object 
with NP-Designer and check the Minimum and 
Maximum values. Then correct them if necessary.

Cannot input to 
any object. Or 
the function is 
not executed.

A password has 
been set.

Input the password in the password input dialog 
box that is displayed. 

Cannot switch 
to System 
Menu. 

A function that can 
switch a screen to 
System Menu is not 
allocated. 

Use the Function Switch or button to set a function 
that can switch a screen to System Menu.

Message Cause Countermeasure

Incorrect Model 
Name

Models of the 
screen and PT do 
not match.

Check the model with PT Setting Dialog from PT 
Menu of the NP-Designer.

Connection 
failed

Time-out occurs 
while connecting to 
the PT or transfer-
ring.

Check the following.

• Power supply to the PT
• Cable connections
(If this symptom still occurs, exit the application 
and restart the computer and PT. Then connect 
them again.
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NP-Designer Error Messages
This section describes possible errors during screen data editing and their coun-
termeasures. 

No Response 
From PT

• Attempted to 
transfer screen 
data using a 
method different 
from the transfer 
setting.

• When attempted 
to transfer screen 
data through COM 
port, the PT was 
not in a transfer 
mode.

• The SW1 slide 
switch on the back 
of the PT is turned 
ON.

• The PT is busy.

• Check the transfer setting in the Option Dialog 
from Tools Menu of the NP-Designer. 

• To transfer screen data through COM Port, the 
PT must be in a transfer mode. (Refer to SEC-
TION 4 System Menu)

• Turn OFF SW1 slide switch on the back of the PT 
before transferring screen data.

• Restart the PT and transfer screen data.

Transmission 
aborted

Time-out occurs 
while connecting to 
the PT or transfer-
ring. 

Check the following.     

• Power supply to the PT     
• Cable connections (If this symptom still occurs, 

exit the application and restart the computer 
and PT. Then connect them again.)

There was possibly a load on communication 
retries between the PT and host. (If this symptom 
still occurs, format the PT flash ROM and transfer 
the screen data again.)

Message Cause Countermeasure

Message Cause Countermeasure

The system 
cannot find the 
path specified.

The output path for 
a file that was out-
put by an error 
check, test function, 
file transfer, etc., is 
not correct.

Check the output path in the Option Dialog from 
the Tools Menu of the NP-Designer, and specify it 
correctly.

The system 
cannot find the 
file specified. 
(When starting 
NP-Designer).

When NP-Designer 
was started, it auto-
matically tried to 
open the project 
that was edited 
most recently, and 
the file was not 
found.

---
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7-4 Requesting a Replacement PT
Always observe the following precautions when faults are detected during inspec-
tion and the PT is to be replaced. 

• Create a backup of the PT project data. 
Project data may be deleted when the PT is repaired by OMRON. 

• Always turn OFF the power before replacing the PT. 

• After replacing the PT, check to confirm that the new PT has no faults. 

• When returning a faulty PT for repair, include a document with the PT that pro-
vides as many details on the fault as possible, and send to your OMRON rep-
resentative. 
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Specifications

General Specifications 

Note (1) When a STN LCD display device is used, the display quality will decline (e.g., the contrast ratio will
be reduced) if the temperature exceeds 40°C. Also, when the temperature drops, the response
speed is lowered due to characteristics of liquid crystals. 

(2) Operate the PT within the temperature and humidity ranges shown in the following diagram.

Item Specifications

NP5-SQ000B/NP5-SQ000
NP5-SQ001B/NP5-SQ001

NP5-MQ000B/NP5-MQ000
NP5-MQ001B/NP5-MQ001

NP3-MQ000B/NP3-MQ000
NP3-MQ001B/NP3-MQ001

Rated power supply voltage 24 VDC

Allowable voltage range 21.6 to 27.6 VDC (24 VDC –10% to +15%) 

Allowable input power inter-
ruption time 

No restriction. 

Power consumption 12 W max.

Ambient operating tempera-
ture 

0 to 50°C (See notes 1 and 2.)

Storage temperature –20 to +60°C (See note 2.)

Ambient operating humidity 35 to 85%RH with no condensation (0 to 40°C) (See notes 2.)
35 to 50%RH with no condensation (40 to 50°C) (See notes 2.)

Operating environment No corrosive gases. 

Noise immunity Conforms to IEC61000-4-4, 2 KV (power lines)

Vibration resistance (during 
operation) 

5 to 9 Hz with 3.1 mm amplitude and 9 to 150 Hz with 9.8 m/s2 acceleration for 30 min in 
each of X, Y, and Z directions 

Shock resistance (during 
operation) 

147 m/s2 3 times in each of X, Y, and Z directions. 

Dimensions 184.1 × 144.1 × 52.3 mm (W × H × D) 130.1 × 104.8 × 55.4 mm 
(W × H × D) 

Panel cutout dimensions Width 172.4  × Height 132.4  mm 

Panel thickness: 1.6 to 2.5 mm 

Width 118.5  × Height 92.5  
mm 
Panel thickness: 1.6 to 2.5 mm 

Weight 900 g max. 500 g max.

Enclosure rating Front panel: IP65 Oil-proof type (See note 3.) 

Battery life 5 years (at 25°C) (See note 4.)

International standards EC Directives UL508

+1
0

+1
0

+1
0

+1
0
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(3) The Unit may not be usable in locations subject to long-term exposure to oil or water. The gasket
will deteriorate after long-time use. Inspect the gasket on a regular basis. If deterioration is found,
contact your OMRON representative.

(4) If the battery is removed, data in the PT will be deleted.

Characteristics
Display Specifications 

Note (1) This is the estimated time when the luminous intensity is decreased by 40% per LED at room tem-
perature and humidity. It is not a guaranteed value.

(2) The life expectancy is given only as a guideline. It is not a guaranteed value. The life of the backlight
will be much shorter at low temperatures.

(3) There may be some defective pixels in the display. This is not a fault as long as the numbers of de-
fective light and dark pixels fall within the following standard ranges. 
Number of light and dark pixels: 0.2 < (minor axis + major axis) / 2 ≤ 0.55 mm (within 1 per 20-mm
square)

Operating Specifications

Note (1) The display is analogue resistive membrane. When two or more points are pressed on the display
simultaneously, a switch between these points may be operated. Do not press two or more points
at the same time.

(2) The specifications are the same for the function switches. 

Item Specifications 

NP5-SQ000B
NP5-SQ000

NP5-SQ001B
NP5-SQ001

NP5-MQ000B
NP5-MQ000

NP5-MQ001B
NP5-MQ001

NP3-MQ000B
NP3-MQ000

NP3-MQ001B
NP3-MQ001

Display panel 
(See note 3.)

Display device 5.7FSTN LCD 3.8STN LCD

Number of dots 320 dot horizontal × 240 dot vertical 

Display color 256 colors Monochrome/8 grayscale levels

Display area Width 121.4 mm × height 92.6 mm (5.7 inches) Width 78.8 mm × height 
59.6 mm (3.8 inches) 

View angle Left/right ±30°, Top 10°, Bottom 30° Left/right ±30°, Top 10°, 
Bottom 30°

Backlight Life expectancy 50,000 hours min. (See note 2.) 40,000 hours min. 
(See note 1.)

Brightness 
adjustment 

Cannot be adjusted There are 19 levels of 
adjustment by operating the 
touch panel.

Backlight error 
detection 

No detection function.

Front panel 
indicators 

Lit: The power is turned to ON 

Unlit: The power is turned to OFF

item Specifications 

NP5-SQ000B
NP5-SQ000

NP5-SQ001B
NP5-SQ001

NP5-MQ000B
NP5-MQ000

NP5-MQ001B
NP5-MQ001

NP3-MQ000B
NP3-MQ000

NP3-MQ001B
NP3-MQ001

Touch panel 
(Analogue type)
(See notes 1 
and 2.)

Method: Resistive membrane 

Resolution: 1024 × 1024 

Input: Pressure-sensitive 

Service life: 1,000,000 touch operations. 
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External Interface Specifications 

Programming Device (Software for Creating Screen Data) 

Communications Specifications 
Serial Communications 

1:1 NT Link 

1:N NT Links 

Item Specifications 

NP5-SQ000B
NP5-SQ000

NP5-SQ001B
NP5-SQ001

NP5-MQ000B
NP5-MQ000

NP5-MQ001B
NP5-MQ001

NP3-MQ000B
NP3-MQ000

NP3-MQ001B
NP3-MQ001

USB HOST 1 port (for connecting USB memory)

USB Slave 1 port (screen data transfer, connected to personal computer)

Item Specifications

Name NP-Designer 

Model NP-NPDC0-V1

Item Specifications

COM1 Conforms to EIA RS-232C
D-Sub female 9-pin connector 
5VDC output (250 mA max.) through pin 6 

COM2 Conforms to EIA RS-422A, RS-485. 
10-pin terminal block

Item Specifications

Communications standards Conforms to EIA RS-232C Conforms to EIA RS-422A/485

Connectors D-Sub female 9-pin connector 10-pin terminal block

Number of Units connected 1:1 1:1

Transmission distance Up to 15 m. Up to 500 m.

Item Specifications

Communications standards Conforms to EIA RS-232C. Conforms to EIA RS-422A/485

Connectors D-Sub female 9-pin connector 10-pin terminal block

Number of Units connected 1:1 1:1

Transmission distance Up to 15 m. Up to 500 m.
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Dimensions

NP5-@Q000(B) (Includes Mounting Dimensions)
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NP5-@Q001(B)
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NP3-@Q000(B) (Includes Mounting Dimensions)
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NP3-@Q001(B)
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Handling the Shield on RS-422A/485 Cables
Perform the following procedures to connect, process the shield, and connect to ground for communications
using RS-422A or RS-485.

Connecting the Ground Wire

The PT has a functional ground terminal (FG: ).

1. Ground according to Figure (a) for normal grounding.

• Connect the ground terminal (GR) of the devices to the functional ground (FG: ).
Make sure that each signal line is grounded at only one point and ground to 100 W max.

• Short the LG terminal of the PLC to the ground terminal (GR).

• Use a wire gauge of at least 2 mm2 for the ground wire.

• Refer to the manual for individual Communications Units for details on proper wiring procedures.

2. Do not ground the functional ground (FG: ) of the PT if it is mounted to the same panel as devices that
generate noise, such as motors or inverters, as shown in Figure (b).

Preparing the Shield of RS-422A/485 Connectors
Always prepare RS-422A/485 cable shields properly. 

Ground only one end of the shield when connecting the ground terminal (GR) of the devices to the functional
ground (FG: ), and grounding each signal line at only one point and to 100 W max, as shown in Figure (a). 

Ground both ends of the shield when not grounding the functional ground (FG: ) of the PT, as shown in Fig-
ure (b).

Example of Recommended Wiring

Ground correctly to prevent the PT from malfunctioning due to noise.Precautions 
for Safe Use

Process the cable shields correctly to prevent the PT from malfunctioning due to
noise.

Precautions 
for Safe Use

RS-422A/485 RS-422A/485 

Signal line

CPU Rack CPU Rack 

Power
supply
Unit

Power
supply
Unit

PT PT

CPU Unit 
or
Communi-
cations 
Unit

CPU Unit 
or
Communi-
cations 
Unit

Signal line

LG
GR

FG FG

 

LG
GR
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Connection Example
An example of connecting a PLC and a PT using an RS-232C/RS-422A Converter is shown below. Use the
wiring example as reference for correct wiring. 

Wiring Example

Note Refer to Handling the Shield on RS-422A/485 Cables for information on processing the shield wire on
the RS-442A/485 cable. 

Use the following connection cables.

CPU Rack PT (unit No. 0)

RS-422A Converter  
(CJ1W-CIF11)

1:N NT Link

Built-in RS-232C  
port on PCU unit

Manufacturer Model

Tachii Electric Wire Co., Ltd. TKV VBS3P-03

HIRAKAWA HEWTECH CORP. CO-HC-ESV-3P×7/0.2

SW1
SW2
SW3
SW4
SW5
SW6

Terminating resistance
2/4-wire
2/4-wire

CPU Rack

ON (Yes)
OFF (4-wire)
OFF (4-wire)
OFF
OFF (None)
OFF (None)

R
D

A
−

R
D

B
+

S
D

A
−

S
D

B
+

F
G

OFF (RS-422A) 
OFF (RS-422A) 
ON (Yes)
(Not used.)

R
D

A
−

R
D

B
+

S
D

A
−

S
D

B
+

F
G

CJ1W-CIF11
DIP switch settings

PT
(Unit No.0)

Not used

RD control
SD control
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Use the following procedure to prepare connecting cables. 

Cable Preparation 
1. Cut the cables to the required length. 

2. Remove the vinyl cable covering using a razor blade or other tool. 
Use care not to damage the shield (braided mesh). 

3. Cut the shield using scissors. 

4. Strip back to the core of each wire using a stripper. 

5. Bend back the shields. 

6. Wrap the section of the shields that is bent back with aluminum foil tape. 

Soldering
1. Pass a heat-shrinking tube over each wire. 

2. Pre-solder each wire and connector terminal. 

3. Solder each of the wires to the connector terminals. 

1

40 (RS-232C)

10

5

Aluminum foil tape(Unit: mm)

2

3

4

5

6

25 (RS-422A/RS-485)

Soldering iron

Heat-shrinking tube

Internal diameter:1.5

Length = 10

1 mm
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4. Replace the heat-shrinking tube up to the soldered section, and shrink the tube onto the wire by applying
heat using a soldering gun. 

Hood Assembly 
Assemble the hood as shown in the following diagram. 

Preparing Connecting Cables for Host Connection 
Refer to the following information when preparing the connecting cables for connecting the PT to the host. 

Wiring Layout between PT COM1 Serial Port and Host (RS-232C)

Wiring Layout between PT COM2 Serial Port and Host (RS-422A)

When connecting individual signals with twisted-pair cable, connect RDA and RDB, and SDA and SDB, as
pairs in the twisted-pair cable. A communications error may occur if the pairs are not combined correctly.

Heat-shrinking tube

Aluminum foil tape
End with Connector End without Connector

Signal

FG

-

SD

RD

RS

CS

+5V

-

-

SG

Pin No.

Connector food

1

2

3

4

5

6

7

8

9

Pin No.

Connector food

2

3

4

5

6

7

8

9

RS-232C
connector

RS-232C
connector

Shield

9-pin connector

PT Host

9-pin connector

Signal

FG

SD

RD

RS

CS

-

-

-

SG

1 6

5 9

1 6

5 9

PT Host

Shield

HostPT

RS-422A 
terminal 
block

Signal

RDA(-)

RDB(+)

SDA(-)

SDB(+)

FG

Signal

RDA(-)

RDB(+)

SDA(-)

SDB(+)

FG

RS-422A cable
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Wiring Layout between PT Serial Port COM2 and Host (RS-485)

Wiring Layout to CS1G/H Serial Communications Boards, C200HX/HG/HE(-Z) 
Communications Boards, CQM1H Serial Communications Boards, and CVM1/CV Series Host Link 
Units 
Applicable Units:

CS1G-CPU42(-V1), CS1G-CPU43(-V1), CS1G-CPU44(-V1),

CS1G-CPU45(-V1), CS1H-CPU63(-V1), CS1H-CPU64(-V1),

CS1H-CPU65(-V1), CS1H-CPU66(-V1), CS1H-CPU67(-V1),

C200HE-CPU32(-Z), C200HE-CPU42(-Z), C200HG-CPU33(-Z),

C200HG-CPU43(-Z), C200HG-CPU53(-Z), C200HG-CPU63(-Z),

C200HX-CPU34(-Z), C200HX-CPU44(-Z), C200HX-CPU54(-Z),

C200HX-CPU64(-Z), C200HX-CPU65-Z, C200HX-CPU85-Z,

CQM1H-CPU51, CQM1H-CPU61, CV500-LK201(COM port 2)

For details on processing shielded cable, refer to Handling the Shield on RS-422A/485 Cables. 

Wiring Layout to CVM1/CV-series CPU Units
Applicable Units:

CV500-CPU01-V1, CV1000-CPU01-V1, CV2000-CPU01-V1,

CVM1-CPU01-V@, CVM1-CPU11-V@, CVM1-CPU21-V@

CVM1/CV Series CPU Units without the -V@ suffix cannot be connected by any communications method.

PT Host

Shield

HostPT

Signal

RDA(-)

RDB(+)

SDA(-)

SDB(+)

FG

Signal

RDA(-)

RDB(+)

SDA(-)

SDB(+)

FG

RS-485 
terminal 
block

RS-485

Shield

PT 1 6

5 9

PLC

9-pin type

RS-422A 
terminal 
block

Signal

RDA(-)

RDB(+)

SDA(-)

SDB(+)

FG

Pin No.

Hood

1

2

3

4

5

6

7

8

9

RS-422A 
connector

Signal

FG

SDA(-)

SDB(+)

-

-

-

RDA(-)

-

RDB(+)

-



254

Preparing Connecting Cables Appendix D

For details on processing shielded cable, refer to Handling the Shield on RS-422A/485 Cables.

Wiring Layout to EJ1 Modular Temperature Controller

For details on processing shielded cable, refer to Handling the Shield on RS-422A/485 Cables.

Preparing Cables for Computer Connection
Refer to the following information when preparing the NP-Designer connecting cables. 

Wire the RS-232C connector to the DOS computer according to the type, as 

follows: 

Use the following products to assemble the connecting cable. 

Shield

PT 1 6

5 9

RS-422A 
terminal 
block

Signal

RDA(-)

RDB(+)

SDA(-)

SDB(+)

FG

9-pin type

Signal

FG

SDA(-)

SDB(+)

-

RS

CS

RDA(-)

-

RDB(+)

-

Pin No.

Hood

1

2

3

4

5

6

7

8

9

RS-422A 
connector

PLC

PT EJ1

Signal

RDA(-)

RDB(+)

SDA(-)

SDB(+)

  FG
Shield

Signal

A(-)

B(+)

To next EJ1

EJ1PT
RS-485 cable

RS-485 
terminal 
block

Shield

SD

RD

RS

CS

SG

SD

RD

RS

CS

SG

FG

2

3

4

5

9

2

3

4

5

7

1

Connector hood

PT serial port

Connector hood

Computer

Name Model Details

Connector XM2D-2501 25-pin type 
Manufactured by OMRON (computer side) 

XM2A-0901 9-pin type
Manufactured by OMRON (PT side) 
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9-pin Connector 

Use the following products to assemble the connecting cable. 

Note Use a connector hood for the computer that conforms to the standards for the screws of the computer
connector. 

Connector hood XM2S-2511 25-pin type 
Manufactured by OMRON (computer side) 

XM2S-0911 9-pin type, mm screws 
Manufactured by OMRON (PT side) 

Cable AWG28 × 5P IFVV-SB Multiconductor shielded cable
Manufactured by Fujikura Densen.

CO-MA-VV-SB 5P × 28AWG Multiconductor shielded cable
Manufactured by Hitachi Densen. 

Name Model Details

Shield

SD

RD

RS

SD

RD

RS

CS

SG

2

3

4

5

9

3

2

7

8

5

CS

SG

Connector hood

PT serial port

Connector hood

Computer

Name Model Details

Connector XM2D-0901 9-pin type 

Manufactured by OMRON (computer side) 

XM2A-0901 9-pin type
Manufactured by OMRON (PT side) 

Connector hood 
(See note.) 

XM2S-0911 9-pin type, mm screws 
Manufactured by OMRON.

XM2S-0913 9-pin type, inch screws 
Manufactured by OMRON.

Cable AWG28 × 5P IFVV-SB Multiconductor shielded cable
Manufactured by Fujikura Densen.

CO-MA-VV-SB 5P × 28AWG Multiconductor shielded cable
Manufactured by Hitachi Densen. 
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Appendix E
Standard Models 

Programmable Terminals (PTs) 

Serial Communications Units 

CPU Units That Connect to PTs in 1:1 NT Links 

CPU Units That Connect in 1:1 NT Links via RS-232C to PT Serial Ports

Model LCD Case

Type Size Color Number of dots Color

NP5-SQ000B FSTN 5.7 inch 256 colors 320 × 240 Black

NP5-SQ000 FSTN 5.7 inch 256 colors 320 × 240 Silver

NP5-SQ001B FSTN 5.7 inch 256 colors 320 × 240 Black

NP5-SQ001 FSTN 5.7 inch 256 colors 320 × 240 Silver

NP5-MQ000B FSTN 5.7 inch Monochrome 320 × 240 Black

NP5-MQ000 FSTN 5.7 inch Monochrome 320 × 240 Silver

NP5-MQ001B FSTN 5.7 inch Monochrome 320 × 240 Black

NP5-MQ001 FSTN 5.7 inch Monochrome 320 × 240 Silver

NP3-MQ000B STN 3.8 inch Monochrome 320 × 240 Black

NP3-MQ000 STN 3.8 inch Monochrome 320 × 240 Silver

NP3-MQ001B STN 3.8 inch Monochrome 320 × 240 Black

NP3-MQ001 STN 3.8 inch Monochrome 320 × 240 Silver

Model Specifications Applicable PLC

CS1W-SCU21 • RS-232C (2 ports) 
• Base-mounting type 

CS-series CS1G/H and 
CS1G/H-H 

CS1W-SCU41 • RS-232C (1 port)
• RS-422A (1 port)
• Base-mounting type

CS-series CS1G/H and 
CS1G/H-H

CJ1W-SCU41 • RS-232C (1 port)
• RS-422A (1 port)
• Building-block type

CJ-series CJ1G/H-H and 
CJ1M

PLC Series Specifications

C200HE/HG/HX Series With RS-232C connector (switching/9-pin type) 

CQM1(H) Series With RS-232C connector (9-pin type) 

CPM1A Series Connects to RS-232C cable using RS-232C Adapter CPM1-CIF01. 

CPM2A Series With RS-232C connector (9-pin type) 

CPM2C Series Connects to RS-232C connector branched using CPM2C-CN111 with con-
verting cable. 

CVM1/CV Series With RS-232C connector (switching/9-pin type) 

PLC Series CPU Units with built-in 1:1 NT Link 
functionality

CPU Units that connect via optional 
Communications Boards

C Series C200HE-CPU42 (-Z) C200HE-CPU32 (-Z) (See note 1.)
C200HE-CPU42 (-Z) (See note 1.)
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Note (1) A C200HW-COM02/COM04/COM05/COM06-V1 Communications Board is required. 

(2) A CQM1H-SCB41 Serial Communications Board is required.

(3) Connection is not possible to CVM1/CV-series PLC CPU Units without “-V1” in the model number.

(4) A CS1W-CN118 Conversion Cable or XW2Z-200T-2 Cable with connector must be used for the con-
nection. 

C Series C200HG-CPU43(-Z)
C200HG-CPU63(-Z)

C200HG-CPU33(-Z) (See note 1.)
C200HG-CPU43(-Z) (See note 1.)
C200HG-CPU53(-Z) (See note 1.)
C200HG-CPU63(-Z) (See note 1.)

C200HX-CPU44(-Z)
C200HX-CPU64(-Z)
C200HX-CPU65-Z 
C200HX-CPU85-Z

C200HX-CPU34(-Z) (See note 1.)
C200HX-CPU44(-Z) (See note 1.)
C200HX-CPU54(-Z) (See note 1.)
C200HX-CPU64(-Z) (See note 1.)
C200HX-CPU65-Z
C200HX-CPU85-Z

CQM1-CPU41-V1
CQM1-CPU42-V1
CQM1-CPU43-V1
CQM1-CPU44-V1
CQM1-CPU45-EV1

---

CPM1A-10CD@-@ (-V1)
CPM1A-20CD@-@ (-V1)
CPM1A-30CD@-@ (-V1)
CPM1A-40CD@-@ (-V1)

---

CPM2A-30CD@@-@
CPM2A-40CD@@-@
CPM2A-60CD@@-@

---

CPM2C-10@@@@@@-@ (See note 4.)
CPM2C-20@@@@@@-@ (See note 4.)

---

CQM1H-CPU21 (See note 2.)
CQM1H-CPU51 (See note 2.)
CQM1H-CPU61 (See note 2.)

---

CV Series (See note 
3.)

CV500-CPU01-V1 
CV1000-CPU01-V1 
CV2000-CPU01-V1

---

CVM1 Series (See 
note 3.)

CVM1-CPU01-V2 
CVM1-CPU11-V2 
CVM1-CPU21-V2

---

PLC Series CPU Units with built-in 1:1 NT Link 
functionality

CPU Units that connect via optional 
Communications Boards

CS-series CPU Units cannot connect to 1:1 NT Links, but a 1:1 connection can be
made using 1:N NT Links (normal or high-speed). Refer to 3-5 Connecting with
1:N NT Links and 3-6 High-speed 1:N NT Links for details. 

Precautions 
for Correct Use
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CPU Units That Connect in 1:1 NT Links via RS-422A/485 to PT Serial Ports

Note (1) A C200HW-COM03-V1 or C200HW-COM06-V1 Communications Board is required. 

(2) A C200HW-COM03-V1 or C200HW-COM06-V1 Communications Board is required. 

(3) Connection is not possible to CVM1/CV-series PLC CPU Units without “-V1” in the model number.

(4) Connect using RS-422A

CPU Units That Connect to PTs in Standard 1:N NT Links

PLC Series CPU Units with built-in 1:1 NT Link functionality

C Series C200HE-CPU32 (-Z) (See note 1.)
C200HE-CPU42 (-Z) (See note 1.)

C200HG-CPU33 (-Z) (See note 1.)
C200HG-CPU43 (-Z) (See note 1.)
C200HG-CPU53 (-Z) (See note 1.)
C200HG-CPU63 (-Z) (See note 1.)

C200HX-CPU34 (-Z) (See note 1.)
C200HX-CPU44 (-Z) (See note 1.)
C200HX-CPU54 (-Z) (See note 1.)
C200HX-CPU64 (-Z) (See note 1.)
C200HX-CPU65-Z (See note 1.)
C200HX-CPU85-Z (See note 1.)

CQM1H-CPU51 (See note 2.)
CQM1H-CPU61 (See note 2.)

CV Series (See note 3.) CV500-CPU01-V1
CV1000-CPU01-V1
CV2000-CPU01-V1

CVM1 Series (See note 3 and 4.) CVM1-CPU01-V2
CVM1-CPU11-V2
CVM1-CPU21-V2

Model Specifications

CP Series Connecting to RS-232C cable using RS-232C Option Board 
(CP1W-CIF01).
Connecting RS-422A/485 Option Board (CP1W-CIF11).

C200HE/HG/HX Series With RS-232C connector (switching/9-pin type) 

CQM1H Series With RS-232C connector (9-pin type) 

CS Series With RS-232C connector (9-pin type) 

CJ Series With RS-232C connector (9-pin type) 
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CPU Units That Connect in 1:N NT Links via RS-232C to PT Serial Ports

Note (1) CP1W-CIF01 RS-232C option board is required. 

(2) A CS1W-SCB21/SCB41 Serial Communications Board or a CS1W-SCU21 Serial Communications
Unit is required. 

(3) A CJ1W -SCU41 Serial Communications Unit is required.

(4) A C200HW-COM02/COM04/COM05/COM06(-V1) Communications Board is required.

(5) A CQM1H-SCB41 Serial Communications Board is required.

PLC Series Connecting with built-in ports Connecting via optional Communications 
Boards

CP Series --- CP1L-L14D/L20D/M30D/M40D (See note 1.)
CP1H-X/XA/Y

CS Series CS1G-CPU42(-V1)
CS1G-CPU43(-V1)
CS1G-CPU44(-V1)
CS1G-CPU45(-V1)
CS1H-CPU63(-V1)
CS1H-CPU64(-V1)
CS1H-CPU65(-V1)
CS1H-CPU66(-V1)
CS1H-CPU67(-V1)
CS1G-CPU42H
CS1G-CPU43H
CS1G-CPU44H
CS1G-CPU45H
CS1H-CPU63H
CS1H-CPU64H
CS1H-CPU65H
CS1H-CPU66H
CS1H-CPU67H
CS1D-CPU65H
CS1D-CPU67H

Same as at left. (See note 2.)

CJ Series CJ1H-CPU65H (See note 2.)
CJ1H-CPU66H (See note 2.)
CJ1G-CPU42H (See note 2.)
CJ1G-CPU43H (See note 2.)
CJ1G-CPU44H (See note 2.)
CJ1G-CPU45H (See note 2.)
CJ1M-CPU11
CJ1M-CPU12
CJ1M-CPU13
CJ1M-CPU21
CJ1M-CPU22
CJ1M-CPU23

Same as at left. (See note 3.)

C Series C200HE-CPU42(-Z) C200HE-CPU32(-Z) (See note 4.)
C200HE-CPU42(-Z) (See note 4.)

C200HG-CPU43(-Z)
C200HG-CPU63(-Z)

C200HG-CPU33(-Z) (See note 4.)
C200HG-CPU43(-Z) (See note 4.)
C200HG-CPU53(-Z) (See note 4.)
C200HG-CPU63(-Z) (See note 4.)

C200HX-CPU44(-Z)
C200HX-CPU64(-Z)
C200HX-CPU65-Z 
C200HX-CPU85-Z

C200HX-CPU34(-Z) (See note 4.)
C200HX-CPU44(-Z) (See note 4.)
C200HX-CPU54(-Z) (See note 4.)
C200HX-CPU64(-Z) (See note 4.)
C200HX-CPU65-Z (See note 4.)
C200HX-CPU85-Z (See note 4.)

--- CQM1H-CPU21 (See note 5.)
CQM1H-CPU51 (See note 5.)
CQM1H-CPU61 (See note 5.)
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CPU Units That Connect in 1:N NT Links via RS-442A/485 to PT Serial Ports

Reference Both the normal 1:N NT Links and high-speed NT Links are supported for CS-series PLC CPU
Units with “-V1” in the model number. If a Serial Communications Unit or Board with
Lot.991220 or later is used, these connections are also sup-ported by CPU Units without “-V1.”
Refer to 3-6 High-speed 1:N NT Links for de-tails. 

PLC Series Unit Serial Communications Board or Unit required 
for connection

CP Series CP1L-L14D
CP1L-L20D
CP1L-M30D
CP1L-M40D
CP1H-X
CP1H-XA
CP1H-Y

CP1W-CIF11 RS-422A/485 Option Board

CS Series CS1G-CPU42(-V1)
CS1G-CPU43(-V1)
CS1G-CPU44(-V1)
CS1G-CPU45(-V1)
CS1H-CPU63(-V1)
CS1H-CPU64(-V1)
CS1H-CPU65(-V1)
CS1H-CPU66(-V1)
CS1H-CPU67(-V1)
CS1G-CPU42H
CS1G-CPU43H
CS1G-CPU44H
CS1G-CPU45H
CS1H-CPU63H
CS1H-CPU64H
CS1H-CPU65H
CS1H-CPU66H
CS1H-CPU67H
CS1D-CPU65H
CS1D-CPU67H

CS1W-SCB41 Serial Communications Board

CJ Series CJ1G-CPU42H
CJ1G-CPU43H
CJ1G-CPU44H
CJ1G-CPU45H
CJ1M-CPU11
CJ1M-CPU12
CJ1M-CPU13
CJ1M-CPU21
CJ1M-CPU22
CJ1M-CPU23
CJ1H-CPU65H
CJ1H-CPU66H 

CJ1W-SCU41 Serial Communications Unit

C Series C200HE-CPU32(-Z)
C200HE-CPU42(-Z)

C200HG-CPU33(-Z) 
C200HG-CPU43(-Z)
C200HG-CPU53(-Z) 
C200HG-CPU63(-Z)

C200HX-CPU34(-Z) 
C200HX-CPU44(-Z)
C200HX-CPU54(-Z) 
C200HX-CPU64(-Z)
C200HX-CPU65-Z 
C200HX-CPU85-Z

C200HW-COM03/COM06(-V1) Communications 
Board

CQM1H-CPU21
CQM1H-CPU51 
CQM1H-CPU61 

CQM1H-SCB41 Serial Communications Board
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CPU Units That Connect to PTs in High-speed 1:N NT Links

Note Connection is not possible for CPU Units without “-V1” in the model number. 

CPU Units That Connect in 1:N NT Links via RS-232C to PT Serial Ports

Note (1) CP1W-CIF01 RS-232C option board is required.

(2) CS-series PLC CPU Units without “-V1” in the model number do not support high-speed NT Links.

(3) A CS1W-SCB21/SCB41 Serial Communications Board or a CS1W-SCU21 Serial Communications
Unit is required.

(4) A CJ1W-SCU41 Serial Communications Board is required.

Model Specifications

CP Series Connecting to RS-232C cable using a CP1W-CIF01RS-232C Option Board 
Connecting RS-422A/485 Option Board (CP1W-CIF11).

CS Series (See note.) With RS-232C connector (9-pin type)

CJ Series With RS-232C connector (9-pin type)

PLC Series Connecting with built-in ports Connecting via optional 
Communications Boards

CP Series --- CP1L-L14D/L20D/M30D/
M40D (See note 1.)
CP1H-X/XA/Y

CS Series CS1G-CPU42-V1 (See note 2.)
CS1G-CPU43-V1 (See note 2.)
CS1G-CPU44-V1 (See note 2.)
CS1G-CPU45-V1 (See note 2.)
CS1H-CPU63-V1 (See note 2.)
CS1H-CPU64-V1 (See note 2.)
CS1H-CPU65-V1 (See note 2.)
CS1H-CPU66-V1 (See note 2.)
CS1H-CPU67-V1 (See note 2.)
CS1G-CPU42H
CS1G-CPU43H
CS1G-CPU44H
CS1G-CPU45H
CS1H-CPU63H
CS1H-CPU64H
CS1H-CPU65H
CS1H-CPU66H
CS1H-CPU67H
CS1D-CPU65H
CS1D-CPU67H

Same as at left. (See note 3.)

CJ Series CJ1G-CPU42H
CJ1G-CPU43H
CJ1G-CPU44H
CJ1G-CPU45H
CJ1M-CPU11
CJ1M-CPU12
CJ1M-CPU13
CJ1M-CPU21
CJ1M-CPU22
CJ1M-CPU23
CJ1H-CPU65H
CJ1H-CPU66H

Same as at left. (See note 4.)
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CPU Units That Connect in 1:N NT Links via RS-442A/485 to PT Serial Ports

CPU Units That Connect to PTs in Host Links

PLC Series Unit Serial Communications Board or 
Unit required for connection

CP Series CP1L-L14D
CP1L-L20D
CP1L-M30D
CP1L-M40D
CP1H-X
CP1H-XA
CP1H-Y

CP1W-CIF01 RS-232C Option 
Board 

CS Series CS1G-CPU42(-V1)
CS1G-CPU43(-V1)
CS1G-CPU44(-V1)
CS1G-CPU45(-V1)
CS1H-CPU63(-V1)
CS1H-CPU64(-V1)
CS1H-CPU65(-V1)
CS1H-CPU66(-V1)
CS1H-CPU67(-V1)
CS1G-CPU42H
CS1G-CPU43H
CS1G-CPU44H
CS1G-CPU45H
CS1H-CPU63H
CS1H-CPU64H
CS1H-CPU65H
CS1H-CPU66H
CS1H-CPU67H
CS1D-CPU65H
CS1D-CPU67H

CS1W-SCB41 Serial Communica-
tions Board

CJ Series CJ1G-CPU42H
CJ1G-CPU43H
CJ1G-CPU44H
CJ1G-CPU45H
CJ1M-CPU11
CJ1M-CPU12
CJ1M-CPU13
CJ1M-CPU21
CJ1M-CPU22
CJ1M-CPU23
CJ1H-CPU65H
CJ1H-CPU66H

CJ1W-SCU41 Serial Communica-
tions Unit

PLC Series Specifications

C200HE/HG/HX Series With RS-232C connector (switching/9-pin type) 

CQM1(H) Series With RS-232C connector (9-pin type) 

CPM1A Series Connects to RS-232C cable using RS-232C Adapter CPM1-CIF01. 

CPM2A Series With RS-232C connector (9-pin type) 

CPM2C Series Connects to RS-232C connector branched using CPM2C-CN111 with 
converting cable. 

CVM1/CV Series With RS-232C connector (switching/9-pin type) 

CS Series With RS-232C connector (9-pin type)

CJ Series With RS-232C connector (9-pin type)
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CPU Units That Connect in Host Links via RS-232C to PT Serial Ports

PLC Series CPU Units with Built-in Host 
Link Function

CPU Units Connectable 
with Host Link Units or 

Expansion 
Communications Board

Host Link Unit/ 
Communications Board

CP Series CP1L-L14D/L20D/M30D/
M40D
CP1H-X/XA/Y

--- CP1W-CIF01

C Series --- C1000H-CPU01-EV1 
C2000H-CPU01-EV1

C120-LK201-EV1

--- C200HE-CPU11-E
C200HE-CPU32-E
C200HE-CPU42-E
C200HE-CPU11-ZE
C200HE-CPU32-ZE
C200HE-CPU42-ZE
C200HG-CPU33-E
C200HG-CPU43-E
C200HG-CPU53-E
C200HG-CPU63-E
C200HG-CPU33-ZE
C200HG-CPU43-ZE
C200HG-CPU53-ZE
C200HG-CPU63-ZE
C200HX-CPU34-E
C200HX-CPU44-E
C200HX-CPU54-E
C200HX-CPU64-E
C200HX-CPU34-ZE
C200HX-CPU44-ZE
C200HX-CPU54-ZE
C200HX-CPU64-ZE
C200HX-CPU65-ZE
C200HX-CPU85-ZE

C200H-LK201-EV1
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C Series C200HE-CPU42-E 
C200HE-CPU42-ZE

C200HE-CPU32-E
C200HE-CPU42-E
C200HE-CPU32-ZE
C200HE-CPU42-ZE

C200HW-COM02-EV1
C200HW-COM04-EV1
C200HW-COM05-EV1
C200HW-COM06-EV1

C200HG-CPU43-E
C200HG-CPU63-E
C200HG-CPU43-ZE 
C200HG-CPU63-ZE

C200HG-CPU33-E
C200HG-CPU43-E
C200HG-CPU53-E
C200HG-CPU63-E
C200HG-CPU33-ZE 
C200HG-CPU43-ZE 
C200HG-CPU53-ZE
C200HG-CPU63-ZE

C200HX-CPU44-E
C200HX-CPU64-E 
C200HX-CPU44-ZE
C200HX-CPU64-ZE
C200HX-CPU65-ZE
C200HX-CPU85-ZE

C200HX-CPU34-E
C200HX-CPU44-E
C200HX-CPU54-E
C200HX-CPU64-E 
C200HX-CPU34-ZE
C200HX-CPU44-ZE
C200HX-CPU54-ZE
C200HX-CPU64-ZE
C200HX-CPU65-ZE
C200HX-CPU85-ZE

--- C1000H-CPU01-EV1 
C2000H-CPU01-EV1

C500-LK201-EV1

--- C1000H-CPU01-EV1 
C1000HF-CPUA1-EV1 
C2000H-CPU01-EV1

C500-LK203

CPM1-10CDR-@
CPM1-20CDR-@

+CPM1-CIF01

--- ---

CPM1A-10CD@-@
CPM1A-20CD@-@
CPM1A-30CD@-@
CPM1A-40CD@-@

+CPM1-CIF01

--- ---

CPM2A-30CD@@-@
CPM2A-40CD@@-@
CPM2A-60CD@@-@

+CPM1- CIF01
(Peripheral port connection)

--- ---

CPM2C-10@@@@@@-@
CPM2C-20@@@@@@-@ 
(See note1.)

--- ---

CQM1-CPU21-E 
CQM1-CPU41-EV1
CQM1-CPU42-EV1
CQM1-CPU43-EV1
CQM1-CPU44-EV1

--- ---

CQM1H-CPU11
CQM1H-CPU21
CQM1H-CPU51
CQM1H-CPU61 
(See note 2.)

CQM1H-CPU51
CQM1H-CPU61

CQM1H-SCB41

CV Series 
(See note 3.)

CV500-CPU01-EV1 CV500-CPU01-EV1 CV500-LK201

CV1000-CPU01-EV1 CV1000-CPU01-EV1

CV2000-CPU01-EV1 CV2000-CPU01-EV1

PLC Series CPU Units with Built-in Host 
Link Function

CPU Units Connectable 
with Host Link Units or 

Expansion 
Communications Board

Host Link Unit/ 
Communications Board
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Note (1) Use a CPM2C-CN111 or CS1W-CN114/118 Connecting Cable, CPM1-CIF01 RS-232C Adapter, or
CPM1-CIF11 RS-422A Adapter to connect. 

(2) The CQM1H-CPU11 does not have a built-in RS-232C port, so connect to the peripheral port to the
PT with a CS1W-CN118 Connecting Cable. 

(3) CPU Units of CVM1/CV-series PLCs without the suffix -EV@ cannot be connected. 

CVM1 Series 
(See note 3.)

CVM1-CPU01-EV2
CVM1-CPU11-EV2 
CVM1-CPU21-EV2

CVM1-CPU01-EV2
CVM1-CPU11-EV2 
CVM1-CPU21-EV2

CV500-LK201

CS Series CS1G-CPU42-EV1
CS1G-CPU43-EV1
CS1G-CPU44-EV1
CS1G-CPU45-EV1
CS1H-CPU63-EV1
CS1H-CPU64-EV1
CS1H-CPU65-EV1
CS1H-CPU66-EV1
CS1H-CPU67-EV1

CS1G-CPU42-EV1
CS1G-CPU43-EV1
CS1G-CPU44-EV1
CS1G-CPU45-EV1
CS1H-CPU63-EV1
CS1H-CPU64-EV1
CS1H-CPU65-EV1
CS1H-CPU66-EV1
CS1H-CPU67-EV1

CS1W-SCU21-V1 
CS1W-SCB21-V1 
CS1W-SCB41-V1

CS1G-CPU42H
CS1G-CPU43H
CS1G-CPU44H
CS1G-CPU45H
CS1H-CPU63H
CS1H-CPU64H
CS1H-CPU65H
CS1H-CPU66H
CS1H-CPU67H

CS1G-CPU42H
CS1G-CPU43H
CS1G-CPU44H
CS1G-CPU45H
CS1H-CPU63H
CS1H-CPU64H
CS1H-CPU65H
CS1H-CPU66H
CS1H-CPU67H

CJ Series CJ1G-CPU44
CJ1G-CPU45

CJ1G-CPU44
CJ1G-CPU45

CJ1W-SCU21-V1
CJ1W-SCU41-V1

CJ1G-CPU42H
CJ1G-CPU43H
CJ1G-CPU44H
CJ1G-CPU45H
CJ1H-CPU65H
CJ1H-CPU66H
CJ1H-CPU67H

CJ1G-CPU42H
CJ1G-CPU43H
CJ1G-CPU44H
CJ1G-CPU45H
CJ1H-CPU65H
CJ1H-CPU66H
CJ1H-CPU67H

CJ1M-CPU11
CJ1M-CPU12
CJ1M-CPU13
CJ1M-CPU21
CJ1M-CPU22
CJ1M-CPU23

CJ1M-CPU11
CJ1M-CPU12
CJ1M-CPU13
CJ1M-CPU21
CJ1M-CPU22
CJ1M-CPU23

SRM1 SRM1-C02-V2 --- ---

PLC Series CPU Units with Built-in Host 
Link Function

CPU Units Connectable 
with Host Link Units or 

Expansion 
Communications Board

Host Link Unit/ 
Communications Board
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CPU Units That Connect in Host Link via RS-422A/485 to PT Serial Ports

PLC Series CPU Units with Built-in Host 
Link Function

CPU Units Connectable 
with Host Link Units or 

Expansion 
Communications Board

Host Link Unit/ 
Communications Board

CP Series CP1L-L14D
CP1L-L20D
CP1L-M30D
CP1L-M40D
CP1H-X
CP1H-XA
CP1H-Y

--- CP1W-CIF11

C Series --- C1000H-CPU01-EV1 
C2000H-CPU01-EV1

C120-LK201-EV1

--- C200HE-CPU11-E
C200HE-CPU32-E
C200HE-CPU42-E 
C200HE-CPU11-ZE
C200HE-CPU32-ZE
C200HE-CPU42-ZE 
C200HG-CPU33-E
C200HG-CPU43-E
C200HG-CPU53-E
C200HG-CPU63-E 
C200HG-CPU33-ZE
C200HG-CPU43-ZE
C200HG-CPU53-ZE
C200HG-CPU63-ZE 
C200HX-CPU34-E
C200HX-CPU44-E
C200HX-CPU54-E
C200HX-CPU64-E 
C200HX- CPU34-ZE
C200HX- CPU44-ZE
C200HX- CPU54-ZE
C200HX- CPU64-ZE
C200HX- CPU65-ZE
C200HX- CPU85-ZE

C200H-LK202-EV1

--- C200HE-CPU32-E
C200HE-CPU42-E 
C200HE-CPU32-ZE
C200HE-CPU42-ZE

C200HW-COM03-EV1
C200HW-COM06-EV1 

--- C200HG-CPU33-E
C200HG-CPU43-E
C200HG-CPU53-E
C200HG-CPU63-E 
C200HG-CPU33-ZE
C200HG-CPU43-ZE
C200HG-CPU53-ZE
C200HG-CPU63-ZE

--- C200HX-CPU34-E
C200HX-CPU44-E
C200HX-CPU54-E
C200HX-CPU64-E 
C200HX- CPU34-ZE
C200HX- CPU44-ZE
C200HX- CPU54-ZE
C200HX- CPU64-ZE
C200HX- CPU65-ZE
C200HX- CPU85-ZE 
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C Series --- C1000H-CPU01-EV1 
C2000H-CPU01-EV1

C500-LK201-EV1

--- C1000H-CPU01-EV1 
C1000HF-CPUA1-EV1 
C2000H-CPU01-EV1

C500-LK203

CPM1-10/20CDR-@
+CPM1-CIF11 

--- ---

CPM1A-10/20/30/40CD@-@
+CPM1-CIF11 

--- ---

CPM2A-30/40/60CD@@-@
+CPM1-CIF11 
(Peripheral port connection) 

--- ---

CPM2C-10/20@@@@@@-@
(See note 1.) 

--- ---

--- CQM1H-CPU51
CQM1H-CPU61 

CQM1H-SCB41 

CV Series 
(See note 2.)

CV500-CPU01-EV1 CV500-CPU01-EV1 CV500-LK201 

CV1000-CPU01-EV1 CV1000-CPU01-EV1 

CV2000-CPU01-EV1 CV2000-CPU01-EV1 

CVM1 Series 
(See note 2.)

CVM1-CPU01-EV2
CVM1-CPU11-EV2
CVM1-CPU21-EV2

CVM1-CPU01-EV2
CVM1-CPU11-EV2
CVM1-CPU21-EV2

CV500-LK201

CS Series --- CS1G-CPU42-EV1
CS1G-CPU43-EV1
CS1G-CPU44-EV1
CS1G-CPU45-EV1 
CS1H-CPU63-EV1
CS1H-CPU64-EV1
CS1H-CPU65-EV1
CS1H-CPU66-EV1
CS1H-CPU67-EV1 

CS1W-SCB41-V1 

--- CS1G-CPU42H
CS1G-CPU43H
CS1G-CPU44H
CS1G-CPU45H 
CS1H-CPU63H
CS1H-CPU64H
CS1H-CPU65H
CS1H-CPU66H
CS1H-CPU67H 

CJ Series --- CJ1G-CPU44
CJ1G-CPU45

CJ1W-SCU41-V1

--- CJ1G-CPU42H
CJ1G-CPU43H
CJ1G-CPU44H
CJ1G-CPU45H 
CJ1H-CPU65H
CJ1H-CPU66H
CJ1H-CPU67H 

--- CJ1M-CPU11
CJ1M-CPU12
CJ1M-CPU13
CJ1M-CPU21
CJ1M-CPU22
CJ1M-CPU23

SRM1 SRM1-C02-V2
+CPM1-CIF11

--- ---

PLC Series CPU Units with Built-in Host 
Link Function

CPU Units Connectable 
with Host Link Units or 

Expansion 
Communications Board

Host Link Unit/ 
Communications Board
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Note (1) Use a CPM2C-CN111 or CS1W-CN114/118 Connecting Cable, CPM1-CIF01 RS-232C Adapter, or
CPM1-CIF11 RS-422A Adapter to connect. 

(2) CPU Units of CVM1/CV-series PLCs without the suffix -EV@ cannot be connected. 

Software Related to NP-series PTs

Connecting Cables and Connectors

Cable with Connector (PT-to-PLC) 

Cable with Connector (PT-to-Personal Computer) 

RS-232C Connecting Cable

Applicable Connectors for RS-232C

Name Model Details

NP-Designer NP-NPDC0-V1 For Windows 2000 (Service Pack 4) or XP (Service Pack 2).

The NP-Designer contains a transfer program and standard system 
program for NP-series PTs.

Model Cable length Applicable Units Communications 
method 

Specifications 

XW2Z-200T 2 m Units with 9-pin con-
nector. 

NT Link 
(RS-232C only)

9-pin-to-9-pin 

XW2Z-500T 5 m

XW2Z-200T-2 2 m CPM2C peripheral 
port

NT Link 
(RS-232C only)

9-pin-to-CPM2C 
peripheral portXW2Z-500T-2 5 m

Model Cable length Applicable computer Specifications

XW2Z-S002 2 m DOS computers Female 9-pin-to-male 9-pin

Model Specifications 

AWG28 × 5P IFVV-SB Multiconductor shielded cable
Manufactured by Fujikura Densen.

CO-MA-VV-SB 5P × 28AWG Multiconductor shielded cable
Manufactured by Hitachi Densen. 

Name Model Specifications Provided with

Connector XM2A-2501 25-pin type (male), Manufactured by 
OMRON. 

CV500-LK201
C200H-LK201-V1

XM2D-2501 25-pin type (female), Manufactured by 
OMRON. (for DOS computers) 

XM2A-0901 9-pin type (male), Manufactured by 
OMRON. 

CS/CJ Series
C Series CQM1, C200HX/HG/HE(-Z)
CVM1/CV Series CPU unit
CV500-LK201

XM2D-0901 9-pin type (female), Manufactured by 
OMRON. (for DOS computers) 

DB-25P 25-pin type (male), Manufactured by 
JAE. 
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RS-422A/485 Connecting Cable

Cables for CS1-series PLC Peripheral Port

Connector hood XM2S-2511 25-pin type, mm screws, Manufac-
tured by OMRON. 

CV500-LK201
C200H-LK201-V1

XM2S-2513 25-pin type, inch screws, Manufac-
tured by OMRON. 

XM2S-0911 9-pin type, mm screws, Manufactured 
by OMRON. 

C Series CQM1, 
C200HX/HG/HE(-Z)
CVM1/CV Series CPU unit
CV500-LK201

XM2S-0911-E 9-pin type, mm screws, Manufactured 
by OMRON. 

CS/CJ Series

XM2S-0913 9-pin type, inch screws, Manufac-
tured by OMRON. 

DB-C2-J9 25-pin type, Manufactured by JAE. 

Manufacturer Model

Tachii Electric Wire Co., Ltd. TKV VBS3P-03

HIRAKAWA HEWTECH CORP. CO-HC-ESV-3P×7/0.2

Model Specifications

CS1W-CN118 Manufactured by OMRON
(CS1-series peripheral port-to-D-Sub female 9-pin connector)

Name Model Specifications Provided with
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Replacement Battery 
This is a lithium battery for backing up the contents of the memory. 

USB Flash Memory
FAT32 formatted USB flash memory can only be connected.

Protective Sheet
The NP3-KBA04 Protective Sheet keeps the display panel of the NP-series PT free from smudges and
scratches. Protective Sheets have a matt finish to reduce glare from reflected light. 

Specifications
Material: Polyester film

Chemical Resistance

Manufacturer Model

OMRON CJ1W-BAT01

Manufacturer Model

OMRON ZF-MEM1G

Manufacturer Model Remark

OMRON NT30-KBA04 For NP5

OMRON NP3-KBA04 For NP3

Resistance Resistant to boric acid, Hexane, Kerosene, Engine oil, Diesel oil, Lubricants, 
Glycerin, Silicone grease.

Non-resistance Not resistant to ammonia solution, Sulfurous acid gas, Caustic potash, 
Sodium hydroxide, Phenol, Propylene, Nitrobenzene.
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Revision History

A manual revision code appears as a suffix to the catalog number on the cover of the manual.

The following table outlines the changes made to the manual during each revision. Page numbers refer to the
previous version.

Revision code Date Revised content

01 July 2008 Original production

02 January 2009 Revised to correct mistakes. 

03 April 2009 Revised to correct mistakes.

Cat. No. V096-E1-03

Revision code
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Terms and Conditions of Sale
1. Offer; Acceptance. These terms and conditions (these "Terms") are deemed

part of all quotes, agreements, purchase orders, acknowledgments, price lists,
catalogs, manuals, brochures and other documents, whether electronic or in
writing, relating to the sale of products or services (collectively, the "Products")
by Omron Electronics LLC and its subsidiary companies (“Omron”). Omron
objects to any terms or conditions proposed in Buyer’s purchase order or other
documents which are inconsistent with, or in addition to, these Terms. 

2. Prices; Payment Terms. All prices stated are current, subject to change with-
out notice by Omron. Omron reserves the right to increase or decrease prices
on any unshipped portions of outstanding orders. Payments for Products are
due net 30 days unless otherwise stated in the invoice.

3. Discounts. Cash discounts, if any, will apply only on the net amount of invoices
sent to Buyer after deducting transportation charges, taxes and duties, and will
be allowed only if (i) the invoice is paid according to Omron’s payment terms
and (ii) Buyer has no past due amounts.

4. Interest. Omron, at its option, may charge Buyer 1-1/2% interest per month or
the maximum legal rate, whichever is less, on any balance not paid within the
stated terms.

5. Orders. Omron will accept no order less than $200 net billing. 
6. Governmental Approvals. Buyer shall be responsible for, and shall bear all

costs involved in, obtaining any government approvals required for the impor-
tation or sale of the Products.

7. Taxes. All taxes, duties and other governmental charges (other than general
real property and income taxes), including any interest or penalties thereon,
imposed directly or indirectly on Omron or required to be collected directly or
indirectly by Omron for the manufacture, production, sale, delivery, importa-
tion, consumption or use of the Products sold hereunder (including customs
duties and sales, excise, use, turnover and license taxes) shall be charged to
and remitted by Buyer to Omron.

8. Financial. If the financial position of Buyer at any time becomes unsatisfactory
to Omron, Omron reserves the right to stop shipments or require satisfactory
security or payment in advance. If Buyer fails to make payment or otherwise
comply with these Terms or any related agreement, Omron may (without liabil-
ity and in addition to other remedies) cancel any unshipped portion of Prod-
ucts sold hereunder and stop any Products in transit until Buyer pays all
amounts, including amounts payable hereunder, whether or not then due,
which are owing to it by Buyer. Buyer shall in any event remain liable for all
unpaid accounts.

9. Cancellation; Etc. Orders are not subject to rescheduling or cancellation
unless Buyer indemnifies Omron against all related costs or expenses.

10. Force Majeure. Omron shall not be liable for any delay or failure in delivery
resulting from causes beyond its control, including earthquakes, fires, floods,
strikes or other labor disputes, shortage of labor or materials, accidents to
machinery, acts of sabotage, riots, delay in or lack of transportation or the
requirements of any government authority. 

11. Shipping; Delivery. Unless otherwise expressly agreed in writing by Omron:
a. Shipments shall be by a carrier selected by Omron; Omron will not drop ship

except in “break down” situations.
b. Such carrier shall act as the agent of Buyer and delivery to such carrier shall

constitute delivery to Buyer;
c. All sales and shipments of Products shall be FOB shipping point (unless oth-

erwise stated in writing by Omron), at which point title and risk of loss shall
pass from Omron to Buyer; provided that Omron shall retain a security inter-
est in the Products until the full purchase price is paid;

d. Delivery and shipping dates are estimates only; and
e. Omron will package Products as it deems proper for protection against nor-

mal handling and extra charges apply to special conditions.
12. Claims. Any claim by Buyer against Omron for shortage or damage to the

Products occurring before delivery to the carrier must be presented in writing
to Omron within 30 days of receipt of shipment and include the original trans-
portation bill signed by the carrier noting that the carrier received the Products
from Omron in the condition claimed.

13. Warranties. (a) Exclusive Warranty. Omron’s exclusive warranty is that the
Products will be free from defects in materials and workmanship for a period of
twelve months from the date of sale by Omron (or such other period expressed
in writing by Omron). Omron disclaims all other warranties, express or implied.
(b) Limitations. OMRON MAKES NO WARRANTY OR REPRESENTATION,
EXPRESS OR IMPLIED, ABOUT NON-INFRINGEMENT, MERCHANTABIL-

ITY OR FITNESS FOR A PARTICULAR PURPOSE OF THE PRODUCTS.
BUYER ACKNOWLEDGES THAT IT ALONE HAS DETERMINED THAT THE
PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR
INTENDED USE. Omron further disclaims all warranties and responsibility of
any type for claims or expenses based on infringement by the Products or oth-
erwise of any intellectual property right. (c) Buyer Remedy. Omron’s sole obli-
gation hereunder shall be, at Omron’s election, to (i) replace (in the form
originally shipped with Buyer responsible for labor charges for removal or
replacement thereof) the non-complying Product, (ii) repair the non-complying
Product, or (iii) repay or credit Buyer an amount equal to the purchase price of
the non-complying Product; provided that in no event shall Omron be responsi-
ble for warranty, repair, indemnity or any other claims or expenses regarding
the Products unless Omron’s analysis confirms that the Products were prop-
erly handled, stored, installed and maintained and not subject to contamina-
tion, abuse, misuse or inappropriate modification. Return of any Products by
Buyer must be approved in writing by Omron before shipment. Omron Compa-
nies shall not be liable for the suitability or unsuitability or the results from the
use of Products in combination with any electrical or electronic components,
circuits, system assemblies or any other materials or substances or environ-
ments. Any advice, recommendations or information given orally or in writing,
are not to be construed as an amendment or addition to the above warranty.
See http://www.omron247.com or contact your Omron representative for pub-
lished information.

14. Limitation on Liability; Etc. OMRON COMPANIES SHALL NOT BE LIABLE
FOR SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES,
LOSS OF PROFITS OR PRODUCTION OR COMMERCIAL LOSS IN ANY
WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED IN CONTRACT, WARRANTY, NEGLIGENCE OR STRICT LIABILITY.
Further, in no event shall liability of Omron Companies exceed the individual
price of the Product on which liability is asserted.    

15. Indemnities. Buyer shall indemnify and hold harmless Omron Companies and
their employees from and against all liabilities, losses, claims, costs and
expenses (including attorney's fees and expenses) related to any claim, inves-
tigation, litigation or proceeding (whether or not Omron is a party) which arises
or is alleged to arise from Buyer's acts or omissions under these Terms or in
any way with respect to the Products.   Without limiting the foregoing, Buyer (at
its own expense) shall indemnify and hold harmless Omron and defend or set-
tle any action brought against such Companies to the extent based on a claim
that any Product made to Buyer specifications infringed intellectual property
rights of another party. 

16. Property; Confidentiality. Any intellectual property in the Products is the exclu-
sive property of Omron Companies and Buyer shall not attempt to duplicate it
in any way without the written permission of Omron. Notwithstanding any
charges to Buyer for engineering or tooling, all engineering and tooling shall
remain the exclusive property of Omron. All information and materials supplied
by Omron to Buyer relating to the Products are confidential and proprietary,
and Buyer shall limit distribution thereof to its trusted employees and strictly
prevent disclosure to any third party. 

17. Export Controls. Buyer shall comply with all applicable laws, regulations and
licenses regarding (i) export of products or information; (iii) sale of products to
“forbidden” or other proscribed persons; and (ii) disclosure to non-citizens of
regulated technology or information.    

18. Miscellaneous. (a) Waiver. No failure or delay by Omron in exercising any right
and no course of dealing between Buyer and Omron shall operate as a waiver
of rights by Omron. (b) Assignment. Buyer may not assign its rights hereunder
without Omron's written consent. (c) Law. These Terms are governed by the
law of the jurisdiction of the home office of the Omron company from which
Buyer is purchasing the Products (without regard to conflict of law princi-
ples).   (d) Amendment. These Terms constitute the entire agreement between
Buyer and Omron relating to the Products, and no provision may be changed
or waived unless in writing signed by the parties. (e) Severability. If any provi-
sion hereof is rendered ineffective or invalid, such provision shall not invalidate
any other provision. (f) Setoff. Buyer shall have no right to set off any amounts
against the amount owing in respect of this invoice. (g) Definitions. As used
herein, “including” means “including without limitation”; and “Omron Compa-
nies” (or similar words) mean Omron Corporation and any direct or indirect
subsidiary or affiliate thereof. 

Certain Precautions on Specifications and Use
1. Suitability of Use. Omron Companies shall not be responsible for conformity

with any standards, codes or regulations which apply to the combination of the
Product in the Buyer’s application or use of the Product. At Buyer’s request,
Omron will provide applicable third party certification documents identifying
ratings and limitations of use which apply to the Product. This information by
itself is not sufficient for a complete determination of the suitability of the Prod-
uct in combination with the end product, machine, system, or other application
or use. Buyer shall be solely responsible for determining appropriateness of
the particular Product with respect to Buyer’s application, product or system.
Buyer shall take application responsibility in all cases but the following is a
non-exhaustive list of applications for which particular attention must be given:
(i) Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.
(ii) Use in consumer products or any use in significant quantities.    
(iii) Energy control systems, combustion systems, railroad systems, aviation
systems, medical equipment, amusement machines, vehicles, safety equip-
ment, and installations subject to separate industry or government regulations. 
(iv) Systems, machines and equipment that could present a risk to life or prop-
erty. Please know and observe all prohibitions of use applicable to this Prod-
uct. 
NEVER USE THE PRODUCT FOR AN APPLICATION INVOLVING SERIOUS
RISK TO LIFE OR PROPERTY OR IN LARGE QUANTITIES WITHOUT
ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO

ADDRESS THE RISKS, AND THAT THE OMRON’S PRODUCT IS PROP-
ERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.    

2. Programmable Products. Omron Companies shall not be responsible for the
user’s programming of a programmable Product, or any consequence thereof. 

3. Performance Data. Data presented in Omron Company websites, catalogs
and other materials is provided as a guide for the user in determining suitabil-
ity and does not constitute a warranty. It may represent the result of Omron’s
test conditions, and the user must correlate it to actual application require-
ments. Actual performance is subject to the Omron’s Warranty and Limitations
of Liability. 

4. Change in Specifications. Product specifications and accessories may be
changed at any time based on improvements and other reasons. It is our prac-
tice to change part numbers when published ratings or features are changed,
or when significant construction changes are made. However, some specifica-
tions of the Product may be changed without any notice. When in doubt, spe-
cial part numbers may be assigned to fix or establish key specifications for
your application. Please consult with your Omron’s representative at any time
to confirm actual specifications of purchased Product. 

5. Errors and Omissions. Information presented by Omron Companies has been
checked and is believed to be accurate; however, no responsibility is assumed
for clerical, typographical or proofreading errors or omissions.



                   Note: Specifications are subject to change.                          © 2008 Omron Electronics LLC                                     Printed in U.S.A.

OMRON ELECTRONICS LLC  THE AMERICAS HEADQUARTERS

m

O

OMRON ELETRÔNICA DO BRASIL LTDA 

Sã P

O

O

O

OTHER OMRON LATIN AMERICA SALES

V096-E1-03         4/09


